
GRC Cloud 8.2

Help



See the Table of Contents to the left to navigate GRC Cloud Help.

© 2006-2015 Resolver Inc.



Contents

GRC Cloud 8.2 1

2

Contents 3

GRC Cloud Editions 21

QuickOverview 22

Main Components of the Enterprise Edition 22

GRC CloudMenu 23

Manage 23

Report 24

Administration 24

Tools 24

User Community 24

Browser Support 25

Supported Browsers 25

Frameworks 26

Understanding Roles and Permissions 244

Roles 27

Cascading of Role Permissions 28

Advanced Permissions and replacement of Local Administrator andOwners 29

SystemSearch 29

Design Your Organizational Information 30

Audit Trail / Change Log 203

The Report Tab 31

The Filters Tab 31

ActionsCaptured in Audit Trail 31



Change Log Tab 31

Redlining and Highlighting Changes 32

Item Templates 32

Modify Basic Characteristics of an Item Type 32

Assign Criteria as an Attribute or Evaluation 33

Add an Existing Criteria 33

Add New Criteria 33

Add an ItemSub-Type 34

Edit an ItemSub-Type 34

Delete an ItemSub-Type 35

Functions 35

Synchronize Item Types 35

Path Context (8.0) 35

Criteria - Overview 36

Attribute and Evaluation Criteria Types 36

Managing Criteria 37

Create Criteria 37

Additional Options 37

Radio Button List/Drop-Down List/Check Box List 37

Date Entry 39

Single Text Entry/Multi Text Entry 39

User List 39

Edit Criteria 42

Delete Criteria 43

Copying Criteria 43

Using the Color Picker 43

SyncingMulti User Picker with Permissions 45



Creating the Criteria 45

Functions - Overview 45

Functions Auto Calculate 46

Function Roll Down 46

Managing Functions 47

Create a New Function 47

Add a Variable 47

DisplayOptions 48

Add anOperator 49

Mathematical Operators 50

Logical Operators 50

Example of a Function 51

Likelihood and Impact – Risk Rating 51

Calculate a Specific Function 51

Calculate All FunctionsUnder an Item 52

Frameworks - Overview 52

Framework Library 52

Framework Building Basics 53

Building andManaging the Central Framework 53

Build Your Central Framework 53

Add a Sub-Folder to an Existing Folder or Sub-Folder 54

Move a Sub-Folder or Add a Sub-Folder to Multiple Folders 54

Add a Risk to a Folder 55

Move a Risk or add a Risk toMultiple Folders 55

Add a Control to a Risk 56

Moving a Control or Adding a Control to Multiple Risks 56

Add a Test to a Control 57



Adding a Test to Multiple Controls 57

Import Items fromPre-Built Frameworks 58

FrameworkMatrix Assessor 58

Starting theMatrix Assessor 58

Using theMatrix Assessor 59

Using theMatrix Assessor: Show/Hide Columns Tab 59

Using theMatrix Assessor: Autosize Tab 59

Delete an Item(s) from the Framework 59

Update and Propagate Frameworks in Use(Once It Has Been Added to Locations & Evaluations
Have Begun)

60

Org/Location Framework 61

Location Building Basics 61

TheOrg/Location Framework 61

Building/Managing the Org/Location Framework 61

Add a Location to your Organization 61

Add an Application to your Organization 62

Add Processes, Risks and Controls to Locations 62

Delete an Item(s) from theOrg/Location 63

Scoping Item Framework 64

Scoping Item Framework Building Basics 64

Building/Managing the Scoping Item Framework 64

Create the Scoping Item Framework 64

Associate Itemswith a Scoping Item 65

Delete a Scoping Item or Top Level Folder from the Scoping Item Tree 66

Completion Reminders (Schedules) - Functionality Retired in v8.0 66

GRC Programs 67

Introduction 67

Configuring Programs and Activities 68



Building Programs and Activities 68

Focus Picker Need to Knows 69

Programs and Actions 71

Program and Activity: Action Types 72

77

Focus Picker On-Going Improvements 77

Managing Advanced Reporting and Analytics 79

Components of Managing Analytics: 79

Manage Information 81

Context 81

Introduction to Context 81

Customizing Context 82

Areas of Applicability 83

ItemOverview 83

Focus Picker 84

Timesheets 85

Hierarchical Report Details 86

Manage by Location vs. Manage by Scoping Item 87

SynchronizingManage by Trees (Scoping to Location) 89

Feature Overview: 89

Define Item Types to Synchronize 89

Steps 89

Manage Attributes 90

Edit an Item's Attributes 90

Edit Attributes Via theMatrix Assessor 91

Manage Evaluations 91

Evaluate Via the Evaluations Tab 92



Viewing Past Period Data 92

Calculate Functions Via the Evaluations Tab 92

Evaluate Via the <Child Item> Tab 92

Evaluate Via theMatrix Assessor 93

Managing Roles and Permissions inManage by Location / Manage by Scoping Item 93

Adding Roles and Users to Items 93

Removing Roles and Users from Items 94

Copying Roles 94

SyncingMulti User Picker with Permissions (6.1) 94

Creating the Criteria 94

SignOff 95

Setting Required Criteria 95

SignOff a Location, Folder, Risk or Control 95

Re-open a SignedOff Location, Folder, Risk or Control 96

Mass Sign-Off in Matrix Assessor 96

Re-Open Items inMatrix Assessor 96

Manage Attachments (Files/Hyperlinks) 97

Attach a New File or Hyperlink 97

Setting Permissions 98

Attach an Existing File or Hyperlink 98

Download an Attached File to your Computer or View aHyperlink 99

Remove an Attached File or Hyperlink 99

Delete a File or Hyperlink from the System 99

Update an Attached File or Hyperlink via Download 100

Edit the Name, Description, or Keywords of an Attached File or Hyperlink 100

Modify File or Hyperlink Permissions 101

Check-In and Check-Out Files or Hyperlinks 101

#Evaluate%20Via%20the%20%3CChild%20Item%3E%20Tab
#Evaluate%20Via%20the%20%3CChild%20Item%3E%20Tab
#Evaluate%20Via%20the%20%3CChild%20Item%3E%20Tab
#Evaluate%20Via%20the%20%3CChild%20Item%3E%20Tab
#Evaluate%20Via%20the%20%3CChild%20Item%3E%20Tab
#Evaluate%20Via%20the%20%3CChild%20Item%3E%20Tab
#Evaluate%20Via%20the%20%3CChild%20Item%3E%20Tab


Preview an Excel File 102

Editing File Attachments viaWebDav 103

Instant File UpdatesOverview 103

Change Log / Audit Trail 105

Redlining and Highlighting Changes 105

Matrix Assessor 106

Starting theMatrix Assessor 106

Using theMatrix Assessor 107

Using theMatrix Assessor: View Tab 107

Using theMatrix Assessor: Show/Hide Columns Tab 107

Using theMatrix Assessor: Autosize Tab 107

View Previous Period inMatrix Assessor 108

Adding Framework Items and Non-Framework Items inMatrix Assessor 108

Calculating Function Results in Matrix Assessor 108

Adding File Attachments in Matrix Assessor 108

Mass Sign-Off in Matrix Assessor 109

Re-Open Items inMatrix Assessor 109

Manage Framework Items (Locations, Folders, Risks, Controls, Standard Tests) 109

Add an Item from an Existing Framework to your Area of Responsibility 110

Create a New Framework in your Area of Responsibility 110

Create a New Item in your Area of Responsibility 110

Remove an Existing Item from your Area of Responsibility 111

Updating the Framework version of an Existing Item from your Area of Responsibility 112

Moving Items between Locations in Area of Responsibility 113

Multi-ing Itemswithin Locations in Area of Responsibility 113

Manage Non-Framework Items (Issues, Action Plans, Notes, Steps, Test Results) 114

Add a New Child Item 114



Example: Add an Issue to a Control 114

Remove an Existing Child Item 114

Or 115

Moving Items between Locations in Area of Responsibility 115

Multi-ing Itemswithin Locations in Area of Responsibility 115

Manage By Location / Manage ByScoping Item – Right ClickMenu and ButtonMenu 116

EasyMenu Navigation 116

116

Expand all descendants below current item 117

AssessChecked Items inMatrix Assessor 117

Assess current item and descendants in Matrix Assessor 117

View Checked Items in Chart Builder 117

Export Selected Items to Resolver Ballot 118

Export Selected Items to Resolver Survey 118

Calculate Functions 118

View <Items> Under This Item 118

Reset AllWorkflow Under the Current Selected Item 119

Updating the Library 119

Offline Assessments 120

Exporting ItemsOffline 121

Steps to Take ItemsOffline 122

Re-Exporting the Same Items 123

File Size 123

Locked ItemManagement / Permission 123

Locking Logic 124

OfflineManagement 125

Error Messages 125

#View%20%3CItems%3E%20Under%20This%20Item
#View%20%3CItems%3E%20Under%20This%20Item
#View%20%3CItems%3E%20Under%20This%20Item
#View%20%3CItems%3E%20Under%20This%20Item
#View%20%3CItems%3E%20Under%20This%20Item
#View%20%3CItems%3E%20Under%20This%20Item


Canceling Locked Items 126

Working Offline 126

Submission of Offline Files 127

130

Time Tracking v8 130

Time Tracking Need to Knows 131

Time Tracking Reporting 133

Time Tracking - Legacy Time Tracking 133

Enabling Time Tracking: 134

Steps to Logging Time: 134

Rolling Up Logged Hours: 134

Incident LoggingWizard 135

Steps to Using Incident LoggingWizard 136

Workflow Tables of Contents 136

Workflow: Overview 137

What is a workflow? 137

CreatingWorkflows 138

Workflow Map 138

Workflow: Glossary 139

State 139

Transition 139

Trigger 140

Condition 140

Validation 140

Action 140

Default Permissions 140

State Permissions 140



Responsible and Informed E-mail Notification Recipients 140

Workflow: Creation Overview 141

Stages ofWorkflow Creation 141

Workflow: Creating and Editing of aWorkflow 143

Create aWorkflow 143

Editing ExistingWorkflows – Published and Draft 143

Workflow: Building States 144

BuildingWorkflow States 144

Workflow: Setting Default Permissions 145

Set Default Workflow Permissions 145

Workflow Creating Triggers 146

Creating Triggers 146

Workflow:Working with Transitions 149

Understanding Transitions 149

Editing an Existing Transition 150

Adding Additional Transitions to a Trigger 150

Managing the order of transitions 150

Workflow: Adding Conditions 151

Adding Conditions to a Transition 151

Check Value 151

HasValue 154

Steps to Adding/Editing Conditions 154

Workflow: Adding Validations 156

Adding Validations to a Transition 156

Check Value 156

HasValue 159

Steps to Adding/Editing Validations 159



Workflow: Adding Actions 161

Adding Actions to a Transition 161

Workflow: TransitioningWorkflow States - Combining Conditions/Validations/Actions 162

Understanding the Processing of Conditions, Validations and Actionswithin Transitions 162

Conditions 163

Validations 163

Actions 163

Successful Transition 163

Ensuring all Necessary Information is in Place for a Transition to Take Place using Validations. 163

Capturing Information at the Time of a Transition using Actions. 164

Managing theWorkflow UsingMultiple Transitions and Conditions. 165

Identifying Failed Validations (7.1) 166

Workflow: Defining State Permissions 167

Steps to Defining State Permissions 167

Workflow: Creating E-mail Notifications 168

Steps to Creating E-Mail Notifications 168

Part A: BuildingWorkflow Templates 168

Part B: Associating templates to each possible transition 170

Part C: Add Aggregate Email Templatemessage 171

Important Information about Aggregated Email Notifications 172

Workflow: Immediate Emails 172

173

Part A: BuildingWorkflow Templates 173

Steps to Creating an Immediate Email 174

Customizing Immediate Emails (7.1) 174

Steps to Customizing an Email Body 175

LinkingWorkflows 176



Building LinkedWorkflows 176

Creating the ACTION that Sends the Event 176

Creating the TRIGGER that Receives the Event 177

Setting upGlobal Triggers 179

Identifying State Status of LinkedWorkflows 179

Workflow: Managing Subtypes 180

Managing SubtypesOverview 180

Managing Subtypes – Detailed Information 180

Workflow: ResettingWorkflow on Item(s) 181

ResettingWorkflows on Item(s) 181

ResettingWorkflows from “Manage By…” Screens 181

ResettingWorkflows during Period End 181

Workflow Reporting 182

Reporting onWorkflow States - Overview 182

Hierarchical and Item overview Reports 182

HomePage Pie Charts 182

Workflow: User Interaction (Manage By& Matrix Assessor) 183

UsingWorkflows – “Manage By…” Screens 183

UsingWorkflows – “Matrix Assessor” 183

Workflow User Interaction (Emails) 184

Workflow E-Mail Notifications 184

Workflow User Interaction (My Tasks) 186

Interacting with My Tasks via the Homepage 186

Setting up theMy Tasks dashboard 186

Report 188

Reporting Introduction 188

Executive Dashboard 188



Export the Executive Dashboard to Excel 189

ItemOverview Reports 189

Sort Items on the ItemOverview Pages 190

Export Items toMatrix Assessor 190

Export Items to Chart Builder 191

Export to Resolver Survey 191

Export to Resolver Ballot 192

Export Items Listed on the ItemOverview Page toWord or Excel. 192

Print Items Listed on the ItemOverview 193

Saved Reports 193

Fixed Headers 193

SummaryReport 194

SummaryReport Builder 194

Location or Location Process SummaryReport 194

Organization-Wide Process SummaryReport 194

Export SummaryReport to Excel, Word or PDF 195

Print Items Listed on the SummaryReport 195

Saved Reports 195

Hierarchical Report 196

Hierarchical Report Formats 196

Hierarchical Report Builder Screen 197

Build a Hierarchical Report 197

Hierarchical Report Viewer Screen 198

Export Hierarchical Report to PDF, Excel or Word 199

Using Hierarchical Report Data in Chart Builder 200

Exporting File Attachments 200

Saved Reports 202



202

Fixed Headers 202

Unformatted List Report 203

Audit Trail / Change Log 203

The Report Tab 203

The Filters Tab 203

ActionsCaptured in Audit Trail 203

Change Log Tab 204

Redlining and Highlighting Changes 204

Using the Parallel Processing Engine for Generating Large Reports 205

Saving Reports generated by the Parallel Processing Engine 205

Saving and Sharing Reports 205

Create a New Report, Save the Settings and Share 206

Sharing Reports 206

Create a New Report, Save a Snapshot and Share 208

Edit a Saved Report 208

Run a Saved Report 209

Delete a Saved Report 209

Move a Saved Report 210

Create a Folder to Store Your Reports In 210

Delete a Folder with Stored Reports 210

Accessing Saved Reports from the Homepage 210

See Saved Reports from the Homepage 210

Drag and Drop Reports and Report Folders 211

Chart Builder 211

Scatter & Cross Table Charts 212

Scatter Charts 212



Generating a Scatter Chart 212

Cross Table Charts 213

Generating a Cross Table Chart 214

Pie Charts & Doughnut Charts 216

Generating a Pie Chart 216

ColumnCharts & Bar Charts 217

Criteria Function Chart Examples 218

Example A: 218

Criteria Function Chart Examples 218

Example A: 218

Criteria Function Chart Examples 218

Example A: 218

Saving and Sharing Charts 219

Save Chart Settings and Share 219

Save Chart Snapshot and Share 219

Edit a Saved Chart 220

Recreate a Saved Chart 220

Create a Folder to Store your Charts In 220

Move a Saved Chart 221

Delete a Folder with Stored Charts 221

Accessing Saved Reports from the Homepage 221

See Saved Charts from the Homepage 221

Drag and Drop Charts and Chart Folders 221

Editable Reports 222

Feature Overview: 222

Quick edit of all criteria types 222

Assessing Criteria Items (Assessments automatically saved to the database) 222



Available in all styles of report 223

Option to transition workflow 223

Access to the view item (attach files / manage permissions / create new items) 224

Revert changes 225

Calculate Functions 226

Rich text report description available in report header 226

Additional Information 227

Overriding Editable Reports 227

Advanced Reporting and Analytics 228

Component of the Analytics Page 228

System Administration 230

MyProfile 230

Modify Your Profile 230

Change Full Name 231

Change Email Address 231

Change Culture 231

Change Password 231

Change ChallengeQuestion - Functionality Removed in 8.1.1 232

Change Homepage Preferences 232

Change Data Preferences 232

File Permissions 233

ChangeGroupMembership 234

My Inbox - Functionality Retired in v8.0 234

My Inbox - Functionality Retired in v8.0 234

Read aMessage 235

Delete aMessage 235

ApplicationMessages 235



User Management 235

Create a New User 236

Edit an Existing User 236

Edit an Existing User – User Profile 237

Change ChallengeQuestion - Functionality Removed in 8.1.1 237

Change Data Preferences 237

Change Homepage Preferences 238

File Permissions 239

ChangeGroupMembership 239

Delete an Existing User 240

Impersonating a User 240

Updating LDapUser Profiles 240

GroupManagement 241

Create a New Group 241

Edit a Group 241

Change Description of a Group 242

ChangeGroup Homepage Preferences 242

Add/Remove Users to/from aGroup 242

File Permissions 243

Delete an Existing Group 243

Understanding Roles and Permissions 244

Roles 244

Cascading of Role Permissions 246

Advanced Permissions and replacement of Local Administrator andOwners 246

Setting up Roles and Permissions in Role Builder 247

Creating a Role 247

Delete a Role 248



Editing Role Permissions 248

Selecting Field Permissions 248

Selecting Advanced Permissions 248

Selecting E-Mail Notifications 249

Managing RoleMembership 249

SystemSettings 250

Email Templates 251

ApplicationMessages 252

Import Criteria Values 253

Specifications: 253

Excel Formatting: 254

Importing the Criteria 254

File Management 255

Upload a File 255

Uploading 256

Delete a File or Hyperlink from the System 256

Modify File Permissions 256

Search for a File 257

Edit or Upload New Versions of Files in the System 257

Period End 258

Overview 258

Period End Process 259

Lockout All Other Users 259

Step 1 of 5: Lockout Other Users and Name this Period 259

Step 2 of 5: Archive andMaintenance 260

Step 3 of 5: Delete Non-Framework Items "EnMasse": 260

Step 4 of 5: Clear Criteria and Function Values / Remove or Purge Attached Files / ResetWorkflows 261



Step 5 of 5: Reopen Items and Remove User Lockout 261

2 Factor Authentication 262

Enabling 2 Factor Authentication 262

Administrator Permissions 263

Two types of administrative options: 263

Limited Administration 264

Creating a Limited Administrator 264

Login Page 264

Customization of the Client Logo 264

Customization of theWelcomeMessage 265

Resolver Contact Info 266

GRC Cloud Editions

GRC Cloud supports two editions of the software to help your organization customize the level of features / functionality

and services required to obtain themaximum value possible from the product.



Quick Overview

If you would like to learnmore about GRC Cloud Editions, please contact us or visit Resolver.com.

Main Components of the Enterprise Edition

Advanced Reporting and Analytic’s - GRC Cloud’s Enterprise Edition will give you direct access to your

data!

You will be able to directly query your data using any standard application to build custom reports and dash-

boards.

Users of the systems will be able to build custom reports, dashboards, analytic’s directly in GRC Cloud.

Bring your data to life, these read-only data warehouse will be updated daily!

Custom Visualization –GRC Cloud dashboards can be contextualized so that a single dashboard can be

reused by many users with their own data.

Custom Reporting – Reports can be shared with any user and provide stunning,pixel perfect, paged reports

across all GRC Cloud data. Reports are contextualized so a single report can be reused by many users with

mailto:info@resolverGRC.com?subject=Enterprise Information
mailto:info@resolverGRC.com?subject=Enterprise Information
http://www.resolvergrc.com/grccloudenterpriseedition/


their own data.

Microsoft Office Connections – Connect Microsoft Office directly to the GRC Cloud data warehouse. Auto-

matically refresh the data when you open the file or as you specify.

Additional Storage – Enterprise Clients are entitled to twice as much storage as professional clients.

To obtain your current edition, please click on the About menu option located under the Tools Menu > Help.

GRC Cloud Menu

Administrative

Non Administrative Menu

Manage

Once Administrators have configured the information in the Administration area, users complete evaluations they have

been assigned and carry out testing and remediation activities in theManage area. This is done in theManage by Location

or Manage by Scoping Item area.



Report

Reports can be generated on any items in the system in a number of different formats. Reports vary by purpose, design

and detail level. Reports are highly configurable in terms of filtering and content inclusion/exclusion.

Administration

All tools needed to administrate the system can be found under this menu header:

● Criteria

● Item Templates

● Frameworks

● GRC Programs

● Users / Groups

● Roles

● System Settings

● Period End

Tools

This area is for functionality that is used less frequent than any other area of the application

Key areas include:

● Setting personal users’ profiles

● Timesheets

● File management

● Reviewing queued reports and other requests

● Setting of ChallengeQuestions (Security)

● Offline Assessments

● Audit Trail

● Help Documentation

User Community

The Resolver User Community was launchedmid-way through the 6.1 release. The User Community can be accessed via

the Cloud Systemmenu. Articles, best practices and informative discussions surrounding GRC practices are all available

within the community.



The first time it's accessed via Cloud, it will auto-create a user using their Cloud credentials.

● Username and password will be used to access the community

http://community.resolvergrc.com

Browser Support

The better the browser, the better the experience! AlthoughGRC Cloud supports later versions of Internet Explorer, it is

strongly recommended to use the latest version of the browsers listed below. Use of legacy browsers will result in per-

formance degradation andmay not support all features available in GRC Cloud (see additional notes).

To get the best GRC Cloud experience possible, we strongly recommend using the best browser available to

your organization.

Supported Browsers

Additional Notes

1. Support for Internet Explorer 7 has been dropped with the release of 7.0.

2. Support of features introduced in future release are not guaranteed in legacy browsers.

http://community.resolvergrc.com/


3. List of Features not supported or experience performance degradation in Internet Explorer 8:
● Administrative Angular Pages: Manage Analytics andGRC Programs.

● Spreadsheet Criteria experience severe performance degradation.

● Report load times experience severe performance degradation.

● View Item page loads experience severe performance degradation.

Frameworks

The information stored in GRC Cloud is organized by Frameworks. There are three Framework types and each is used to

build out various types if relationship between items in the system.

Types of Frame-
work:

Use:

Framework Library Used to create the structure reflecting your Governance, Risk and Compliance hierarchies.
The Framework Library lets you create multiple customized frameworks. Once these frame-
works exist, you will attach applicable portions of them to your Location Framework and
Account Framework.

You can build a Framework Library from pre-built framework templates such as COSO and
COBIT.

These custom or pre-built frameworks are the foundation for all other work performed within
the system.

Org/Location
Framework

Used for developing your Organizational Structure, including regional or functional areas.

Items in the system cannot be evaluated until they have been assigned to a location.

Scoping Item
Framework

Used for linking your Risk and Control hierarchies to your scoping system, providing an alter-
nate view of the data and a structure for placing items in to, or out of, scope.

Understanding Roles and Permissions

GRC Cloud’s granular permission set and Role-based approach to permissions has a variety of benefits, including:

● Enables more efficient creation of sets of permissions that can be applied tomultiple users and then

edited for multiple users later if required.

● Enables any criteria within an item to be editable, readable or hidden for members of a specific role

● Different users can see and edit different criteria within the same item



● Enables users to occupy different roles within different parts of the framework. For instance if an individual

has responsibility for testing controls and overseeing the work of other control testers, he/she can be

member of one role (Control Tester) for some items and another role (Control Test Supervisor) for others,

which would have different permissions.

For information on steps to building out Roles and Permissions, see Setting up Roles and Permissions in Role Builder.

Roles

In GRC Cloud, a Role is not a collection of users with similar responsibilities. Instead, a Role is a set of common per-

missions for one or more item types or sub-types. A Role is then applied to a specific item in the location framework or

scoping item framework, and then a specific user (or users) is chosen to occupy the Role for that item.

Therefore there are three elements to setting up permissions for a user and an item.

1. A Role is created and its permissions for various item types are defined

2. The Role is applied to items

3. Users are applied as role members for the items

Step 1 is performed in a Role Editor where new Roles can be created and assigned to different item types and then in turn

to different fields for the various item types.

Example:  At Company X, a Control Test Supervisor may require the following permissions

● Location: Read name of location ONLY

● Folders: (e.g. Processes, Sub-processes and Cycles). Read the name and description of these items.

● Risk: Read all risk criteria, including name, description, impact, likelihood etc.

● Test: Read name and description of test, edit comments and notes and description of test procedure. Also able to

add Test Results, Issues and add attached files.

● Test Results: Read and Edit all fields.

● Issues: Read and Edit all fields. Manipulate permissions for Issue so it can assigned to a co-worker.



All the capabilities listed above could be saved in one Role called Control Test Supervisor.

Steps 2 and 3 are typically combined into one action called PermissionMembership. In these steps, items in the Location

Framework or Scoping Framework are selected and the role and user applied to that item. This can be done in one of two

ways:

● In Role Editor, a Role can be selected and then applied to specific items and users, or

● In Manage by Location andManage by Scoping Item, an item can be selected and a role and individual

user can be applied to that item.

● Synchronizing permissions with multi user picker. See "SyncingMulti User Picker with Permissions" on

page 45

Cascading of Role Permissions

As a Role typically represents permissions for multiple item types, a cascading concept enables role membership to be

automatically applied to items above and below the item where role membership is being edited. (6.1)

It is now possible to havemultiple anchor nodes on the branch of the tree. In this scenario the permissions will cascade as

expected, but will not override each other, they will grant the user a combination of the 2 sets of permissions.

Example:

Using the Company X example, if Pat Campbell is being given the role membership for the Control Test Supervisor role at

Risk #261, the system also identifies the items above and below that risk in the hierarchy for which the role has



permissions. Pat therefore receives role membership for these items also.

Therefore, Pat Campbell would get Control Test Supervisor permissions for the Locations and Folders above that Risk and

also for any Controls, Tests, Test Results and Issues below the Risk. However, Pat does not receive permissions for

Action Plans or Steps, as these are not defined in the Control Tester role.

Advanced Permissions and replacement of Local Administrator and Owners

In addition to setting read or edit permissions for each criteria, other permissions may also be defined for a role.

● Ability to add child items to items in the location framework or scoping item framework. The permission

can limit the item type/sub-type to which child items may be added and the item types/sub-types which

may be used as child items.

● Ability to add, delete or edit file attachments to an item type or sub-type

● Establish the role membership for other users in specified roles for a specific item type or sub type. (This

ability replaces Local Admin.)

● Ability to receive specific e-mail alerts: Functionality retired in v8.0

o On creation of a new item (this message was previously sent only to Owners)

o Completion Reminder alerts

o Deadline Reminder alerts

o Sign-off Ready notifications.

For information on steps to building out Roles and Permissions, see Setting up Roles and Permissions in Role Builder.

System Search

Search is available on all screens of GRC Cloud except pop up windows. The search feature is in the top right corner of

each screen.



1. Simply enter a search term

2. Define the parameters to search (Item Number, Item Name, Attachments)

3. Attachment Search: searches attachment names, descriptions and file content (Microsoft Office types / PDF files

are not included in the search).

Note: Description appears as an option if Item Description is enabled to in the system settings.

A list of items is generated in a pop up window. The list includes an icon, item number, name, description and parent name.

All fields except the icon are hyperlinks which will open the actual item or file attachment page. Clicking in the plus sign

next to the parent namewill display a full path for the item.

Note: The number of results is currently limited to 50 items and 50 files for performance reasons.

Design Your Organizational Information

The Design section of GRC Cloud enables Administrators to build the organization’s overall risk/control framework, trans-

pose the appropriate parts of this framework into the organization’s location or organizational structure and define the crite-

ria which are used to assess all items within the framework. The Administrator also uses The Design area to relate items

within the framework to the organization’s scoping or account structure, whichmay be used to identify materiality for scop-

ing control evaluation work, and to applications.
This section is for use by Administrators only. All the design functionality is located under the Designmenu. For users who

are not members of the Administrators user group, the Design option will be grayed out.
Only Administrators have access to the Design area of GRC Cloud, however some framework building and editing tasks

may be performed by non-Administrator users in theManage by Location area if they aremembers of roles with appropriate

advanced permissions.

Audit Trail / Change Log

Change Log provides Administrators with a complete list of all user activity that has occurred on the application to date. It

outlines the date and time of the activity, the Item that it concerns, the User’s name that performed the activity, and a brief

description of the activity. This functionality is used for audit purposes and cannot bemodified.



Note:Audit Trail does not capture administrative configuration actions. (Example: workflow building of states / triggers /

transitions / emails, item templatemanagement)

Only Administrator groupmembers can access this functionality.

1. Click onReport > Audit Trail.

2. There are two tabs on this page: Report and Filters.

The Report Tab
All user activities made in the system are listed here. They are sorted chronologically and show the Item name, date, user

and a description of the change.

3. Click on an item name to see where the item exists in the organization. TheBrowseMyOrganizationwindow will

appear.

4. Use the column headings to sort changes displayed on the page (as done in the Item Overview pages).

The Filters Tab
5. Enter the criteria you wish to filter by: Item name, datemodified, user/group or whether items are deleted.

6. Click the Filter button to display the results.

Actions Captured in Audit Trail

1. Creating and deleting items

2. Moving andMulti-ing items

3. All criteria, function calculation and attachments add to the system

4. Exporting items offline

5. Workflow state changes

6. Updating to/from the library

7. Permission changes to workflow and role builder (8.0)

8. Password Changes (8.0)

9. Creating, deleting andmodifying attributes of roles, groups and users (8.0)

Change Log Tab

A complete record of every user action associated with the Item is displayed in the Change Log tab. This functionality is

used for audit purposes and cannot bemodified. The Date, User Name and Description of the action are displayed in chron-

ological order with themost recent action first. Change log doesn't not record administrative actions (Role Permission build-

ing, framework building, etc)



By default, the Change Log tab is deactivated for non-Admin users.

Redlining and Highlighting Changes
Specific to the Rich Text Editor, all changes will be tracked highlighting any additions in green text and redlining any

deleted text. This changemakes it easier to quickly understand what changes have beenmade to rich text criteria. (6.2)

Note: when initially assessing the rich text editor and spreadsheet criteria, text will not be highlighted.

Note: Audit Trail and Change Log do not capture redlining and highlighting of changes for the Spreadsheet criteria. Only rec-

ords the latest value. (7.0)

Item Templates

An Item Template defines the characteristics (attributes and evaluations) for all instances of an Item Type. For example, all

Risks share characteristics that are defined here, including all Attributes, Evaluations and Functions. Each Item Template

page provides you with the necessary tools to develop Sub-Types, assign assessment criteria, and build Functions.
The Item Templates menu contains templates for all Item Types in the system.

Modify Basic Characteristics of an Item Type

1. Click onAdministration >Item Templates.

2. Select the Item Type or Sub-Type you wish tomodify. (Sub-Types are indented to the right of the Item Types list.).

3. Click on theOverview tab, (it is selected by default).

4. Name: Change the item name if required. For instance, Department may bemore suitable than location in your

organization.

5. Description: Enter an optional description of this item type.



6. Icons: The default icons may be changed to other images. The large icon will appear on the screen when that item

type is being assessed. The small icon is used in the framework view, reports and other parts of GRC Cloud where

screen space is limited. Multi-Parent Icons will only be used when one item has multiple parents. For more infor-

mation on creatingMulti-Parent Items see Design Framework Library.

To change an icon, click on theChange button adjacent to the current icon. Instructions are provided on optimum

image sizes. Use theUpload box to search for an image on your hard drive, network drive etc. and click Upload
Icon. Repeat the process for the other icons.

7. Click Save to apply all change(s).

8. Enable Sign Off: a new checkbox has been provided for the administrators to determine whether an item type and

all associated subtypes requires sign off capabilities. Unchecking the checkbox will remove sign off buttons and

report filters. (6.0)

If the option is not available (not visible) reference theSystem Setting:Enable Signoff of all Item Types, it must

be set to Yes to enable this option in the item template.

9. Enable Time Tracking: checkbox that enables users and administrators to log and track time against any item

type in the system. See "Time Tracking - Legacy Time Tracking" on page 133

Assign Criteria as an Attribute or Evaluation

Add an Existing Criteria
1. Click onAdministration > Item Templates.

2. Select the Item Type you wish to assign criteria.

3. Click on either theAttributesTab or theEvaluations Tab

Note: Criteria cannot be both an Attribute and an Evaluation for one Item Type/Subtype. For more information on

Attributes and Evaluations, see Design Your Organizational Information Criteria.

4. Click theAdd Existing Criteria button. A list of all criteria in the system will appear.If you are setting up the system

for the first time you will see “No criteria found.”

5. To assign criteria, click on the criteria name or select the check box beside its name.

6. Click theAdd Selected button once you have chosen the desired attribute criteria. The criteria will be added to the

item in the order they were listed.

7. You now have the opportunity to rearrange the criteria so they are presented to the evaluators in an intuitive

manner. Use theOrder drop downmenu to select the position for criteria.

8. You can choose tomake any of the criteria Required, whichmeans it must be evaluated for all instances of that

Item Type. If the box is unchecked, the evaluation of that criterion is optional.

9. Click Save to apply your change(s).

Add New Criteria
1. Click onAdministration > Item Templates.

2. Select the Item Type you wish to assign criteria.



3. Click on either theAttributes tab or theEvaluations tab. 

4. Click theAddNew Criteria button. This will take you to the Criteria Editor page and allow you to add new criteria.

5. When you finish creating your new criteria it will automatically be added to the Item Type.

6. You now have the opportunity to rearrange the criteria so they are presented to the evaluators in an intuitive

manner. Use theOrder drop downmenu to select the position for a criterion. This order also applies to report dis-

play, matrix assessor etc.

7. You can choose tomake any of the criteriaRequired, whichmeans it must be evaluated for all instances of that

Item Type before it can be signed off. If the box is unchecked, the evaluation of that criterion is optional.

8. Click Save to apply your change(s).

A graphical representation of the assessment is automatically created for each graphable criterion (criteria that havemul-

tiple choice answer types: drop downs, radio buttons, and check boxes). This Pie graph can be displayed on the user’s

Homepage. These are called “Preference Controls”. (See the System Administration “change homepage preferences” for

detailed information).

Add an Item Sub-Type

Item Sub-Types are used to allow differentiation within an Item Type. Item Sub-Types are evaluated by the Attribute and

Evaluation criteria for the Item Type but can also have additional criteria specific to the Sub-Type. Sub-Types can be dis-

played differently from themain Item Type and can be used to sort or filter reporting and graphing results. For example, a

company may have both an ERM program and a SOX compliance program. Thus, the company may want to differentiate

between SOX risks and ERM/Operational risks as there are certain additional evaluation requirements specific to those

risks for SOX. With the use of Risk sub-types, the company can specify required evaluation criteria for SOX risks that

ERM/Operational risks will not be required to assess for sign off.
Item Sub-Types will appear on an indented right side drop downmenu bar on the Item Templates menu once added. Fold-

ers have pre-configured Item Sub-Types.
1. Click onAdministration > Item Templates.

2. Select the Item Type to which you wish to add a Sub-Type.

3. Click on theSub-Type tab.

4. Click theAddNew Sub-Type button. The Add New Sub-Type screen will appear.

5. Enter in the name and description for the Sub-Type.

6. Other options can be changed as described for other item types.

7. Click Save to apply your changes.

Edit an Item Sub-Type

1. Click onAdministration > Item Templates.

2. Select the Item Type to which you wish to add a Sub-Type.

3. Click on theSub-Type tab.



4. Click the name of the Sub-Type to be edited from the list of Existing Sub-Types.

5. All items may be changed as described for other item types.

6. Click Save to apply your changes.

Delete an Item Sub-Type

1. Click onAdministration > Item Templates.

2. Select the Item Type from which you wish to delete a Sub-Type.

3. Click on theSub-Type tab.

4. Click the name of the Sub-Type to be deleted from the list of Existing Sub-Types.

5. The Sub-Type item template will appear.

6. Click theDelete button to remove the item Sub-Type.

Note: You will not be able to delete a Sub-Type Item if the Sub-Type has any Attributes, Evaluation criteria or functions set

up, or if it is in use within a framework.

Functions

Functions allow you to gather the results of multiple attributes, evaluations and other functions, and create a custom equa-

tion with a number of mathematical operators.  For more information see the Design Your Organizational Information—

Functions section.

You have the opportunity to rearrange the functions so they are presented to the evaluators in an intuitivemanner. Use the

Order drop downmenu to select the position for a function. This order also applies to report display, matrix assessor etc.

Synchronize Item Types

It has been designed to allow maximum flexibility when determine which items types get synchronized to which parents

types. For eachmain and corresponding subtypes, it allows the admin to define 'synchronize this main and/or sub type(s),

if the parent is of type(s) x AND exists in the scoping tree'.

For more details See "SynchronizingManage by Trees (Scoping to Location)" on page 89

Path Context (8.0)

Many organizations have the same processes and controls in multiple locations. Understanding that you are looking at a

control in the Payroll Process in Denver instead of New York or Rome is an important distinction; however showing the

entire path to the root of the tree can often includemany layers of information that are not helpful for context.

This release allows administrators to identify which item types and subtypes are important for context and can then dra-

matically shorten the path to an item. This abbreviated context field shows up in the Item Overview reports, the Focus

Picker and in the Timesheet.

To set up: Once in an item template, check off that Path Context box if you want see this item type appear in the Item Over-

view reports, the Focus Picker and in the Timesheet.



Note: Locationmain type is set by default

Criteria - Overview

There are two types of assessments performed within the system: Attribute assessments and Evaluation assessments.
Attributes are item properties that are typically consistent over time and tend to bemore descriptive of the item. Attributes

will appear on theOverview tab of an Item.

Examples include: description, account balance, control type, frequency andmateriality.
Evaluations are the assessments made for items for each assessment period. These will appear on theEvaluations tab

and are typically evaluated each assessment period.

Examples include: likelihood, impact, testing results and control effectiveness.
GRC Cloud enables users to configure both types of assessments within the system. All criteria are first created in the

Design Criteria section of GRC Cloud and are then assigned to Item Types as either Attribute criteria or Evaluation criteria

of that item. Users will then evaluate the item at the prescribed intervals (quarterly, annually, etc).
Use theDesign > Criteria page to create new criteria or edit, delete andmake copies of existing criteria.

For detailed instructions on building criteria in item types, seeManaging Criteria.

Attribute and Evaluation Criteria Types

Criteria may be structured as one of several types. Criteria types ensure that all assessments aremade in a consistent

manner by all users.

Check Box List: The Check Box List allows users to pick one or more options from a scale with 2 or more options.
You cannot graph or build Functions around this criteria type due to the multiple choice selection
capability.

Radio Button: Radio Buttons allow users to choose one option from a list of two or more options. This list differs
from check boxes in that only one scale choice can be selected and therefore they may be used
to build Functions and graphs.

Drop Down List: Drop Down List is a selection list that allows users to choose between two or more options. Like
Radio Buttons, the Drop Down List limits users to one selection and is therefore a suitable criteria
type for building Functions and graphs. There is no effective difference between drop down
menus and radio buttons except for how they appear on the screen.

Single Text Entry: Single Text Entry enables users to type in one or more words along a single line, limiting the
entry between 1 and 20,000 characters.

Multi-text Entry: Multi-text Entry enables users to type in one or more words in a text box with multiple lines and a
scroll bar, limiting the entry between 1 and 20,000 characters. Multi-text Entry boxes also enable
Rich Text Content, enabling text to be formatted in terms of size, color and justification within the
text. This also enables formatted text from other applications to be copied-and-pasted into GRC
Cloud. The formatted text includes tables, which when represented in reports may lead to very
wide report columns.
Note: not all formatting styles are supported when copying from 3rd party applications.

Numeric Entry: Numeric Entry limits users to entering a numeric value. The way numbers appear will be derived
from the culture settings of the user.

Date Entry: Date Entry allows users to select a date from a “pop-up” calendar. The way dates appear will be
derived from the culture settings of the user.

User List: User Lists enable users to specify one or more users and/or groups from the list of all users and



groups in the system.
Ability to sync the multi user list with the item permissions in Manage by. (6.1)

See "Syncing Multi User Picker with Permissions" on page 45

Spreadsheet Spreadsheet criteria provides the ability to display data in a spreadsheet view. Spreadsheet data
can be imbedded directly into the system and fully accessible by Manage by (view item), Matrix
Assessor, and Editable Reports. (7.0)

Formatting: option is built into the menu to format currency. Display of currency will be dependant
on the users local settings. Example: French decimals = commas.

Note: Spreadsheet criteria only supports 60 rows in IE8. Any data add in via another browser will
not be viewed by the user.

All criteria values can be cleared. For single line text boxes, rich text boxes and numerical fields the items may simply be

deleted. For check boxes, items may be unselected by clicking the boxes. User lists are cleared by clicking the X next to a

user's name. Radio buttons and date fields have a Clear option. Drop-downmenus are cleared by selecting the "Select"

choice in themenu.

The length of a criteria name is limited to 150 characters. Themaximum length of menu options for drop-downmenus, radio

buttons and check box lists is also 150 characters.

Managing Criteria

Create Criteria

1. Click onAdministration > Criteria.

2. The Criteria page will appear.

3. You will see a number of criteria which have already been configured and can bemodified or deleted as desired.

4. Click theCreate a New Assessment Criteria button.

5. Criteria Name: Enter the name for your new Criteria.

6. Help Text Popup: Text in this area will be visible to users completing assessments. Provide additional information

and/or instructions in the Help Text area, such as definitions of the question or of the criteria values, to enable

more accurate assessments.

7. Criteria Type: Select the required type from the drop downmenu.

Additional Options
Depending on the selected item type, additional options are available:

Radio Button List/Drop-Down List/Check Box List

Define the Scale Size for each criteria within the criteria template.

1. Create new (or existing criteria)

2. In the text box, copy and paste OR manually paste in the labels



3. If necessary, values and colors can be define immediately. (Ex: Toronto,1,#fff000). The last entry defines the color.

4. Save.

Display Order: The order can be changed by dragging and dropping the labels..
Label Values: You can change the numeric value for any of the scale choices by clicking the pencil. This is important when

any quantitative assessment is going to be based on the scale choices. The label values will affect any Functions or

graphs that use the results of this assessment or any graphs.
Note: The Label Values are not displayed when the users perform their assessments. If you want users to see the scale

values for criteria, the numbers have to be added as a part of the label.e.g. “5 – High Likelihood”.

Colors: To add a color for a scale choice, click on the color palette icon. Chose a color to represent each scale value. The

color choices make assessment screens and reports easier to follow and also impact the graphs, including each user’s

home page graphs. More information on using the Color Picker.

Update Preview: Enables you to preview how your selection will appear to users, including the use of colors.

Click Add orSavewhen completed.

Date Entry
Deadline: If appropriate place a check mark in the Deadline box if you want to use this date field as a deadline. This will gen-

erate automatic notifications to users based on the date selected.
Click Addwhen completed. Functionality retired in v8



Single Text Entry/Multi Text Entry
Maximum Text Length: If desired, change themaximum number of characters that can be entered into the text field. Note

that the size of the single text or multi text boxes will not change. (Single andMulti Text Entry), determine themaximum

text length.
Click Addwhen completed.

User List
Data Source: Customers who have integrated GRC Cloud user-ids with their LDAP Active Directory, can choose either list

as the data source of users. This is a customization available for a fee.
Selection Type: Select either a single user or multiple users.
Limit to: Enables the list of users to be filtered by members of a specific Group.

Spreadsheet Criteria (7.0)
Spreadsheet criteria provides the ability to display data in a spreadsheet view. Spreadsheet data can be imbedded directly into
the system and fully accessible through Manage by (view item), Matrix Assessor, and Editable Reports. These criteria can be con-

figured via the Add New Criteria page to display a default template reducing end user time and improving documentation con-
sistency. When clicking on this criteria in Manage by or Editable Reports, the template build will be presented to the user.

(8.0)

Building a Template

1. Select Criteria Type: Spreadsheet

2. Define the number of Rows and Columns

3. Click on theCriteria Template

4. At this point, all formatting described in the overview below is available

Note: To apply formatting to all rows and columns, data needs to be entered in the last intersecting cell of the defined

number of rows and columns. For example, adding an asterisks in the bottom corner.



Template Need to Knows:

- This functionality only applies to new templates going forward. If a template is added to an existing criteria,

it will not override any data in existing templates.

- Until the criteria is saved, it will continue to show themost up to date version of the template. The spread-

sheet cannot be updated by the template once it has been saved by a user.

- Default size of Spreadsheet: 10*20.

- Formatting of template only applies to columns with data in them (as noted above).

- Reports will not display the template.

- Period End orWorkflow Reset: if the criteria is cleared via the Period Process or workflow action, the latest

template will be set as default.

Overview

1. Default rows and columns are set: 25*40

2. Excess / unused rows and columns will be trimmed in reporting

3. Available as a condition / validation in workflow transitions (has value)

4. Full Screen option

5. Paste capabilities from Excel
a. Respect line breaks

b. Does not paste in formatting from 3rd parties (bolds, italics, coloring, etc)

c. Formulas from excel do not get pasted

6. Ability to freeze and unfreeze columns and rows
a. Select an entire row or column

b. Right click on the row or column headers



c. Select freeze or unfreeze (will freeze from the row/column and prior)

7. Delete / Insert Row or Columns

a. Select an entire row or column

b. Right click on the row or column headers

c. Select delete or insert this column / row

8. Wrap text
a. Select a row / column / cell / multiple cells

b. Click the wrap icon



c. Click again to unwrap

9. Delete Sheet

Simply click delete sheet icon seen in the image.
Note: this will delete all data held in the spreadsheet. If done accidentally, simple click the X on the win-

dow and close without saving the changes.

Edit Criteria

1. Click onDesign > Criteria. The Criteria page will appear.

2. Click on the Criteria name you wish tomodify. Beside each criteria name and type, you will see the Item Types

and Item Subtypes that a criterion is currently attached to. The Edit Criteria window will appear.

3. Make the required changes to the criteria, as described in the Create Criteria section of this guide.

4. Update Preview will instantly update.

5. Click Savewhen completed to apply your change(s).

Note: Label Deletions



If you delete a label from check box, radio button or drop down criteria, GRC Cloud automatically deletes any assessments

made up to that point to protect data integrity. For this reason, it is highly recommended that you do not modify the labels

once assessments have begun.

Furthermore, changing the order of the labels will not update the evaluations. Example: scale of high = 1 / medium = 2 / low

= 3 changing the order of the text (medium = 1 / high = 2 / low = 3) the assessment related to high =1 will not update to high

= 2. This is only a text / position change, not a change the relationship in the database.

Adding additional labels to the criteria will not impact the criteria across the application.

Note: Criteria Type

You can change the display style between similar criteria (e.g. between Drop Down Lists and Radio Buttons). However,

you cannot change the basic properties of criteria. (E.g. if the current type is Check Boxes, then you cannot change the

criteria type to Radio Buttons or Date Entry.)

Delete Criteria

1. Click onDesign > Criteria. The Criteria page will appear.

2. Click on the Criteria name you wish tomodify. The Edit Criteria window will appear.

3. Click on theDelete button.

4. A pop-up box will ask you to confirm that you wish to delete the item. Click OK.

Note: You cannot delete a criterion that has been added to an Item. If a criterion is attached to an item the Delete button will

be grayed out. You need to remove the association with all Item Types before the Delete button will be active.

Copying Criteria

There are two purposes to copying criteria:
To replicate the color scheme and rating scale of existing criteria without having to reproduce the labels and colors from

scratch.
Tomodify any existing criteria, you can edit the copy and retain the original version for reference purposes.

1. Click onDesign > Criteria. The Criteria page will appear.

2. Select the criteria you wish to copy by checking the box next to the criteria name.

3. Click theCopy Selected button.

4. The new item will appear with “(COPY)” after its name.

Using the Color Picker

The color picker provides flexibility in selecting colors (16million colors available vs. the 216 in previous versions). Admin-

istrators can also define colors by their hexadecimal code, RGB code or HSB code.

1. When creating or editing a check box, radio button or drop down criteria, the Administrator can select colors for

each available option or value, by clicking the Palette icon.



2. The initial Web Palette view appears. Choose a color by clicking on any one of the boxes. To clear the selection

(so that the criteria option no longer has any color applied to it) click NoColor. Note that the standard hexadecimal

code for the color appears. The hexadecimal code is a technology standard for defining colors and is made up of a

has sign (#) followed by six numbers and/or letter. By recording the hexadecimal code an Administrator can ensure

that consistent shades are used on all criteria and item types.

3. To select from a broader range of colors, click on the HSB tab. The following view is displayed. On this screen,

any one of over 16million colors can be created, in one of three ways:



● Use themouse to select a color in themain window and then using the slide bar at the right to determine the

lightness or darkness of the shade of the color.

● Use the Red, Green and Blue (RGB) settings to create a color.

● Use the Hue, Saturation and Brightness (HSB) settings to create a color

Syncing Multi User Picker with Permissions

During creation of the user list criteria, the administrator has the option to set the criteria to synchronize with a defined role.

It will add the user selected to the synched role while cascading to the relevant tree items as regular permissions would. It

also works in the reverse by syncing any removal of permissions via the Role Builder or Permissions tab with the users in

the criteria list.

Creating the Criteria

1. Administration > Item Templates > Select "Item Template"

2. Attributes or Evaluations tab

3. AddNew Criteria

4. Select User List as Criteria Type

5. SelectMultiple as Selection Type

Note: Page will refresh with Permissionmanagement options

6. Check: 'Synchronize the user list with the defined role and applicable permissions'

7. Select the Role

Note: users in the permissions tab as anchors will automatically be synced with the role and inherit the

applicable permissions when the criteria is saved.

This criteria will now be visible to the users in Matrix Assessor andManage by Location/Scoping. Any users added to this

criteria will be granted all applicable permissions granted via the role, using that item as the anchor node.

When the new criteria is added, it will automatically sync all the relevant anchor nodes with the criteria. However, if the

criteria is deleted, it will not remove the permissions from the items.

Cascading of permissions will be applied to the tree, however, the anchor nodes on other levels will not be overridden. For

further information on permissions and cascading please See "Understanding Roles and Permissions" on page 244

Syncing applies to both adding and deleting users from this criteria.

Functions - Overview

Functions allow you to gather the results of multiple attributes, evaluations and other functions, and create a custom func-

tion with a number of mathematical operators. To build a function, first define the variables that will be used within, and then

select the appropriate operators. Variables are attributes, criteria or functions, from that item or any item beneath it in the

tree. Operators are your traditional mathematical operators +, -, *, / and others. Because a function can become very



complex, to obtain the result for a function, youmust explicitly trigger its evaluation with the click of a button (amended in

7.1 - See Below).

Functions Auto Calculate

If a criteria value changes and a function lying on that item incorporates that criteria as a variable of the function, it will auto-

matically trigger the function to recalculate. This applies to all areas of the application on save of the criteria. For more infor-

mation.See "Managing Functions" on page 47This functionality only applies to functions that lie on the item where the

criteria has been changed. For example, if a function on the risk has a criteria change on itself and the criteria is a variable

in the function, it will update. It will also update any other variable functions incorporated. For example: a variable that

requires drawing from a function on another item.

It occurs on save of the item in the following areas: Manage by, Editable Reports (criteria save / revert), clearing criteria,

updates from Framework Library. It is not applicable to: Criteria Importer, Offline Assessor, Period End, Matrix Assessor.

Example: Update the Residual Likelihood from Rare to Possible, the Residual Risk function auto calculates toModerate

Warning: Enabling this featuremay cause performance degradation in Editable Reports. If this occurs in your envi-

ronment, please contact Resolver Support.

A selection of logical mathematical operators are available when constructing functions. Many of these are useful for cre-

ating complex conditional formulae, such as "if/then" statements. There are a number of applications of these andmore

information is available from Resolver's Solutions Consulting Group.

Throughout GRC Cloud, where there is no result for a function it will be displayed as either Invalid or Not Calculated.

Invalid indicates that one or more of the variables used in the calculation is missing or in some other way invalid. (For exam-

ple, if a function on a risk calculated the average of ratings of several controls, but not all controls had been rated.) If the

function has not been calculated and therefore there is no result it is displayed as Not Calculated. In previous versions, the

wording was inconsistent across various parts of the application and the two situations were not indicated properly in pie

charts in the home page or in the Executive Dashboard report. (5.3)

Function Roll Down

Release 6.1 provides an additional source to draw from when calculating functions. Function variables can be created to

draw from all direct Ancestors in tree. Administrators will have the option to pick Ancestors from the Source drop down

which will refresh with all possible direct ancestors.

Example: A function that lies on a Control has the ability to draw from data that lie at the Risks, Folders, Locations, Scop-

ing Items levels.



Managing Functions

Create a New Function

A selection of logical mathematical operators are available when constructing functions. Many of these are useful for cre-

ating complex conditional formulae, such as "if/then" statements. There are a number of applications of these andmore

information is available from Resolver's Solutions Consulting Group.

Throughout GRC Cloud, where there is no result for a function it will be displayed as either Invalid or Not Calculated.

Invalid indicates that one or more of the variables used in the calculation is missing or in some other way invalid. (For exam-

ple, if a function on a risk calculated the average of ratings of several controls, but not all controls had been rated.) If the

function has not been calculated and therefore there is no result it is displayed as Not Calculated. In previous versions, the

wording was inconsistent across various parts of the application and the two situations were not indicated properly in pie

charts ion the home page or in the Executive Dashboard report.

1. Click onAdministration > Item Templates.

2. Select the Item Type you wish to assign a Function.

3. Click on the Functions tab.

4. Click theCreate New Function button.

5. The Function Builder page will appear.

6. Provide the Function a name, and add any details about the Function in the Description area.

7. Add variables to the function one at a time by pressing theAdd Variable button.

8. Then type your formula using the available operators and any added variables.

9. When you are finished writing your function, choose if you wish to show previous results and if so, choose the

number of previous results to display. - Functionality removed in 7.1

11. Determine whether you want the function to Auto calculate. Uncheck to disable the auto calculation (default = ena-

bled). See "Functions - Overview" on page 45

12. Choose whether to group your results into ranges or not.

12. If you choose not to use a range the numeric result will be displayed. If you choose to use a range, the numeric

result will be displayed alongside the assigned label and color.

Note: If you do not use ranges, the function cannot be reported in Chart Builder.

13. Click Save to apply your changes.

Add a Variable

Variables can be either a single value or a set. If the source you select is from multiple items then the variable will be a set. If the
source is a single item then the value will be a single number.



1. From the Function Builder page click Add Variable.

2. Select the source for the variable. The preview will show you which items can be the source.

Self: Attributes, Evaluations, and Functions attached to this item.

Descendants: Attributes, Evaluations, and Functions attached to any item beneath this item in the tree.

Children: Attributes, Evaluations, and Functions attached to any item directly below this item in the tree.

Siblings: Attributes, Evaluations, and Functions attached to any item with the same parent item as this item in
the tree.

Ancestors: Attributes, Evaluations, and Functions attached to any item that it is a direct ancestor. An immediate
path up the tree.

3. Once you have determined the source, select the item type the desired criteria are attached to. The list of available

item types is dictated by the rules governing the hierarchical structure of the tool.

4. A list of attributes, evaluations, and functions attached to that item type will appear.

5. Select the desired criteria or function as the variable source.

6. Type in a short name for the variable with no spaces or numbers that resembles the selected source.

Display Options

Function results can be displayed in a variety of new formats.

Format

1. Number: returns a numeric value.

2. Currency: returns a numeric value with desired currency symbol. Note: it does not do any currency conversion.

3. Date: returns the value in a variety of different date formats.

4. Percent: returns a numeric value with a percentage symbol appended. Note: it does not do any conversion to per-

centage (decimals > percentage).

5. Boolean: returns a true or false result.

Displaying Function Results (if reporting by ranges only)

1. Displays both the label and value: returns the label and value (ex: 3 - Low)

2. Displays label only (ex: Low)

3. Displays value only (ex: 3)



Add an Operator

1. From the Function builder page use the drop down list to see available operators.

2. Select an operator from the list to see the syntax and a definition.

Some operators can handle variables that are sets and some cannot. Be careful to use the correct operator for your variable

type.



Mathematical Operators

Operator Description Valid Inputs

ADD (+) The sum of the two operands Numbers, Single Variables, Functions

AVERAGE The mean of all numbers Numbers, Single Variables, Sets, Functions

COUNT The count of all numbers Numbers, Single Variables, Sets, Functions

DIVIDE ( / ) The first number divided by the second
number

Numbers, Single Variables, Functions

MAX The largest number in a set of numbers Numbers, Single Variables, Sets, Functions

MIN The smallest number in a set of numbers Numbers, Single Variables, Sets, Functions

MULTIPLY ( * ) The product of the two numbers Numbers, Single Variables, Functions

SUBTRACT ( - ) The first number minus the second number Numbers, Single Variables, Functions

SUM The sum of all numbers in a set of numbers Numbers, Single Variables, Sets, Functions

Logical Operators

Logical operators return 1 when a statement is true and 0 when a statement is false. Many of these operators only serve a

purpose when used in conjunction with others by "nesting" one function within another.

Operator Description Valid Inputs

AND True when all values in the list are the same Numbers, Single Variables, Sets, Functions

CHOOSE Selects the argument to be displayed from a
list of arguments

Numbers, Single Variables, Sets, Functions

EQUAL & NOTEQUAL EQUAL is true when two items are the
same. NOTEQUAL is true when two items
are not the same

Numbers, Single Variables, Sets (limited to
two arguments), Functions

GREATERTHAN & GREAT-
ERTHANOREQUAL

Returns true when the first argument is
greater than the second (or equal to)

Numbers, Single Variables, Sets (limited to
two arguments), Functions

IF If the condition is true, the first value is dis-
played, if false then the second value is dis-
played.

Numbers, Single Variables, Sets (limited to
two arguments), Functions

ISINVALID Returns true if the argument is the invalid
result of another function.

Functions

LESSTHAN & LESS-
THANOREQUAL

Returns true when the first argument is less
than the second (or equal to)

Numbers, Single Variables, Sets (limited to
two arguments), Functions

LOOKUP Compares a "look up value" with a series of
arguments and then returns a cor-
responding result from a list of results

Numbers, Single Variables, Functions, Sets

OR True when any item = 1 and false if all items
= 0.

Numbers, Single Variables, Functions, Sets

DAY Returns the serial day value of the given

date.

Date Criteria

MONTH Returns the serial month value of the

given date.

Date Criteria

YEAR Returns the serial year value of the given

date.

Date Criteria

DATE Returns the date value given by the spec-



ified arguments.

TODAY Returns the serial day value of the current

date.

Date Criteria

SET Creates an array of values that can be proc-
essed by another logical operator.

Numbers, Single Variables, Functions

Example of a Function

Likelihood and Impact – Risk Rating
Create a Function for Risks that can calculate a Risk Rating based on a Risks Likelihood and Impact.  A range can be

developed to categorize the Risk Rating and assign it a scale and colors for reporting purposes.

Name: Risk Rating

Description:

(Optional)

Calculates a Risk Rating based on Risks Likelihood and Impact.

Formula: Rlike * Rimp

Operators:

(Optional)

Multiply (*)

Variables: Name: Rlike

Source: Self

Item: Risk

Criteria: Likelihood

Name: Rimp

Source: Self

Item: Risk

Criteria: Impact

Display Options:

(Optional)

Report using ranges

Low <= 5 < Medium <= 10 < High # of Ranges: 3

Calculate a Specific Function

1. Click onManage > By Location or Manage > By Scoping Items.

2. Right click on an Item from the tree in the framework panel.

3. In the detail panel under theEvaluations tab, below the Criteria you will see the Functions Evaluations.

4. Displayed for each Function is: the name of the Function, the formula to calculate the Function and the evaluation

time.  If selected during the creation or modification of the Function, Past Results and/or a Range will be dis-

played.

5. If the function has Past Results selected, click the + button to view the Previous Results.  To return to the Latest

Results, click the – button.

6. If you have edited any of the criteria which comprise the variables used within the function, click Save All Changes

before proceeding with the calculation.

7. Calculate the Function by clicking theCalculate button.

8. Click Save All Changes to save your assessments.

Note:Function calculation capabilities in Manage by Location are also available in Matrix Assessor.



Calculate All Functions Under an Item

To calculatemultiple items simultaneously, use Calculate Functions at Item. This is used to update the calculations of all

functions (or multiple selected functions) at and below a specific item in the framework.
1. Click onManage > By Location or Manage > By Scoping Items.

2. Right click on any item in the framework tree.

3. Choose theCalculate Functions at Item option.

4. The right panel will refresh displaying a tree of the selected item and all items below it and lists the functions con-

tained in these items.

5. To recalculate all functions within and under this item, check Select All Functions. Alternatively, to select specific

functions navigate through the list by clicking the + signs to view all item types and functions.

6. Click Calculate to update all the function calculations with current data.

Functions can also be calculated automatically. For more information See "Workflow: Adding Actions" on page 161

Frameworks - Overview

There are four key areas to working with Frameworks in GRC Cloud. The links below take you to the full details on each

section.
● Framework Library, where you construct the overall governance, risk or compliance framework for your organization.

● Org/Location Framework, where you apply parts of the organization's overall framework to individual locations

(divisions, functions, departments, physical locations etc)

● Scoping Item Framework, where the organization's risk control matrix can be cross-referenced with account lines from

the income statement and balance sheet. This is useful for scoping of compliance programs, such as Sarbanes-Oxley

Section 404 and Canada's Bill 198 (NI 52-109). Other non account related frameworks may also be used as scoping

criteria in other compliance or risk management areas.

Applications and Application Controls reside in themain framework rather than in a separate Application-specific frame-

work. This change simplifies use of the software and provides better reporting with regular controls and application controls

being treated equivalently. The Application item type is similar to a Location and is set up in a Location framework. Appli-

cation controls can be used interchangeably with regular controls, or an Application Control sub-typemay be defined.

Framework Library

The Framework Library provides you with the tools to build your organization’s governance, risk and complianceman-

agement hierarchies(s).

For detailed information on building out the frameworks library, see Building andManaging the Central Framework

Framework Building Basics

● The starting point for your framework must be a Folder or a Folder Sub-Type.



● You can add an item tomore than one Sub Type group. So a Risk can be both a SOX Risk and an ERMRisk. Which

icon it displays will be determined by the Default Icon selection.

● Changes made in the Framework Library are not automatically reflected in any instance(s) of the item (i.e. in loca-
tions). Youmust use propagate or update to apply those changes. All items can bemoved from one Folder/Location to

another by just dragging and dropping.

Note: users can update an item and have the granularity of selecting specific criteria. Prior to 8.0, blank values

would be ignore. Now that the user can specify what criteria they can update, blank values will override any

values.

● You can add as many Items to a Folder/Location as needed.

● All items added to the Framework Library are given an automatically generated number in accordance with the set num-

bering standard. This number is reflected in any instance of the item(s).

● You can add new sub-items to existing items by right-clicking on the item in the framework panel. On themenu that

appears, select Add a New 'Item'. The system will only let you add sub-items based on the business rules built into the

system. (Example: You can only add Controls to Risks).

● You can set up items to havemore than one “parent” item. For instance one risk might relate to several processes or

one control may mitigate several risks. These are termed “multi-parent items”.

● You can set up items to exist in the framework in multiple locations but be assessed only once. These are termed “sin-

gle assessment items”. This is particular useful for setting application controls and entity level controls.

A new Single Assessment Item option enables any item to be defined as an item that can appear in multiple locations in

the framework yet needs to be assessed once centrally.

Building and Managing the Central Framework

Build Your Central Framework

Administrators and users with Advanced Permissions can now copy changes to the attributes and descriptors for one or

more items made in theManage by Location screen to the corresponding item(s) in the framework library using theUpdate

Library button.

Administrators and users with Advanced Permissions can now move items and createmulti parent items in theManage by

Location screen using theChange Parent button.

1. Click onDesign > Frameworks > Framework Library.

2. This brings up the Framework Library page. The panel on the left-side is reserved for your central Framework Tree.

3. The panel on the right-side is used as a workspace for editing individual items, and importing items from pre-built

frameworks.

4. On the Framework Library page, click the Framework Actions button and thenCreate New Framework.

5. Enter the name of your framework and, if desired, provide a description.

6. Click Create to add the framework into the system.



7. This returns you to the Framework Library page. On the framework panel you will notice the beginnings of your

framework, properly named and sequentially numbered.

8. You canmodify the framework details on the detail panel of the screen under theEdit Information tab.

9. Click Savewhen you are ready to add the new folder to your framework.

10. Continue building out your framework by addingmore items to reflect your company’s governance, risk and compli-

ancemanagement hierarchy.

Add a Sub-Folder to an Existing Folder or Sub-Folder

1. Click onDesign > Frameworks > Framework Library.

2. From the drop downmenu select the framework you wish tomodify. The first framework in the list is open by

default.

3. In the framework panel, click on the Folder you wish to add a Sub-Folder(s) to

4. The selected folder's information will appear in the detail panel.

5. Click theNew Folder button found in the content window toolbar in the right hand panel.

Alternatively, you can right-click the Folder in the left hand panel and select Add a New Folder from themenu that

appears.

6. The new Folder information will appear in the right-side panel.

7. Enter the, number, name and description of the new item as required.

8. Select the item Sub Type and Default Icon as required and indicate if this item is a Single Assessment Item.

9. Any Item Attributes associated with the Folder or Folder Sub-Type will appear below the description field. Admin-

istrators can fill in the Attributes information if this information is consistent across all locations this Folder is

added to.

10. Click Save to apply your change(s).

Move a Sub-Folder or Add a Sub-Folder to Multiple Folders

Sometimes Sub-folders contain items that apply to multiple Folders. For example, youmay have a single Control Objective

that applies to several Processes. To avoidmaintainingmultiple copies of the same Folder and sub-items, you can attach a

Sub-folder to more than one Folder. This makes the Sub-folder a “multi-parent” item. (Please note that multi-parent items

are different form single assessment items.) Users in Roles with appropriate permissions for the Sub-folder or its contents

canmake changes once, and the results will automatically propagate throughout the location.
1. Click onDesign > Frameworks > Framework Library.

2. From the drop downmenu select the framework you wish tomodify. The first framework in the list is open by

default.

3. Add a Sub-folder to a Folder (as above).

4. Open the item and click theChange Parent button in the right panel toolbar.



5. Tomove the item, select a new parent from the right hand panel and click Move. Alternatively you can simply drag

it to a new parent.

6. To “multi” an item (attach it to multiple parents), select all items to which this item should be added and click Multi-

Parent. Alternatively, hold down either theAlt, Ctrl orShift key, then drag and drop the Sub-Folder onto the second

Folder it applies to.

7. The system will ask you if you are sure you want to add the one Folder to the other. Select OK.

8. If you have created amulti-parent item, the same Sub-folder will now appear under both Folders and will be num-

bered identically. The Folder icon will automatically change into theMultiple Folder icon.

Add a Risk to a Folder

1. Click onDesign > Frameworks > Framework Library.

2. From the drop downmenu select the framework you wish tomodify.  The first framework in the list is open by

default.

3. In the framework panel, click on the Folder you wish to add a Risk to.

4. The selected Folder's information will appear in the detail panel.

5. Click theNew Risk button found in the content window toolbar in the right hand panel.

Alternatively, you can right-click the Folder in the left hand panel and select Add a New Risk from themenu that

appears.

6. The new Risk information will appear in the right-side panel.

7. Enter the, number, name and description of the new item as required.

8. Select the item Sub Type and Default Icon as required and indicate if this item is a Single Assessment Item.

9. Any Item Attributes associated with the Risk or Risk Sub-Type will appear below the description field. Admin-

istrators can fill in the Attributes information if this information is consistent across all locations this Folder is

added to.

10. Click Save to apply your change(s).

Move a Risk or add a Risk to Multiple Folders

Sometimes Risks exist that may pertain to multiple Folders. To avoidmaintainingmultiple copies of the sameRisk, you

can attach a Risk tomore than one Folder. This makes the Risk a “multi-parent” item. Users win Roles with appropriate per-

missions for that Risk canmake changes to it once, and the results will automatically propagate throughout the location.
1. Click onDesign > Frameworks > Framework Library.

2. From the drop downmenu select the framework you wish tomodify.  The first framework in the list is open by

default.

3. Add a Risk to a Folder (as above).

4. Open the item and click theChange Parent button in the right panel toolbar.



5. Tomove the item, select a new parent from the right hand panel and click Move. Alternatively you can simply drag

it to a new parent.

6. To “multi” an item (attach it to multiple parents), select all items to which this item should be added and click Multi-

Parent. Alternatively, hold down either theAlt, Ctrl orShift key, then drag and drop the Risk onto the second Folder

it applies to.

7. The system will ask you if you are sure you want to add the one Risk to the Folder. Select OK.

8. If you have created amulti-parent item, the sameRisk will now appear under both Folders and will be numbered

identically. The Risk icon will automatically change into theMultiple Risk icon.

Add a Control to a Risk

1. Click onDesign > Frameworks > Framework Library.

2. From the drop downmenu select the framework you wish tomodify.  The first framework in the list is open by

default.

3. In the framework panel, click on the Risk you wish to add a Control to.

4. The selected Risk’s information will appear in the detail panel.

5. Click theNew Control button found in the content window toolbar in the right hand panel.

Alternatively, you can right-click the Folder in the left hand panel and select Add a New Control from themenu

that appears.

6. The new Control information will appear in the right-side panel.

7. Enter the, number, name and description of the new item as required.

8. Select the item Sub Type and Default Icon as required and indicate if this item is a Single Assessment Item.

9. Any Item Attributes associated with the Control or Control Sub-Type will appear below the description field. Admin-

istrators can fill in the Attributes information if this information is consistent across all locations this Folder is

added to.

10. Click Save to apply your change(s).

Moving a Control or Adding a Control to Multiple Risks

Sometimes Controls may be used tomitigatemore than one Risk. To eliminate performingmultiple evaluations of the

sameControl you can attach a Control to more than one Risk. The evaluator will only need to assess the Control once and

the results will propagate throughout the location for that Control.
1. Click Design > Frameworks > Framework Library.

2. From the drop downmenu select the framework you wish tomodify.  The first framework in the list is open by

default.

3. Add a Control to a Risk (as above).

4. Open the item and click theChange Parent button in the right panel toolbar.



5. Tomove the item, select a new parent from the right hand panel and click Move. Alternatively you can simply drag

it to a new parent.

6. To “multi” an item (attach it to multiple parents), select all items to which this item should be added and click Multi-

Parent. Alternatively, hold down either theAlt, Ctrl orShift key, then drag and drop the Control onto the second

Risk it applies to.

7. The system will ask you if you are sure you want to add the one item to the other. Select OK.

8. If you have created amulti-parent item, the sameControl will now appear under both Risks and will be numbered

identically. The Control icon will automatically change into theMultiple control icon.

Add a Test to a Control

1. Click onDesign > Frameworks > Framework Library.

2. From the drop downmenu select the framework you wish tomodify.  The first framework in the list is open by

default.

3. In the framework panel, click on the Control you wish to add a Test to.

4. The selected Risk’s information will appear in the detail panel.

5. Click theNew Test button found in the content window toolbar in the right hand panel.

Alternatively, you can right-click the Folder in the left hand panel and select Add a New Test from themenu that

appears.

6. The new Test information will appear in the right-side panel.

7. Enter the, number, name and description of the new item as required.

8. Select the item Sub Type and Default Icon as required and indicate if this item is a Single Assessment Item.

9. Any Item Attributes associated with the Test or Test Sub-Type will appear below the description field. Admin-

istrators can fill in the Attributes information if this information is consistent across all locations this Folder is

added to.

10. Click Save to apply your change(s).

Adding a Test to Multiple Controls

Sometimes Tests may be used to evaluatemore than one Control. To eliminate performingmultiple evaluations of the

same Test you can attach a Test to more than one Control. The evaluator will only need to assess the Test once and the

results will propagate throughout the location for that Test.
1. Click onDesign > Frameworks > Framework Library.

2. From the drop downmenu select the framework you wish tomodify.  The first framework in the list is open by

default.

3. Add a Test to a Control. (as above)

4. Hold down either theAlt, Ctrl orShift key, then drag and drop the Test onto the Control it applies to.

Alternatively, open the item and click theChange Parent button in the right panel toolbar. Select all items to which



this item should be added and click Multi-Parent.

5. The system will ask you if you are sure you want to add the Test to the Control. Select OK.

6. The same Test will now appear under both Controls and will be numbered identically. 

Import Items from Pre-Built Frameworks

1. Click onDesign > Frameworks > Framework Library.

2. From the drop downmenu select the framework you wish tomodify.  The first framework in the list is open by

default.

3. Click on theAdd from Pre-Built Frameworks tab in the detail panel.

4. Using the drop downmenu, select the framework that you want to import an item(s) from.

5. Expand the framework to find the section of the Pre-built Framework you want to import into your customized

framework.

6. Click on the highest level item and drag it over to the framework panel and drop it onto the parent folder that you

want the section to be grouped under.

If you hold the Ctrl key while dragging items from the Pre-built Framework, it will copy all items below it, not including itself,

into the item it is dropped into.

7. The system will ask you if you are sure you want to add the selected items. Click OK.

8. Alternatively, you can use the check boxes to add only certain items from the Pre-built Framework into you cus-

tomized framework.

9. Place a check mark beside the items you wish to add. All levels directly above the check marked item will auto-

matically bemarked as well.

10. Once all items are selected, select the top level item, drag and drop it onto the desired folder in your customized

framework. Only items check marked will be transferred.

Contact Resolver if you wish to have a custom framework loaded into your site.

Framework Matrix Assessor

Attributes of multiple items can be assessed at one time through thematrix assessor in a spreadsheet style format.

Starting the Matrix Assessor

1. Click on Administration > Frameworks > Framework Library.

2. Place check marks in the boxes next to each Item in the framework tree you wish to view in theMatrix Assessor.



3. Click the Framework Actions button and select Assessed Checked Items in theMatrix Assessor. Thematrix

assessor will load.

Using the Matrix Assessor

Once theMatrix Assessor loads you are able to assess Attributes of multiple items at once in a hierarchical structure.  Only

Attribute criteria will be editable.  TheMatrix Assessor has three tabs: View, Show/Hide Columns andAutosize.
1. Using theMatrix Assessor: View Tab.

2. Use the +/- boxes beside the item names (Folder, Risk, Control...) to expand or contract the level below in the

framework.

3. Use the +/- box in each column header to show or hide that column.

4. Clicking in any of the cell of theMatrix Assessor will bring up an interface to evaluate that attribute criteria.

Remember to save frequently by clicking the Save All button. Note: After 20minutes of inactivity the GRC Cloud win-

dow will turn gray, displaying a warningmessage that alerts you that there is 5minutes to Refresh your session, otherwise

after the 5minutes elapses, you will be logged out.  Clicking the Refresh button will reinstate your session.

Only the first instance of aMulti-Parent item in theMatrix Assessor can be edited, each instance after is locked out by the

Matrix Assessor. The additional views of themulti-item are colored light blue to identify them as such. Changes made to

themulti-parent item will be spread over all other instances.
To view help text for criteria, click on the [?] in the criteria name header.
An asterisk [*] is displayed in the criteria name header for any criteria that is required to be assessed in order to Sign-Off.

Using the Matrix Assessor: Show/Hide Columns Tab

1. Click on theShow/Hide Columns Tab tomodify the visible columns.

2. For each Item Type, uncheck any column (Item Number, Name, Description, Item/Sub-Item Criteria) you would

like to hide. Alternatively, you can click theAll button to have all columns displayed.

3. Click theUpdate View button.

Using the Matrix Assessor: Autosize Tab

1. Click on theAutosize Tab tomodify the row and column sizes.

2. In the Row Height section, choose aMinimum andMaximum number of rows using the drop down box, row height

can be as small as 1 row to as large as 30 rows.

3. For each Column, a ColumnWidth selection is available. Select from narrow, normal or wide by clicking to des-

ignate the width for each column.

4. Click theUpdate View button.

Delete an Item(s) from the Framework

1. Click onAdministration > Frameworks > Framework Library.



2. From the drop downmenu select the framework you wish tomodify.  The first framework in the list is open by

default.

3. Click on the item you wish to delete.

4. The selected item's information will appear in the detail panel.

5. In the detail panel under theEdit Information tab, click theDelete button.

6. A pop-up will appear asking you to confirm that you wish to delete this item. Click OK.

7. Youmay see a pop-up telling you to uncheck items in your framework panel before proceeding. The system will

not allow you to use this Delete button if you have items selected in the framework panel. Click OK, and then dese-

lect the items in the framework panel before proceeding.

Alternatively,
1. Click onAdministration > Frameworks > Framework Library.

2. From the drop downmenu select the framework you wish tomodify.  The first framework in the list is open by

default.

3. Check the box(s) beside the item(s) you wish to delete.

4. Right click on any item within the customized framework (framework panel) and select Delete Checked Items

from themenu that appears,

OR

Click on the Framework Items button at the top-right of the framework panel and then select Delete All Checked

Framework Items.

5. A pop-up will appear asking you to confirm that you wish to delete the selected item(s). Click OK.

Update and Propagate Frameworks in Use
(Once It Has Been Added to Locations & Evaluations Have Begun)

There are four ways changes can bemade to a customized framework once it is built and assessments have begun.

1. Save:Using the Save button updates the changes made to the customized framework but does NOT update the

changes made throughout the system. If you expand your organization and add the changed section(s) of the Frame-

work to another Location, the updated items will be used.

2. Update:Using the Update button updates the changes made to the specific item for all instances of the item within

any location. After modifying an item, click the update button to update every other instance of that item to reflect

the new changes.

3. Alternative Update Approach:

Users may find it convenient to Save items as they edit them and then just Update once, rather than clicking Update

in each item. The Update button in the left hand panel will Update all items that have been checked in that panel.

4. Propagate:

Using the Propagate button adds this item to all instances of its parent.  After adding a new item, click Propagate to



place this new item in every location in which its parent exists. Propagate does not update any changes to the item

to any existing instances of the item.

Org/Location Framework

TheOrg/Location Framework enables Administrators to create specific instances of Items by attaching them to locations

such as countries, cities, divisions, departments, etc. associated with your organization.
On theOrg/Location Framework page you can easily add locations and sub-locations and import Items from an existing

Framework(s).

Location Building Basics

● Items are numbered sequentially in the order they are added. You canmodify the numbering standard by allocating

your own Item numbers.

● You can right-click on a location in the tree in the left panel to access amenuwith more functions.

● You can only add folders to locations.  You cannot add risks and controls directly to a location.

● It is recommended that you do not add folders to the top-level location because it will disrupt the process of building the

location tree.

● Applications are set up in the Org/Location Framework and behave similarly to Locations.

● User Permissions are handled through Roles and the Role builder

The former Application Framework has been replaced with a capability to set up Applications within the Organ-

ization/Location Framework. This will providemore intuitive reporting of Applications and Application Controls or other cen-

trally managed controls.

Note: Locations do not have to be geographical in nature. They can be divisions, subsidiaries, departments, projects, etc.

The Org/Location Framework

1. Click onAdministration > Frameworks > Org/Location.

2. This will take you to theOrg/Location Framework screen.

TheOrg/Location Framework homepage is divided into two panels similar to the Framework Library.

● The framework panel displays your location tree.

● On the detail panel under theEdit Information tab you can enter the number, name and description for selected loca-

tions and sub locations. Under the Add From Existing Framework tab you will select Items from your customized

Framework(s) and add them to each Location in which they are present.

Building/Managing the Org/Location Framework

Add a Location to your Organization

1. Click onAdministration > Frameworks > Org/Location.



2. Click on your organization's starting point, symbolized by the Earth icon.

3. In the detail panel under theEdit Information tab click theAdd a Sub-Location button. Alternatively, you canmouse

over the Org/Location’s starting point (or a Location) to which you want to add a Sub-Location. Once it is high-

lighted, right click on the Location and select Add a New Location from themenu that appears.

4. Enter the number, name and description of the new location as required.

5. Any Item Attributes associated with the Location, Sub-Locations or Location Sub-type will appear below the

description field. Administrators can fill in the Attributes information in this area, althoughManage by Location is

generally where Attributes are filled out. 

6. Click Save to apply your change(s).

Locations and Sub-Locations can bemoved to another Parent Location by dragging and dropping a Location onto a different

Parent Location (This works the same as in the Framework Library.)

Add an Application to your Organization

1. Click onAdministration >Frameworks > Org/Location.

2. Click on either the organization's starting point, symbolized by the Earth icon, or a location.

3. In the detail panel under theEdit Information tab click theAdd a Application button. Alternatively, you canmouse

over the Org/Location’s starting point (or a Location) to which you want to add a Sub-Location. Once it is high-

lighted, right click on the Location and select Add a New Applicationfrom themenu that appears.

4. Enter the number, name and description of the new location as required.

5. Any Item Attributes associated with the Application or Sub-Type will appear below the description field. Admin-

istrators can fill in the Attributes information in this area, althoughManage by Location is generally where Attrib-

utes are filled out. 

6. Click Save to apply your change(s).

Add Processes, Risks and Controls to Locations

1. Click onAdministration >Frameworks > Org/Location.

2. In the detail panel under theAdd From Existing Framework tab, use the drop downmenu next to 'Select a frame-

work' and select the Framework you want to work from.

3. The Framework developed in the Framework Library section will appear on the detail panel.

4. Locate the Item(s) you want to import to a specific Location. Click on the parent Item in the Framework tree.

5. Drag the parent Item over and drop it onto the sub-location under which you want the Items to appear. (All sub-

Items will be included in this drag and drop action.)

6. The system will verify that you do want to add the Items to the location. Click OK.

Click on any Item in the framework tree and in the detail panel under the Edit Information Tab, Item Attributes associated

with the Item(s) or Item Sub-type(s) will appear below the description field. Administrators can fill in the Attributes



information in this area, althoughManage by Location is generally where Attributes are filled out.  If you hold the Ctrl key

while dragging items from the Pre-built Framework, it will copy all items below it, not including itself, into the item it is

dropped into. Instead of dragging an entire branch of a pre-existing framework, you can select certain sections or Items

using the check boxes. (This works the same as in the Framework Library).
Folders and Folder Sub-Types can bemoved to another Parent Location by dragging and dropping the Folder onto a dif-

ferent Parent Location (This works the same as in the Framework Library).

Delete an Item(s) from the Org/Location

1. Click onAdministration >Frameworks > Org/Location.

2. In the Framework panel, click on the item you wish to delete.

3. The selected item's information will appear in the detail panel.

4. In the detail panel under theEdit Information tab, click theDelete button.

5. A pop-up will appear asking you to confirm that you wish to delete this item. Click OK.

6. Youmay see a pop-up telling you to uncheck items in your framework panel before proceeding. The system will

not allow you to use this Delete button if you have items selected in the framework panel. Click OK, and then dese-

lect the items in the framework panel before proceeding.

Once delete is clicked it will indicate to the user the number of descendants that will also be deleted. A delay is in place to

ensure users take the time to acknowledge the implications of the delete. To disable this, simply check the box andOK will

be available immediately. The delay will then be removed for for 24 hours. (7.1)

Alternatively,
1. Click onAdministration >Frameworks > Org/Location.

2. In the Framework panel, locate the item(s) you wish to delete and check the box(s) beside the item(s).

3. Right click on any item within the organizational structure (framework panel) and select Delete Checked Items

from themenu that appears.

4. A pop-up will appear asking you to confirm that you wish to delete the selected item(s). Click OK.

Note:

When you delete any Framework Items (Folders, Processes, Risks, Controls and Tests) added to a Location, the asso-

ciation with the Location is removed.  However the item is not deleted permanently. When you delete a Location or Sub-

Location, the item is deleted permanently.

TheOrganizational Starting Point cannot be deleted.



Scoping Item Framework

The purpose of scoping is to identify parts of the framework that do not require further assessment or evaluation work, or

that in other words are "out of scope". For Sarbanes-Oxley or Canada Bill 198 users, this is typically done on the basis of

the financial value related to specific business activities and so each business process and underlying risk and control can

be connected to a scoping item line in the general ledger. This also enables the application to report the link betweenGL

scoping items and processes in various locations, and allows you to dissect the data to understand how instances of proc-

esses, risks, and controls are affecting the accuracy and completeness of your financial statements. In other compliance

frameworks, or in enterprise risk management programs the Scopingmay be done on the basis of different criteria, such as

potential risk impact.
In previous versions of GRC Cloud this functionality was referred to as the Account Framework, but is now renamed to

reflect the diverse needs of different software users.
The functionality and layout of the Scoping Item Framework is predominantly the same as the Framework Library and

Org/Location Framework. The framework panel displays the active Scoping Item Tree and the detail panel displays the

org/location framework from which you import items.

The Scoping Item Building Functionality is referred to as Scoping Item Framework. This reflects the need of many organ-

izations, particularly those not involved in Sarbanes-Oxley or Bill 198 compliance to use criteria for placing items in or out of

scope for assessment that are not derived from the organization's scoping item structure. Administrators can also change

the word "Scoping" to another term more suited to their organization. This customized terminology will then appear through-

out the site's interface

Scoping Item Framework Building Basics

● Folders can be imported into a Scoping Item framework from the Location framework by dragging them across the

screen. The folders will bring across additional items higher in the tree, such as other folders and locations. You

can also choose which lower items, such as sub-folders risk and controls to import into the scoping item frame-

work

● User Permissions are handled through Roles and the Role builder

Building/Managing the Scoping Item Framework

Create the Scoping Item Framework

1. Click onAdministration > Frameworks > Scoping Items.

2. Click on the Scoping Items starting point or any Scoping Item.

3. In the detail panel under theEdit Information tab click theAdd a Sub-Scoping Item button.

4. Enter the number, name and description of the new Scoping Item, as required.

5. Any Item Attributes associated with the Scoping Items or Scoping Item Sub-types will appear below the descrip-

tion field. Administrators can fill in the Attributes information in this area, althoughManage by Scoping Item is



generally where Scoping Item Attributes are filled out. 

6. Click Save to apply your change(s).

Scoping Items can bemoved to another Parent Scoping Item by dragging and dropping the item onto a different Parent

Scoping Item. (This works similarly to the Framework Library.)

Associate Items with a Scoping Item

Folders, risks and controls are added from existing location frameworks. When adding a folder, all items above it up to and

including the locations are also included to provide a complete identifying reference in the scoping item framework. Any

items beneath the folder can also be imported into the scoping item framework, and the Administrator can choose which

folders, risks, controls are relevant and therefore should be dragged over and which are not.

Items are now imported into the Scoping Item Framework from the Location structure. Previously they were dragged over

from themain framework. This change eliminates unwanted duplication of location-based processes under multiple loca-

tions in the scoping item framework.

The Admin can now specify specific sub-folders, risks and controls to be imported into the scoping item framework along

with the selected item. In previous versions all lower items would be brought over with a folder.

1. Click onAdministration > Frameworks > Scoping Items.

2. In the detail panel under theAdd from Existing Location tab, select a folder to be added to the scoping item frame-

work, by checking the appropriate box. Note that all boxes below and above the selected folder are also auto-

matically checked.

3. Deselect any items below the selected folder that are not required to be included in the scoping item framework

(i.e. sub-folders, risks, controls).

4. Drag the selected folder item to the required scoping item.

5. The system will verify that you to want to add the process to the scoping item. Click OK.

6. The selected folder will now appear under the selected scoping item. Between the scoping item and the folder are

any higher folders and locations, so the instance of this folder (usually a process) can be easily identified.

All the functionality that is mention above (to build out the Scoping framework) is now available in Manage by Scoping. A

new interface to select items directly from the Location Framework and add directly to the Scoping Framework can be

accessed via the Add Folder button. This is available to both Administrators and normal users via the Roles and Per-

missions. Enabling the user to add folders to Scoping items will allow them to build out the tree in Manage by Scoping. (6.1)

1. Manage > By Scoping Framework

2. Select the Scoping item

3. Go to the Folders tab

4. click AddNew Folder

The Location Framework will appear in the View Item window

5. Users, based on permissions, can add the desired items to add to the Scoping Framework



Delete a Scoping Item or Top Level Folder from the Scoping Item Tree

1. Click onAdministration > Frameworks > Scoping Items.

2. In the framework panel place a check mark beside the scoping item or top level folder you wish to delete.

3. Right-click anywhere on the Scoping Item Tree and select Delete Checked Items from the drop downmenu that

appears.

OR

1. Click onAdministration > Frameworks > Scoping Items.

2. In the framework panel click on the scoping item or top level folder you wish to delete.

3. In the detail panel that appears, click theDelete button.

Once delete is clicked it will indicate to the user the number of descendants that will also be deleted. A delay is in place to

ensure users take the time to acknowledge the implications of the delete. To disable this, simply check the box andOK will

be available immediately.The delay will then be removed for 24 hours. (7.1)

Completion Reminders (Schedules) - Functionality Retired in
v8.0

The behavior of Completion Reminders set at the sub-type level in terms of whether the reminders are impactedmy main

type criteria is now configurable.

The Completion Reminders feature enables automated reminders to be sent to users to finish their evaluations before given

dates. This is set up for each item type and sub-type if required. Multiple schedules can be designed and one selected as a

default for that item type. The Administrator or a user with appropriate advanced permissions can override the default

schedule with one of the other schedules for that item type inManage by Location. The recipients of reminders and the

number of reminders that are sent aremanaged in user roles.

Where an item has a completion reminder set on both themain item type and the a sub -type, only the sub-type completion

reminder functions and themain type reminder is ignored. When configuring a sub-type completion reminder, the Admin-

istrator can select whether or not criteria related to themain type should be checked when determining whether an item is

complete or not and thus whether a reminder should be sent. A completion reminder on a sub-type cannot be configured to

check the completion status of criteria attached to other sub-types. (A completion reminder set on themain type does not

check the completion status of any sub-type criteria.)



1. Click onDesign > Item Templates.

2. Select the Item Type (or sub-type) for which you will set the Completion Reminders.

3. Click on theSchedule tab.

4. Click Edit Schedules

5. Select the Schedule you wish to edit, from Annually, Semi-Annually, Quarterly or Monthly. The appropriate number

of boxes for selecting dates will appear.

6. Select themonths and days you wish the reminders to be sent for that schedule. Enter values from 1-12 in the

month column and 1-31 in the day column.

7. If creating/editing a completion reminder for a sub-type, select whether the reminder should check for completion

of just the criteria related to that sub-type or check themain type criteria in addition to the sub-type criteria.

8. Click Save. The system will validate that all the dates entered are possible combinations (for example 02 and 31

would not be a possible combination) and you will be instructed to re-enter if there are erroneous date com-

binations.

9. If an alternate schedule is required (example some risks may require more frequent or less frequent assessment

than others), chooses another schedule and repeat steps 5-7.

10. Press Cancel/Go Back.

11. Select the Schedule that will be the Default for that item type or sub type. Click Set as Default Schedule.

GRC Programs

Introduction

This feature tackles an ongoing challenge in the GRC world, providing clear, effective instructions to a wide variety of end

users.

There aremany roles that participate in GRC: Issue owners, Auditors, Risk Managers, Reviewers, Approvers andmore.

Some roles will access the system daily, others once or twice a year. Even within a role, the degree of access can vary



significantly; for example, Joemay be the Process Owner for Accounts Receivable, but Mary might be a process owner for

Payroll, HumanResources, Accounts Payable and Financial Reporting.

GRC Programs has been designed to help organizations provide clear, efficient access to areas of responsibility, so that

users can get their work done quicker.

First some terminology:

GRC Programs – The high level “Program” that you engage in e.g (Internal Control, NERC Compliance,

Risk Management, Legislative Compliance…)

GRC Activities – The “activities” that users perform within a program (Testing, Self-Assessment, Report-

ing…)

Since every organization is different GRC activities can be configured by administrators to match the internal processes.

Navigate to “GRC Programs” under the Administrationmenu to configure programs and activities for your organization.

Configuring Programs and Activities

1. Activities can be linked to Roles to determine visibility.

2. Activities can be linked to Time Tracking to allow logging of time against these activities in the timesheet. Time

Tracking is mapped to an activity via an item type and workflow states.

Example 1: Auditors might like to log time spent doing Fieldwork on the Audits that are active.

3. Activities can be linked to Focus to allow users to choose an object to focus on which will drive navigation through

the focus selector in the top left hand corner of themenu.

Example 1: Process Owners might like to easily focus on different processes regardless of which state they are in.

Example 2: Internal Control Testers might like to easily focus different processes that are in an Testing workflow

state

Building Programs and Activities

By default all sites are equipped with a best practices pre-configuration of Programs and Activities. The pre-configuration

covers all major programs within GRC.

Included Programs:

1. Internal Audit

2. Internal Control

3. Risk Management

4. Administration

5. Compliance

6. Incident Management

7. Balance Scorecarding

8. Legacy Time Tracking



Each of these programs are equipped with activities relevant to that program. This is simply a best practices guide and all

programs and activities can be edited or /removed.

Focus Picker Need to Knows

The focus selector is available via the top left corner of themenu. A user will be presented with items that have been con-

figured to be available to their role via the GRC Programs page. Selecting a focus will automatically zoom-in on that item.

The users Dashboard, Manage By Location, Item Overview and Hierarchical Reports will all use the selected focus as a

filter to show content in and below that item.



1. Searching: the search capabilities search all elements on the page (including the context).

2. Caching: the list of items seen in the picker is cached for 20minutes. If you are not sure if it's up to date, click the

refresh option.

3. Exception to #2: workflow transitions will automatically refresh the focus picker. Example: if a focus item (our any

item in the focus picker has it's workflow transitionedmaking it no longer relevant to that user's list, it will update

automitically when the user accesses the focus picker. They do not have tomanually click the refresh option.

4. Filters: Activities and Item Types can be filtered as one or together.

5. Clear Focus: resets your focus back to the starting point defined in the User Profile.

6. Focus Reset: selecting a link that falls outside of the defined focus will navigate to that item and reset the focus.

7. Reports: once a focus is selected, saved reports, new reports, Homepage pie charts and Executive Dashboard will

respect the new focus.

8. Focus does not apply to the following areas: Matrix assessor, Survey, Audit trail, Framework Library, Location

Builder, Scoping Builder.

9. Workflow Emails: Clicking on a link from an email will automatically reset the focus.

10. Login: focus will be persisted upon login. Your last selection will be remembered.

11. Current Selection: will be highlighted in Red in the Focus Picker list of items.



Programs and Actions

Actions allow users to quickly navigate the system with ease. They drive users to the area of the application they require to

get their work completed.



Program and Activity: Action Types

1. Offline: provides an option for user to take all items below a specific focus point to an offline state.
a. Navigate to Programs and Activities

b. On the required activity (Example: fieldwork), scroll to the Actions.



c. Check off: Offline Enabled on this Activity.

d. AnOffline option will be available per item in the focus picker.

2. Reference or Link: Utilized to navigate users to a specific item in the hierarchy or an external link outside of GRC

Cloud (webpage).
a. Navigate to Programs and Activities.

b. On the required activity (Example: fieldwork), scroll to the Actions.

c. Click on Create New Action.

d. Select Reference.

e. Insert Name.

f. Insert Url or Link (must contain http/https).

g. Set Focus after clicking on action: Determine if focus should be set when action is clicked on. It is selected

by default.



h. If required, link to open in a separate window by selecting the option to Open in another window.

3. Reports:Utilized to link internal GRC Cloud reports to the focus picker.
a. Navigate to Programs and Activities.

b. On the required activity (Example: fieldwork), scroll to the Actions.

c. Click on Create New Action.

d. Select Reports: A list of all Administrative Reports will be available.

e. Select report
● Only includes Item Overview and Hierarchical Reports. Summary reports are not available.

f. No save required.

g. Set Focus after clicking on action: Determine if focus should be set when action is clicked on. It is selected

by default.



■ To deselect, click the pencil icon after report is selected and added to the list of actions - uncheck the

'Set Focus when clicking on action' option.

4. Workflow Triggers: embed a workflow trigger action that allows users to transition items from the focus picker.

a. Execute High Level Task through the Focus Picker
● Submit Audit Fieldwork

● Close Audit Projects

● Complete Risk Assessments

● Send Engagement Letters

b. Built in confirmation statements ensures all low level requirements have beenmet.

c. Focus Picker auto updates after a workflow action
● Removes the item if it is no longer applicable

d. Customizable icon and name display

e. Setup
a. Via the AdministrationMenu option, openGRC Programs and select the applicable program &

activity.

b. Click Create New Action.

c. Click Triggers.

d. Based on the Item Types and states defined for the activity, a list of triggers are available to

add to the activity.

e. Select a trigger.



f. To customize the trigger text or icon, edit the action.

g. Notes:
a. Regardless of the permissions, the trigger will show on the focus picker. Once clicked

the actual permissions will be applied.

b. Multiple Triggers can be added.

c. Copying a workflow and republishing will maintain the triggers.

d. Focus will not be set when the workflow trigger is executed.

e. IMPORTANT: Un-publishing a workflow will remove the triggers from the activity. It will

require the a reconfiguration. Best practice would be to copy and republish.

Analytics:Analytics are reports typically built through the DataWarehouse and 3rd Party reporting tools. This feature
requires the Enterprise Edition of GRC Cloud.

a. Navigate to Programs and Activities.

b. On the required activity (Example: fieldwork), scroll to the Actions.

c. Click on Create New Action.



d. Select Analytics.

e. Select an Analytic Report: Defined by list of all reports created inManage Analytics. SeeManage Ana-

lytics page.

f. Multiple actions can be added.

g. No save required.

h. Set Focus after clicking on action: Determine if focus should be set when action is clicked on. It is

selected by default.
■ To deselect, click the pencil icon after report is selected and added to the list of actions -

uncheck the 'Set Focus when clicking on action' option.

Focus Picker On-Going Improvements

Description



The description detailed in the setup of the activity will now be displayed in the focus picker (per item / per activity)

New way to Set the Focus

After clicking on the items a user wants to focus on, it will expand with the description, actions, and new option is displayed

to Focus on This.

Focused Item will also remain at the Top

After setting the focus and opening the focus picker, the item selected will be at the top, expanded and highlighted in yel-

low.

Additional Changes

● The activity related to the focused item is indicate in the top left menu option to request the Focus Picker. If multiple

activities, it will not show until an action is selected from an activity.

This can be activate via the system settings: Show activity name in header = True.

● Auto Expand: if there are no homepage preferences on the homepage (Reports / Pie Charts), the Focus Picker will

auto expand for the user.

● Indictor is given if more than 30 items are listed on the focus picker

New Message: 1-30 of x focus items displayed. Search or filter to refine results.

● Selected a report will also set the focus.
● Except offline and links

● Summary Report respects the focus selected.
● Only applies when the user is ordering by framework

● Note: GRC Programs page is not supported in Internet Explorer 8.

To learn more about configuring GRC Programs for your organization, please
contact Resolver Client Care.

mailto:clientsupport@resolvergrc.com
mailto:clientsupport@resolvergrc.com
mailto:clientsupport@resolvergrc.com


Managing Advanced Reporting and Analytics

Manage analytics is the area of the application to configure advanced reporting and analytics. In most cases, these report-

ing tools require access to the data warehouse. Both components are available via Enterprise Edition of GRC Cloud.

Components of Managing Analytics:

1. Report Name: Name of the report.

2. Description: Shows in the Analytics report page.

3. Visibility: Type of users that can view the reports via the Analytics page.

a. None: no users see it on the Analytics page

b. Users: all users see it on the Analytics page

c. Admins: only administrators see it on the Analytics page

Note: Regardless of visibility the reports are available to administrators when creating actions in pro-

grams / activities.

4. Filter by: defines the starting point for the report.
a. If enabled: the focus item used to access the report will be applied to the report as the 'starting point'.

b. If disabled: the report defaults to the entire database.

5. Type: type of report
a. External Reports: provides the ability to upload Excel, Word, PowerPoint and Visio documents to be dis-

played in the Focus Picker (See Programs/Activities).

b. Tableau and Crystal reports: components that are part of GRC Cloud Enterprise Edition. Please contact

Resolver Client Care or visit our website to learnmore.

Note: theManage Analytics page does not support the use of Internet Explorer 8. Please upgrade your browser. A mes-

sage will be shown to the user.

To learnmore about theGRC Cloud Enterprise Edition, please contact Resolver Client Care or visit our website.

http://www.resolvergrc.com/grccloudenterpriseedition/
http://www.resolvergrc.com/grccloudenterpriseedition/




Manage Information
TheManage Information area is available to all Internal users (except Reporting Only users). It is themost widely used

area of GRC Cloud where users document processes, risks, controls and other items, document tests and record results,

identify issues and createmitigation plans where necessary and finally, where the objective is compliance with Sarbanes-

Oxley Section 404 or Canada Bill 198 (NI 52-109) it is here users sign off or certify their area of responsibility.

The following functionality is documented in Help. Click the links below for further information.

1. Manage by Location vs. Manage by Scoping Item: Choice whether to view the hierarchy in terms of corporate

organizational structure or in the context of the general ledger accounts impacted by the processes, risks and con-

trols, or other appropriate criteria for determining whether items are in scope or out of scope. (In older versions of

GRC Cloud, scoping was known as accounts).

2. Manage Attributes: Some users may have access to edit descriptive information relating to framework items.

3. Manage Evaluations: A key area of functionality where users assess and evaluate risks, controls and other items.

4. Manage Role Permissions: Setting access for users in specific Roles for different areas of the framework and crite-

ria within those items.

5. Sign Off: The certification process necessary for key controls and related risks, processes, locations etc to meet

the requirements of SOX 404 and Canada Bill 198 (NI 52-109). Sign-Off is not used for sites which have the

optional Workflow functionality activated.

6. Manage Attachments: Uploading external documents into GRC Cloud, managing updates and access.

7. Change Log: Review listing of all changes made to any framework item.

8. Matrix Assessor: A convenient spreadsheet-like format for simultaneous assessment of multiple items.

9. Manage Non-Framework Items: Add items such as issues, action plans, tests and notes to the framework.

10. Manage Framework Items: Capability to amend sections of a framework for Administrators and users that are

members of roles with advanced permissions.

11. Right Click Menu: Quick access to reporting, matrix assessor, and charting via a pop-upmenu.

Context

Introduction to Context

Many organizations have the same processes and controls in multiple locations. Understanding that you are looking at a

control in the Payroll Process in Denver instead of New York or Rome is an important distinction; however showing the

entire path to the root of the tree can often includemany layers of information that are not helpful for context.

For example the full path for the scenario above could be:

My Company > North America > USA > Colorado > Denver > Internal Control > Business Process > Payroll

#_Ref751249537
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My Company > North America > USA > New York > New York> Internal Control > Business Process > Pay-

roll

My Company > Europe > Italy> Rome > Internal Control > Business Process > Payroll

The Item types and subtypes for this path are in order:

Organization> Continent > Country > State> City > Folder > Topic > Process

However the only path needed for Context would be:

Country > City > Process

USA > Denver > Payroll

USA > New York > Payroll

Italy> Rome > Payroll

Context allows administrators to identify which item types and subtypes are important and can then dramatically shorten

the path to an item. This abbreviated context field shows up in the Item Overview reports, the Focus Picker, Timesheet and

in the Hierarchical Report Details.

Customizing Context

As noted above, administrators have full control over what displays as the context throughout the application. Each item

type and it's associated sub types have an option to display that type in the context. By default, the location/entity main

type is selected.

Note: Context is responsive to the hierarchical rules applied throughout the application. For example, if focused on a risk, it

will show the context of it's ancestors. It will not reference any descendants (ie: controls). Context path is not based on per-

missions. It automatically assumes users have name permissions.

Steps to Set up Context:

1. Navigate to the Item Templates (Menu: Administration > Item Templates)

2. Select the item type (or sub type) to reference in the context



3. Check off Path Context

4. Save the Item Template

5. If desired, select another item type to show in the context

After saving, the item type will now show in the Areas of Applicability referenced below.

Areas of Applicability

Context can be referenced inmultiple areas across the application: Item Overview, Focus Picker, Timesheets and Hier-

archical Report Details.

Item Overview

When building an Item Overview report, an additional column to display is available to display the context in the report. Cus-

tomizing the Item Templates will drive the context that is shown in the report. It will be the default. As noted above, if no

item templates are selected to display the context, it will default to Location/Entities in the Path selector.



The default item types can bemodified in the report. If saved, themodified selections will be applied to that report.

Focus Picker

Administrators have an option to show the context path in the Focus Picker header. This is defined via the System Settings

.



1. Navigate to the System Settings (Menu: Administration > System > System Settings)

2. Locate the setting: Show Context in Header

3. Set to True

4. Save

This action will input the context path in the header of the Focus Picker.

The Context Path will also be displayed under items listed in the Focus Picker. Note: this is not driven by the system set-

ting. It is always visible.

Example: List of Audits referencing the Auditable Entity it is related to.

Timesheets

In the audit world, it's common to havemultiple audits span the same period of time. Therefore, when tracking time, users

are provided with additional context defining the relationship of the Audit.



Example: when selecting Audits to track time against, it provides a the context of the Audit Entity it's related to.

Hierarchical Report Details

To view the context in a Hierarchical Report, expand the details in the report header.



Manage by Location vs. Manage by Scoping Item

GRC Cloud features two distinct ways to organize andmanage your data: By Location or By Scoping Item.

Types of
Frameworks:

Use: Example:



Manage By
Location Frame-
work

Manage By Location Framework
provides access to your frame-
work via the location it is
attached to.

For example to access the Sales
process click on the location
where that Sales process oper-
ates. In this case Toronto, Van-
couver, San Diego or New York.

Manage By
Scoping Item
Framework

Manage by Scoping Items pro-
vides access to your framework
by Scoping Framework first and
Location second. This option is
only available if your admin-
istrators have configured an
association between your GRC
framework and a given scoping
criteria, such as account line.
Since a process or activitymust
in real life occur in a physical loca-
tion(s) there is also a required
location association for scope-
based or account basedman-
agement. Processes that are
linked to a scoping itemmust
also be linked to a location where
they occur. All locationswhere
that process operates will then
be independently displayed
beneath that account line to
allow evaluations that are distinct
at each location.

For example to access the same
Sales process from the example
above click under Receivables,
Net (the Account line that the



Sales Process has been
attached to) and then under the
location where that process oper-
ates.

Synchronizing Manage by Trees (Scoping to Location)

Administrators can determine which item types in the system automatically sync to the Scoping Tree. Historically, this

was amanually action placed on the user done through the Scoping tree after adding any new or framework items to the

location tree. This feature gives the user and the administrators the reassurance the scoping tree is an up to date and accu-

rate representation of the location tree.

Feature Overview:

● Administrators can define the item types to be synchronized

● Administrators can define what type the parent must be in order to synchronized (including subtypes)

● Adding items, either new or from the framework, to the Location tree automatically gets added (synchronized) to the

scoping tree

● Mass synchronization: existing sites can enable the functionality and on Save will synchronize the two trees

Define Item Types to Synchronize

It has been designed to allow maximum flexibility when determine which items types get synchronized to which parents

types. For eachmain and corresponding subtypes, it allows the admin to define 'synchronize this main and/or sub type(s),

if the parent is of type(s) x AND exists in the scoping tree'.

For Example:Administrators can synchronize ERM Controls (subtype of control) to ERM Risks (subtype of risks), and

only if they are present in the Scoping. tree.

This functionality will apply to all avenues of item creation and item addition in relation to theManage by Location Tree.

● Propagate an item from the Framework Library

● Add new items in theManage by Location tree

● Add existing items in theManage by Location tree from the framework

● Add items in theMatrix Assessor

Steps

1. MainMenu > Design > Item Templates > Select an item type (or sub type)

2. On theOverview tab findSynchronize Item Type

3. Expand the drop down: it will contain all relevant hierarchical options that the item type can be synchronized with



4. Select the parent(s) to sync the item types

5. Save

Warning: Once saved, it will automatically go to the Manage by trees, find the defined relationships and syn-

chronize them to the scoping tree. Upon refresh both trees will be synchronized with each other. Un-checking

the synchronize option on the item template will NOT undo the synchronization. It will simple stop future

actions from synchronizing.

Notes:

● Synchronizing the item type will override the system setting toDisable Ability to Add New Items to all scoped par-

ent items. Item will auto-synchronize across both trees, regardless of this setting. See "System Settings" on page

250

Manage Attributes

A summary of Item information is displayed on theOverview tab including the parent Item, the Item description, whether

the item is a Single Assessment Item, any Completion Reminder schedule (Functionality retired in v8.0) and the Item attrib-

ute criteria. The information on theOverview tab (i.e. Attributes) is meant to be input initially and is typically static for sub-

sequent reporting periods. Information onOverview tab is used to produce reports and provide background information

about an Item when performing evaluations. An asterisk (*) beside any field indicates it must be completed for the Item to

be signed off.

GRC Cloud supports the use of foreign languages, including those with accented characters (for example, French, Ger-

man, Czech, Vietnamese) and non Roman alphabet characters (for example Chinese, Russian, Greek, Japanese, Hindi)

when entering information into fields.

Date formats and number formats also determined by a user's settings for "culture".

All criteria values can be cleared. For single line text boxes, rich text boxes and numerical fields the items may simply be

deleted. For check boxes, items may be unselected by clicking the boxes. User lists are cleared by clicking the X next to a

user's name. Radio buttons and date fields have a Clear option. Drop-downmenus are cleared by selecting the "Select"

choice in themenu.

Edit an Item's Attributes

1. Click onManage > By Location orManage > By Scoping Items.

1. Choose an Item from the tree in the framework panel.

2. In the detail panel under theOverview tab, you will see Item Attributes.  Different Items have different Attributes.

You canmodify some or all of the fields depending upon your permissions.

3. Assess the Attribute Criteria using the drop downmenus, check boxes, radio buttons, text fields, etc.

Drop down criteria is searchable by label. Begin typing and the label options will match and narrow the selection.

(6.2)



4. If the Item you are evaluating is also an Item Sub-Type, then all Attributes pertaining to the Sub-Type will also be

listed below the Item Attributes. The Sub-Type icons will be displayed to indicate if the Attribute is associated with

a Sub-Type.

5. Click Save All Changes to apply your change(s).

If you require more information about the Attribute Criteria and how to evaluate a field, click the questionmark (?) help but-

ton to display the help text and guidelines entered by the Administrator.

Edit Attributes Via the Matrix Assessor

Attributemodifications can now be performed onmultiple items at once.

1. Click onManage> By Location or Manage > By Scoping Items.

2. Place check marks in the boxes next to each Item in the framework tree you wish to view in theMatrix Assessor.

3. Either, press the Assessor button at the top of the left hand panel,

or

right click on the text of the tree tomake the pop-menu appear. Select Assess Checked Items in theMatrix Asses-

sor.

4. Thematrix assessor will load.

Note: Select only the items you wish to evaluate and items required for context. Selecting large amounts of items may

result in performance degradation.

For more information on how to use theMatrix Assessor, seeManage > Matrix Assessor >.

Manage Evaluations

All Assessment Criteria for the Item Type (and Item Sub-Type(s) if there are any) are listed on theEvaluations tab. This

Evaluation tab includes all the criteria you will assess for each reporting period. An asterisk (*) beside any field indicates it

must be completed for the item to be signed off.

Key features and content of the Evaluations Tab:

1. Evaluate via the Evaluations Tab

2. Viewing Past Period Data

3. Calculate Functions vie the Evaluations Tab

4. Evaluate via the <Child Item> Tab

5. Evaluate via TheMatrix Assessor

All criteria values can be cleared. For single line text boxes, rich text boxes and numerical fields the items may simply be

deleted. For check boxes, items may be unselected by clicking the boxes. User lists are cleared by clicking the X next to a

user's name. Radio buttons and date fields have a Clear option. Drop-downmenus are cleared by selecting the "Select"

choice in themenu.



Evaluate Via the Evaluations Tab

1. Click onManage > By Location or Manage > By Scoping Item.

2. Choose an Item from the tree in the framework panel. 

3. In the detail panel under theEvaluations tab, you will see the Evaluations attached to that item.

4. Evaluate the Criteria using the drop downmenus, check boxes, radio buttons, text fields, etc.

Drop down criteria is searchable by label. Begin typing and the label options will match and narrow the selection.

(6.2)

5. If the Item you are evaluating is also an Item Sub-Type, then all criteria pertaining to the Sub-Type will also be

listed below the Item criteria. The Item and Sub-Type icons will be displayed to indicate with which Item or Sub-

Type the criteria are associated.

6. Click Save All Changes to save your assessments.

If you require more information about the Evaluation Criteria and how to evaluate/fill in the item, click the questionmark (?)

help button to display the help text and guidelines entered by the Administrator.

Viewing Past Period Data

If the user's data preferences have been set to view specific previous periods and evaluation criteria, this information will

automatically appear immediately below the current period data in the right hand panel on theManage by Location screen.

To set up your own user profile to see this see Data Preferences inMy Profile. Instructions for Administrators to set up this

feature for other users is found in Data Preferences in User Management.

Calculate Functions Via the Evaluations Tab

1. Click onManage > By Location or Manage > By Scoping Item.

2. Choose an Item from the tree in the framework panel. 

3. In the detail panel under the Evaluations tab, below the Criteria you will see the Functions Evaluations.

4. Displayed for each Function is: the name of the Function, the formula to calculate the Function and the date of the

last evaluation.  If set up during the creation or modification of the Function, Past Results and/or a Range will be

displayed.

5. If the function has Past Results selected, click the + button to view the Previous Results.  To return to the Latest

Results, click the – button.

6. Calculate the Function by clicking the Calculate button.

7. Click SaveAll Changes to save your assessments.

Evaluate Via the <Child Item> Tab

When an Item has a Sub or Child Item that has evaluations attached to it and the user has evaluate permissions for that

Child Item, then evaluations for that Child Item can be done via a tab on the Parent Item page.

This feature was removed in Release 6.3



Evaluate Via the Matrix Assessor

Evaluations can now be performed onmultiple items at one time.

1. Click onManage > By Location orManage > By Scoping Item

2. Place check marks in the boxes next to each Item in the framework tree you wish to view in theMatrix Assessor.

3. Right click on the text of the tree.

4. A pop-menu appears. ChooseAssess Checked Items in theMatrix Assessor.

5. Thematrix assessor will load.

Note: Select only the items you wish to evaluate and items required for context. Selecting large amounts of items may

result in performance degradation.

Managing Roles and Permissions in Manage by Location /
Manage by Scoping Item

Administrators and other users with appropriate permissions canmanage RoleMembership and permissions within Man-

age by Location/ Manage by Scoping Item.

Also see:

● Understanding Roles and Permissions

● Setting up Roles and Permissions in Role Builder

● SyncingMulti User Picker with Permissions

Adding Roles and Users to Items

1. Click onManage > By Location or Manage > By Scoping Items.

2. Choose an item and click thePermissions tab. If any Role permissions are already set up for this item, the role

name(s) and user/group name(s) appear in a table. These role permissions may have been set up specifically for

this item, or may have cascaded up or down from another item in the framework.

3. Click AddUsers/Groups.

4. In the left hand column select one or more roles to be applied to this item. In the right hand column select one or

more users or groups. This can be done by scrolling up and down the list of users, or by typing in the name of the

user and then checking the box adjacent to the user name. (Users can be deselected by unchecking the box.)

5. Click Save.



6. Click GoBack. The selected Roles are now set for this item and the selected Users/Groups have the Role per-

missions for that item. In addition, if this Role features permissions for other item types, these permissions will

cascade directly up and down the hierarchy for items of those types or sub types.

Removing Roles and Users from Items

1. In Manage by Location, open an item and click the Permissions tab.

2. Review the list of Role names and User/group names. If anX appears next to it then it can be deleted by clicking

theX.

Note: In Manage by Location/Scoping Item, Rolememberships can be deleted only at the item at which they were set up.

This is referred to as the Anchor Point. If no X appears next to the Role and User/Group name it means that the per-

missions on this item cascaded from an item either higher or lower in the hierarchy. To delete this role permission it is nec-

essary to browse higher level and lower level items to find the Anchor Point (i.e. where the X appears next to the Role and

User/Group names) and delete it at that level. It will then be automatically deleted from all items to which the permissions

were originally cascaded.

Copying Roles

To copy a role

1. Go to the Roles page.

2. Click the Copy icon beside the delete button.

3. Role gets copied and appends the namewith _Copy.

4. Note: It will copy the entire permission configuration for that role (the permission tab in the role). It does not copy the

user permissions or workflow associations.

Syncing Multi User Picker with Permissions (6.1)

During creation of the user list criteria, the administrator has the option to set the criteria to synchronize with a defined user

role. It will add the user selected to the synched role while cascading to the relevant tree items as regular permissions

would. It also works in the reverse by syncing any removal of permissions via the Role Builder or Permissions tab with the

users in the criteria list.

Creating the Criteria

1. Administration > Item Templates > Select "Item Template"

2. Attributes or Evaluations tab

3. AddNew Criteria

4. Select User List as Criteria Type

5. SelectMultiple as Selection Type

Note: Page will refresh with Permissionmanagement options



6. Check: 'Synchronize the user list with the defined role and applicable permissions'

7. Select the Role

Note: users added to the user picker will be synced with these role and inherit the applicable permissions

when the item template is saved.

This criteria will now be visible to the users in Matrix Assessor andManage by Location/Scoping. Any users added to this

criteria will be granted all applicable permissions granted via the role, using that item as the anchor node.

Cascading of permissions will be applied to the tree, however, the anchor nodes other levels will not be overridden. For fur-

ther information on permissions and cascading please See "Understanding Roles and Permissions" on page 244

Syncing applies to both adding and deleting users from this criteria.

Sign Off

Items are SignedOff only after all required assessments have been completed. When an Item is SignedOff, access to the

item is restricted to ReadOnly.  Sign off of an item can only be completed when all the items below have been signed off

and all required fields have been completed.  (I.e. a Control needs to be Signed off before a Risk, a Risk before a Process

and so on.)  Sign off rolls up through the hierarchy, by default only Locations, Folders, Risks and Controls are configured for

Sign off. If you wish to have other Items configured for sign off, please contact Resolver.

Setting Required Criteria

1. Click onDesign > Item Templates.

2. Select the Item Type you wish to have required criteria for.

3. Click on theAttributes or theEvaluations tab.

4. Add Existing Criteria or Add New Criteria (For detailed instructions see Design > Item Types and Templates >

Assign Criteria as an Attribute or Evaluation).

5. In theRequired column, uncheck tomake the criteria not required.

6. Click theSave button.

By Default, theRequired? option is already checked.  Each criterion attached to that Item will be Required unless the

option is unchecked.

Sign Off a Location, Folder, Risk or Control

1. Click onManage > By Location. 

2. Choose a Location, Folder, Risk or Control you wish to Sign Off from the tree in the framework panel.

3. In the detail panel under theOverview tab you will seeSignOff button.

The SignOff button is only available after all required fields have been completed and all child items have been signed off. 

Required fields are indicated by an asterisk (*) after the criteria name.  Once all of the required fields are complete, the item

is available to be Signed off; otherwise theSignOff button will be grayed out.



4. Click theSignOff button.

5. This item is now SignedOff.  It cannot bemodified and is restricted to ReadOnly access.

Re-open a Signed Off Location, Folder, Risk or Control

1. Click onManage > By Location.

2. Choose a Location, Folder, Risk or Control you wish to Re-open from the tree in the framework panel.

3. In the detail panel under theEdit Information tab you will seeRe-open button.

4. Click theRe-open button.

5. This item is now Re-Opened.  It can now bemodified and is no longer restricted to ReadOnly access.

The Sign off status of Locations, Folders, Risks and Controls is displayed at the top right of the detail panel.

Mass Sign-Off in Matrix Assessor

Matrix Assessor enables items to be signed off without having tomanually sign off all lower items first, assuming all the

lower level items have been signed off or are available to be signed off.

1. Click onManage > By Location orManage > By Scoping Item

2. Place check marks in the boxes next to each Item in the framework tree you wish to view in theMatrix Assessor.

3. Click theAssessor button

or

Right click on the text of the tree and a pop-menu appears. ChooseAssess Checked Items in theMatrix Assessor

.

4. Click SignOff All Items

Re-Open Items in Matrix Assessor

Matrix Assessor enables items to be signed off without having tomanually sign off all lower items first, assuming all the

lower level items have been signed off or are available to be signed off.

1. Click onManage > By Location orManage > By Scoping Item

2. Place check marks in the boxes next to each Item in the framework tree you wish to view in theMatrix Assessor.

3. Click theAssessor button

or

Right click on the text of the tree and a pop-menu appears. ChooseAssess Checked Items in theMatrix Assessor

.

4. Click Re-Open All Items. Note that when re-opening only the level of items displayed inMatrix assessor is re-

opened and not all the child items. This is to stop the inadvertent re-opening of lower level items that should remain

signed off.



Manage Attachments (Files/Hyperlinks)

Under theManage area of the program, users with permissions for a specific item are able tomanage Attachments (Files or

Hyperlinks) for that item. 

Management functions include: 

1. Attach a New File or Hyperlink

2. Attach an Existing File or Hyperlink

3. Download an Attached File to your Computer or View aHyperlink

4. Remove an Attached File or Hyperlink

5. Delete a File or Hyperlink from the System

6. Update an Attached File or Hyperlink

7. Edit the Name, Description, or Keywords of an Attached File or Hyperlink

8. Modify File or Hyperlink Permissions

9. Check-In and Check-Out Files or Hyperlinks

Attach a New File or Hyperlink

All users have the ability to uploadmultiple file and attach tomultiple items in the system. (6.3)

● Select amaximum of 5 files

● Can be added to an undefined set of items (no limitation)

● Available in all areas of the applicable files can be attached

1. Click onManage > By Location or Manage > By Scoping Item.

2. Choose an Item from the tree in the framework panel. 

3. In the detail panel under theAttachments tab, you will see the Files attached to that Item.

4. Click theAddNew File button. TheUpload New File page will appear.

5. Click theBrowse button > Continue to add additional files (maximum of 5)

6. Add a Description or Keyword by expanding the arrow for the listed file.

7. Attach file to Multiple Items: the item selected in the tree will be automatically checked. Option to select additional

items to attach the file(s) to.

8. Set the default File Permissions for this attachment. There are two settings and both, none or either can be

selected. The options are:

● All Users with permission for this item can read this file.



● Users with higher-level permissions can read/edit this file.

Setting Permissions

Selecting the first optionmeans that any users who have any type of permission for the items (including read only) will auto-

matically receive read only permission for this file. Selecting the second optionmeans that any users who have any other

type of permissions other than read (i.e. Edit Item, Edit Attributes, Evaluate, Owner, Local Admin, Sign Off) will be able to

both read the file and check it out, edit and update it.

Notes: Any new users subsequently given permissions for the item will gain permissions for the file based on the options

above. If an item is attached to two or more items and a user has Read permissions for one item, but another type of per-

mission for the other item(s), the user will have read/edit permissions for that file under all items.

1. Click Save.

2. In addition to the default permissions, specific file permissions can be established for individual users and
groupswho have permissions for the item. Click the Permissions tab adjacent to theOverview tab.

3. The default permissions are grayed out, as they cannot be edited in this screen. The default permissions
display is for information purposes. To add additional users, click Edit.

4. Click Add Users/Groups.

5. Select one or more users or groups from the user/group listing by checking the appropriate box(es) and
click AddChecked Users/Groups.

6. For each added user or group select Read File or Edit File permission. (Edit file permission automatically
gives that user/group permission to read the file. Thismay not be reflected on the current screen, but will
be after the task is completed).

7. Click Save.

Attach an Existing File or Hyperlink

Note: You can only attach an existing file or hyperlink if you have already uploaded the file to GRC Cloud

1. Click onManage > By Location or Manage > By Scoping Item.

2. Choose an Item from the tree in the framework panel.

3. In the detail panel under theAttachments tab you will see the Files attached to that Item.

4. Click theAdd Existing File(s) button TheSearch Existing Files page will appear.

5. Optional: Enter the name, description or keywords of the File you are looking for.

6. Click theSearch button.

7. Select the File(s) you wish to attach by placing a check mark beside the file. Any Files currently attached to the Item

will already be checked.

8. Set whether the default File Permission for this attachment will be ReadOnly. If set to Yes then all users who have

permissions for the item to which the file is attached will have Read access to the attachment. If set to No, the file



permission will be determined solely by the file permissions set for the User by the Administrator in the User Profile

(either ReadOnly, Edit or None).

9. Click theAttach Selected button to attach the File(s).

10. Click theView All Files button to return to the list of all existing files after a search has been completed.

Download an Attached File to your Computer or View a Hyperlink

For Users using MS Office 2007 and below.

1. Click onManage > By Location or Manage > By Scoping Item.

2. Choose an Item from the tree in the framework panel.

3. In the detail panel under theAttachments tab you will see the Files attached to that Item.

4. Click on the File name of the File you would like to download.

5. The file overview page will appear showing all versions of the attached file.

6. To download the file click on the version you would like to download.

7. A File Downloadwindow will appear, chooseOpen orSave as appropriate.

Remove an Attached File or Hyperlink

1. Click onManage > By Location or Manage > By Scoping Item.

2. Choose an Item from the tree in the framework panel.

3. In the detail panel under theAttachments tab, you will see the Files attached to that Item.

4. Place a checkmark beside the Attachments(s) you wish to remove, and click theX button.

5. A window will appear to confirm that you wish to remove the file. Click OK.

6. Using the new Interface to Attach File to Multiple Items, in the Selected Items section, removing an entry after

save will not remove the file from the items. This feature is for addition of files only.

After saving, it will only list the item selected in the tree. (6.3)

Note: When you remove an Attachment from an Item, you are not deleting it from the system. You are just removing the

association between the File and the Item. View the System Administration-File Management section of the help file to

learn how to delete the Attachment entirely.

Delete a File or Hyperlink from the System

1. Click onSystem > File Manager.

2. Optional: In the area headed "Search for files with the following keywords:" Enter the name, description or key-

words of the file you are searching for.



3. In the list of files that appears, check the box relating to all files to be deleted (clicking the check box on the top row

of the table will select all items) and click theX button.

4. A window will appear to confirm that you wish to remove the file. Click OK.

Update an Attached File or Hyperlink via Download

For Users using MS Office 2007 and below.

1. Click onManage > By Location or Manage > By Scoping Item Choose an Item from the tree in the left-side

panel.

2. In the right-side panel under theAttachments tab, you will see the Files attached to that Item.

3. Click the on the File Name of the desired File.

4. TheEdit File orAttachment Informationwindow will appear. Click theEdit button at the top of the page, unless the

Item has already been checked out by you.

5. New in 6.3Option to selected additional items to add to via the Attach to Multiple Items section.

If the Edit button does not appear, it is because the file has been checked out. The status of the file will say "Checked out

to:...", and the file cannot be edited by other users until it has been checked back in. For more information on Check-in and

Check-out status, see the Check-in and Check-out Files and Hyperlinks section below.

1. Click theUpload New Version button beside the File you'd like to update. TheUpload New Versionwindow will

appear.

2. Type the new File location or click Browse to select the new File.

3. A File Browserwindow will appear. Choose the new version of the File and click Open.

4. Click Save to replace the old File with the new one.

5. The old version of the File is still retained and is itemized by version number, date and time in theEdit File or

Attachment Informationwindow.

Edit the Name, Description, or Keywords of an Attached File or Hyperlink

1. Click onManage > By Location or Manage > By Scoping Item.

2. Choose an Item from the tree in the framework panel.

3. In the detail panel under theAttachments tab, you will see the Files attached to that Item.

4. Click the on the File Name of the desired File.

5. TheEdit File orAttachment Informationwindow will appear. Click theEdit button at the top of the page, unless the

Item has already been checked out by you.

If the Edit button does not appear, it is because the file has been checked out. The status of the file will say "Checked out

to:...", and the file cannot be edited until it has been checked back in. For more information on Check-in and Check-out

status, see the Check-in and Check-out Files and Hyperlinkssection below.



6. Modify the information as required.

7. Click Save to apply your change(s).

Modify File or Hyperlink Permissions

File Permissions may be set as follows:

Read File: A user with this permission is able to view the File or Hyperlink.

Edit File: A user with this permission is able tomodify the File or Hyper-
link: Status, Name, Version, Description and Keywords.

“None” A user with no permissions is unable to view the file or any infor-
mation relating to it.

Only Administrators and the File creator can assign File Permissions.

1. Click onManage > By Location or Manage > By Scoping Item.

2. Choose an Item from the tree in the framework panel.

3. In the detail panel under theAttachments tab, you will see the Files attached to that Item.

4. Click the on the File Name of the desired File.

5. TheEdit File orAttachment Informationwindow will appear.

6. In the detail panel under the Permissions tab, you will see existing permissions for that item.

7. If the file is checked-in then click theEdit button at the top of the panel.

8. Click theAddUsers/Groups button to view a list of all users within the system that can be given various per-

missions to this Item.

9. Check the User Group(s) you want to assign permissions to or open a group by clicking on the plus sign to select

individual members listed within that group.

10. Click the Add Selected User/Groups button. The users or groups selected will now appear in the list ready to be

assigned specific permissions.

11. By default, each user or group added will be given Read File permissions. Use the check boxes to determine any

additional permission for each user and group listed.

12. To edit existing permissions, check or uncheck the applicable boxes, or click theX to remove all permissions for a

user or group.

13. Click Save to apply your change(s).

Check-In and Check-Out Files or Hyperlinks

The Check-in/Check-out feature is designed to protect the integrity of Files. Any time a file is edited; it is automatically

Checked-Out, which prevents other users from also editing the file.

1. Click onManage > By Location or Manage > By Scoping Item.



2. Choose an Item from the tree in the framework panel.

3. In the detail panel under theAttachments tab, you will see the Files attached to that Item.

4. Click on the File Name of the desired File.

5. TheEdit File orAttachment Informationwindow will appear.

6. UnderStatus, it will read "Checked-In" if the file is available for editing. Otherwise, it will read "Checked-Out to:

[user name]".

7. If a file is checked-out by another user:

8. TheEdit button will be unavailable.

9. The item cannot be edited unless it is checked-in by that user.

10. The item can be forced to check-in by an Administrator by clickingCancel Check-Out.

11. If the File is checked-in, click theEdit button at the top of the page.

12. The File will be checked-out until theKeep file Checked-out option is unchecked.

13. Click Save to apply your change(s).

Preview an Excel File

Quickly preview the content of an attached Excel file via the preview option.

1. Only MS Excel file (supported types: xls / xlsx).

2. Only displays one sheet. Default is the first sheet.

3. To display a different sheet, simple save the file on that sheet and it will display in the preview. Example: if there are

5 sheets and the 3rd was open when the file was saved, the 3rd sheet will show in the preview.

4. Not all data can be displayed. There are limitations with charts, graphs, images, and intricate function results. XLS

displays more limitations than xlsx.

5. No Internet Explorer 8 support.

6. Option can be disabled via the system settings: Enable Excel Preview = True / False

7. To enable, navigate to the system setting via the Administrationmenu. Set: Enable Excel Preview = True



Editing File Attachments via WebDav

File management has becomemuch easier and quicker to use.

Instant File Updates Overview

● Clicking on a file creates a version that is connected to server.

● User can continue to work and update changes back to the server.

● A token is granted to do this and expires after 8 hours.
o Default – auto checked back in after 8 hours.



● Applies to: Word, Excel (includes XLSM), Powerpoint, Visio.

On open, it checks out the file so no other user canmakemodifications.

● Admin can cancel the check – user can upload back in if needed.

● Areas Instant File Updates are available:
a. Framework Library

b. Manage by

c. Item Overview and Hierarchical Reports

d. File manager

e. Not supported in Matrix Assessor

Once Opened

● Saving will create a new version in the system.

● Saving will continue to update the new version, not create another version with each save.

Once Closed

● The file is checked back in.

● Version is updated and time stamped with the last update.

● User can continue to access the file via recent versions (if within the 8 hours).

System Setting

● Defines the token expiration (default 8 hours)

● Option to completely disable theWebdav technology used to support updates.

● It will revert back to original approach (download, make changes, re-upload)

Visio Files

If Visio is installed, it will show the user amessage that will allow them to download the file. The file will not open inWeb-

Dav.

1. A redmessage will appear in themessage bar.

2. Message: Click here if your file did not open successfully.

3. Clicking on link will download the file.

Working In Office



● MS Office has rules in place regarding file sharing and editing, these rules are respected

● Opening files
o Cloud will allow 2 users to open, but the 2nd will be read only.

o Once closed by the other user they will be notified it’s ready to be edited.

o Both will have their own token.

o New version will be created for the original user that saves and closes.

Additional Notes

● Permissions are fully respected

● Note: if a user manually checks the file out and then proceed to click on the link to get live copy to edit, it will not

give it to them. It will read the file as checked out regardless of whether or not it is the same user.

● Feature Requirements: MS office 2010 and above.

Change Log / Audit Trail

A complete record of every user action associated with the Item is displayed in the Change Log tab. This functionality is

used for audit purposes and cannot bemodified. The Date, User Name and Description of the action are displayed in chron-

ological order with themost recent action first. Change log doesn't not record administrative actions (Role Permission build-

ing, framework building, etc)

By default, the Change Log tab is deactivated for non-Admin users.

Redlining and Highlighting Changes

Specific to the Rich Text Editor, all changes will be tracked highlighting any additions in green text and redlining any

deleted text. This changemakes it easier to quickly understand what changes have beenmade to rich text criteria. (6.2)

Note: when initially assessing the rich text editor and spreadsheet criteria, text will not be highlighted.

Note: Audit Trail and Change Log do not capture redlining and highlighting of changes for the Spreadsheet criteria. Only rec-

ords the latest value. (7.0)



Matrix Assessor

Simultaneous assessment of multiple items can be achieved through thematrix assessor, which presents attribute and

evaluation information in a spreadsheet-like format.

1. Using theMatrix Assessor: View Tab

2. Using theMatrix Assessor: Show/Hide Columns Tab

3. Using theMatrix Assessor: Autosize Tab

4. Viewing Previous Period Data in theMatrix Assessor

5. Adding Framework and Non-Framework Items viaMatrix Assessor

6. Calculating Function Results in Matrix Assessor

7. Attaching Files in Matrix Assessor

8. Sign-Off/Re-Open inMatrix Assessor

Starting the Matrix Assessor

1. Click onManage > By Location or Manage > By Scoping Item.

2. Place check marks in the boxes next to each Item in the framework tree you wish to view in theMatrix Assessor.

Items may be selected from different levels within the framework. If you wish to view all items under a particular

item, it is not necessary to click all items at this time as these can be toggled on or off one thematrix assessor is

opened.



3. Right click on the text of the tree.

4. A pop-menu appears. ChooseAssess Checked Items in theMatrix Assessor.

Alternatively

1. Click onReport > Item Overview(where Item is the item you wish to report on. i.e. Risks or any sub-type of

Risks). The Item Overview page will appear.

2. Place check marks in the boxes next to each Item in the report you wish to view in theMatrix Assessor.

3. Click theAssess button at the top of the left panel. Thematrix assessor will load.

Note: Select only the items you wish to evaluate and items required for context. Selecting large amounts of items may

result in performance degradation.

Using the Matrix Assessor

WhenMatrix Assessor loads you can assess multiple items at once in a hierarchical structure.  The permission structure

applies to theMatrix Assessor, and only items and criteria users have edit permissions for will be editable.  TheMatrix

Assessor has three tabs: View, Show/Hide Columns and Autosize, as described below.

Using the Matrix Assessor: View Tab

● Use the +/- boxes beside the item names (Folder, Risk, Control...) to expand or contract the level below in the

framework.

● Use the +/- box in each column header to show or hide that column.

● Clicking in any of the cell of theMatrix Assessor will bring up an interface to evaluate that attribute or evaluation

criteria.

● Each instance of aMulti-Parent item in theMatrix Assessor can be viewed, but only the first instancemay be

edited. Each subsequent instance is grayed out within Matrix Assessor, to indicate that it cannot be edited in that

position. However, all changes made to any multi-parent item will be replicated in its other instances.

Note: The system is set to time out after 20minutes of inactivity between the browser and the server for security purposes.

A warning will appear after 15minutes of inactivity. Ensure you save your assessments completed in theMatrix Assessor

before 20minutes pass to prevent timeout. To adjust the timeout period for your site, contact client-

support@resolvergrc.com

Using the Matrix Assessor: Show/Hide Columns Tab

1. Click on theShow/Hide Columns Tab tomodify the visible columns.

2. Uncheck any criteria you would like to hide.

3. Click Update View.

Using the Matrix Assessor: Autosize Tab

The Autosize feature sets the height and width of all the cells within Matrix Assessor.
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1. Click on theAutosize Tab tomodify the row and column sizes.

2. In the Row Height section, set the amount of information to be viewable without scrolling, by choosing aminimum

andmaximum number of rows using the right hand drop down box. Row height can range from 1 row to 30 rows.

3. The width of each column for any item inMatrix Assessor, is set by clicking the preferred option: Narrow, Normal

orWide.

4. Click theUpdate View button.

View Previous Period in Matrix Assessor

If the user's data preferences have been set to view specific previous periods and evaluation criteria, this information will

automatically appear immediately below the current period data in the right hand panel on theManage by Location screen.

To set up your own user profile to see this see Data Preferences inMy Profile. Instructions for Administrators to set up this

feature for other users is found in Data Preferences in User Management.

Adding Framework Items and Non-Framework Items in Matrix Assessor

1. WhenMatrix Assessor is opened, icons will appear at the left hand and right hand ends of each row. These icons

indicate the items that can be created at this level, depending on the user's permissions and the level of the hier-

archy. For example, for an Admin user, when looking at a Risk, a Control may be added or when looking at a loca-

tion either a location or a folder may be added. At all levels, and for all users, an Issue and a Stepmay be added.

2. Click on the appropriate icon. A window will open with all the appropriate fields for an item of that type. Complete

as described inManage Framework Items andManage Non-Framework Items.

3. Click Savewhen completed.

Calculating Function Results in Matrix Assessor

1. WhenMatrix Assessor is opened, the current results of functions are included in the grid. These will typically

appear toward the right of the screen.

2. Click Calculate. Review the list of all functions at this level of the framework and below.

3. Check the boxes adjacent to the functions to be updated, or chooseSelect All Functions. Note that only the func-

tions related to this framework item are shown inMatrix Assessor, although any number of functions may be

updated.

4. Click Calculate to update the calculations. Click Close to close the window and return toMatrix Assessor.

Adding File Attachments in Matrix Assessor

1. WhenMatrix Assessor is opened, icons appear at the left hand and right hand ends of each row. One of these ena-

bles themanagement of file attachments.

2. TheManage Files window appears and any existing files will be displayed. To add/delete or edit files follow the

instructions discussed inManage Attachments.

3. When completed, click Close to close the window and return toMatrix Assessor.



Mass Sign-Off in Matrix Assessor

Matrix Assessor enables items to be signed off without having tomanually sign off all lower items first, assuming all the

lower level items have been signed off or are available to be signed off.

1. Click onManage > By Location orManage > By Scoping Item

2. Place check marks in the boxes next to each Item in the framework tree you wish to view in theMatrix Assessor.

3. Click theAssessor button

or

Right click on the text of the tree and a pop-menu appears. ChooseAssess Checked Items in theMatrix Assessor

.

4. Click SignOff All Items

Re-Open Items in Matrix Assessor

Matrix Assessor enables items to be signed off without having tomanually sign off all lower items first, assuming all the

lower level items have been signed off or are available to be signed off.

1. Click onManage > By Location orManage > By Scoping Item

2. Place check marks in the boxes next to each Item in the framework tree you wish to view in theMatrix Assessor.

3. Click theAssessor button

or

Right click on the text of the tree and a pop-menu appears. ChooseAssess Checked Items in theMatrix Assessor

.

4. Click Re-Open All Items. Note that when re-opening only the level of items displayed inMatrix assessor is re-

opened and not all the child items. This is to stop the inadvertent re-opening of lower level items that should remain

signed off.

Manage Framework Items (Locations, Folders, Risks, Con-
trols, Standard Tests)

Framework Items include Locations, Folders, Risks, Controls, and Tests. In theManage area of the program Admin-

istrators and other users who aremembers of roles with advanced permissions are able to add, edit and remove Frame-

work Items, which will be reflected in the Framework and Location Trees.

1. Create a New Framework in your area of responsibility

2. Create a New Item in your area of responsibility

3. Remove an Existing item from your area of responsibility

Only Administrators and users in roles with the advanced permissions to Add/Delete Child Items and/or the advanced per-

mission to Update the Library fromManage by Location can perform these tasks.



Add an Item from an Existing Framework to your Area of Responsibility

1. Click onManage > By Location.

2. Choose an Item you wish to add a Child Item to from the tree in the framework panel. 

3. In the detail panel, click on the tab that pertains to the Child Item Type you would like to add (available tabs are

determined by the Items relationships).

4. Click AddNew <Item> (where <Item> is the type of Child Item you would like to add).

5. If starting at a Location and there is more than one Framework available in the system, select the Framework that

you wish to add Items from.

6. Select the Items that you wish to add using the check boxes provided.

7. Click AddChecked Items.

8. Click Refresh to see the new Child Item(s).

Create a New Framework in your Area of Responsibility

1. Click onManage > By Location.

2. Choose a Location you wish to add a folder to from the tree in the framework panel.

3. In the detail panel, click on the Folders tab.

4. Click AddNew Folder.

5. Click Create New Framework. TheAddNew Folder page will appear.

6. Enter the Framework details.

7. Click theCreate button.

8. A new Framework will be created with only one item in it, the root folder.

9. Select the newly created folder using the check boxes provided.

10. Click AddCheckedItems.

If you wish to addmore items to this new framework then click on the newly added folder and then Create a New Item in

your Area of Responsibility.

Create a New Item in your Area of Responsibility

1. Click onManage > By Location.

2. Choose an Item you wish to add a child Item to.



3. In the detail panel click on the tab that pertains to the item type you would like to add (available tabs are determined

by the item type and the relationships that item type can have).

4. Click AddNew <Item>. (Where <Item> is the type of sub item you would like to add.)

5. If the item that you selected in the framework panel is part of an existing framework then theAddNew <Item>

Page in the right side panel will show a branch of the framework with the selected item as the head of the branch.

6. Click Create New Item.

7. On theAddNew <Item> page that appears, fill in at least basic information such as Item name and number.

8. Click Save to apply your change(s).

9. Click Refresh to see the newly added Items. 

Creating a new item and attaching it as a child item will actually create a new item within the framework in the appropriate

position.

Adding a new item in this way will save all attributes and descriptors with the item in the Framework. Previously, only the

Descriptors (name, number, description and sub-type information was saved and the attributes were only saved for the

instance of the item in that location. (5.4)

In addition to creating new items both in the location and adding a corresponding item to the framework, it is now possible

for Administrators and Non-Administrators to edit items in theManage by Screen and have those changes copied to the cor-

responding item in the framework library. (5.4)

Remove an Existing Item from your Area of Responsibility

1. Click onManage >By Location.

2. Choose the Item you wish to delete.

3. In the detail panel on the toolbar click theDelete button.

OR

1. Click onManage > By Location.

2. Choose the parent item of the sub Item you wish to delete.

3. In the right-side panel under the <Item> tab you will see existing Risks associated with that item (where <Item> is

the name of the item type that you wish to delete).

4. Click Delete beside the Item you wish to delete.

Once delete is clicked it will indicate to the user the number of descendants that will also be deleted. A delay is in place to

ensure users take the time to acknowledge the implications of the delete. To disable this, simply check the box andOK will

be available immediately. The delay will then be removed for for 24 hours. (7.1)



Updating the Framework version of an Existing Item from your Area of Respon-
sibility

1. Click onManage >By Location.

2. Choose the Item, make changes and click theUpdate Library button on the item to update the individual item.

3. Select criteria to update (8.0).

4. Changes are saved to the instance of the item being viewed inManage by Location. In addition any changes to the

attributes and descriptors (name, number, description and sub-type info) will also bemade to the corresponding

item in the framework library.

OR

1. Click onManage > By Location.

2. Check items to be updated in the tree on the left side of the screen.

3. Click theUpdate Library button.



4. Select criteria to update (8.0). In this casemultiple item types may be selected and can select criteria on a per item

type basis.

5. The attribute and descriptor values in the checked items are copied to the corresponding items in the framework

library.

Important Note: Prior to 8.0, blank values would be ignore. Now that the user can specify what criteria they can

update, blank values will override any values.

Important Note: Permissions are respected in action. If user has read only permissions and they update all crite-

ria, only the ones they have edit to will be update.

Moving Items between Locations in Area of Responsibility

1. Click onManage >By Location.

2. Choose the Item you wish tomove and click theChange Parent button.

3. A tree opens in the right hand screen. Select the new parent for the item and press theMove button.

4. Click OK to confirm themove.

Multi-ing Items within Locations in Area of Responsibility

1. Click onManage >By Location.

2. Choose the Item you wish to attach to additional parents and click theChange Parent button.

3. A tree opens in the right hand screen. Select the additional parent(s) for the item and press theMulti-Parent button.

4. Click OK to confirm creating themulti-parent item.



Manage Non-Framework Items (Issues, Action Plans, Notes,
Steps, Test Results)

Non-Framework Items include Issues, Action Plans, Notes, Steps, and Test Results. Under theManage area of the pro-

gram authorized users are able to add and remove Non-Framework Items as Child Items of an existing Item:

New in 5.2

All newly created Tests are framework items. It is no longer possible to create a non-framework test item.

Add a New Child Item

1. Click onManage > By Location.

2. Choose an Item you wish to add a Child Item to from the tree in the framework panel.

3. In the detail panel click on the tab that pertains to the Child Item you would like to add. (Available tabs are deter-

mined by which Items are eligible Child Items for that Parent Item Type.)

4. Click AddNew <Item>. (Where <Item> is the type of Child Item you would like to add.)

5. Complete at least basic information such as Item name.

6. Click Save to apply your change(s).

7. Click Refresh to see the newly added Items.

Example: Add an Issue to a Control

1. Click onManage > By Location.

2. Choose the Control you wish to add an Issue to from the tree in the framework panel.

3. In the detail panel, click on the Issue tab.

4. Click AddNew Issue.

5. On theAddNew Issue page that appears, fill in the name, select a sub-type if applicable, fill in description, and any

attributes associated with that Item Type or Sub-Type.

6. Click Save to apply your change(s).

7. Click Refresh to see the newly added Items. 

 Remove an Existing Child Item

1. Click onManage > By Location.

2. Choose the Item you wish to delete from the tree in the framework panel. 

3. In the detail panel on the toolbar click theDelete button.



Or

1. Click onManage > By Location.

2. Choose the Parent Item of the Child Item you wish to delete from the tree in the framework panel.

3. In the detail panel under the <Child Item> tab you will see existing Child Items associated with that Item. (Where

<Child-Item> is the name of the Item type that you wish to delete.)

4. Click Delete beside the Item you wish to delete.

Once delete is clicked it will indicate to the user the number of descendants that will also be deleted. A delay is in place to

ensure users take the time to acknowledge the implications of the delete. To disable this, simply check the box andOK will

be available immediately.The delay will then be removed for for 24 hours. (7.1)

Moving Items between Locations in Area of Responsibility 

1. Click onManage >By Location.

2. Choose the Item you wish tomove and click theChange Parent button.

3. A tree opens in the right hand screen. Select the new parent for the item and press theMove button.

4. Click OK to confirm themove.

Multi-ing Items within Locations in Area of Responsibility

1. Click onManage >By Location.

2. Choose the Item you wish to attach to additional parents and click theChange Parent button.

3. A tree opens in the right hand screen. Select the additional parent(s) for the item and press theMulti-Parent button.

4. Click OK to confirm creating themulti-parent item.

Users have the ability to multi all non framework items. (Added: Steps, Test Results, Action Plans)



Manage By Location / Manage By Scoping Item – Right Click
Menu and Button Menu

Easy Menu Navigation

Themenu contains sevenmain options including one sub-menu:

1. Check All: Checks all expanded items below the node clicked on.

2. Uncheck All: Reverts the above action.

3. Expand all descendants below current item

4. Assess checked items inMatrix Assessor

5. Assess current item and descendants in Matrix Assessor

6. Calculate Functions

7. Update checked items' attributes to library

8. From the pop up: select all or individual criteria

9. View <Items> Under this Item: loads the selected item type in the Item Overview

In addition, some options are available through gray buttons at the top of the left hand panel.



Expand all descendants below current item

This option enables the quick opening of multiple branches of the framework tree. This feature will display up to 200 items.

This limitation is to ensure system performance. If an item with more than 200 descendants is chosen an error message

will display.

1. Click onManage > By Location or Manage > By Scoping Item.

2. In the framework panel, right click the item below which you wish to display the descendants.

3. Select Expand all descendants below current item

Assess Checked Items in Matrix Assessor

All selected items will be displayed in theMatrix Assessor enabling quick assessments.

1. Click onManage > By Location or Manage > By Scoping Item.

2. In the framework panel, check off the items you wish to assess.

3. Click theAssessor button, or right click on any item in the framework tree to see the right click menu and choose

theAssess Checked Items in Matrix Assessor option.

4. The screen will refresh displaying theMatrix Assessor (also limited to 200 items)

5. For more detailed information onMatrix Assessor see:Manage > Matrix Assessor

Assess current item and descendants in Matrix Assessor

As an alternative approach to checkingmultiple items, this option will open up to 200 items inMatrix Assessor, starting

from the current item and from all lower items. The items will be displayed in theMatrix Assessor enabling quick assess-

ments.

1. Click onManage > By Location or Manage > By Scoping Item.

2. Right click on the highest level item in the framework tree to be viewed inMatrix Assessor.

3. Select the optionAssess current item and descendants in Matrix Assessor.

4. The screen will refresh displaying theMatrix Assessor.

5. For more detailed information onMatrix Assessor see:Manage > Matrix Assessor.

View Checked Items in Chart Builder

Displays the selected items in a heat map in the right panel. 

1. Click onManage > By Location orManage > By Scoping Item.

2. In the framework panel, check off the items you wish to be included in the chart data.



3. Click the Chart button,  Chart Builder launches with the selected data included in the available data series. For

more detailed information on Charts see: Chart Builder.

Export Selected Items to Resolver Ballot

Exports selected items and criteria to Resolver Ballot for group-based assessment.

1. Click onManage > By Location or Manage > By Scoping Item.

2. In the framework panel, check off the items you wish to export.

3. Click theBallot button.The right panel will refresh displaying a Criteria list to export.

4. For more detailed information on Exporting to Ballot see: Report > Item Overview

Export Selected Items to Resolver Survey

Exports selected items and criteria to Survey for group-based assessment.

1. Click onManage > By Location or Manage > By Scoping Item.

2. In the framework panel, check off the items you wish to export.

3. Click theSurvey button. The right panel will refresh displaying a Criteria list to export.

4. For more information on Exporting to Survey see Report > Item Overview.

Calculate Functions

1. Click onManage > By Location or Manage > By Scoping Item.

2. Click theCalculate button or right click on any item in the framework tree and choose theCalculate all functions

under the currently selected Item option.

3. The right panel will refresh displaying a tree of the selected item and all items below it and lists the functions con-

tained in these items.

4. To recalculate all functions within and under this item, check Select All Functions. Alternatively, to select specific

functions navigate through the list by clicking the + signs to view all item types and functions.

5. Click Calculate to update all the function calculations with current data.

6. For more detailed information on Calculate Functions see: Design > Item Templates > Functions.

View <Items> Under This Item

Brings up amenu of all item types, choose to see all <items> under the item you right clicked on displayed in Item

Overview. 

1. Click onManage > By Location or Manage > By Scoping Item.

2. Right click on any item in the framework tree.



3. Choose theView option.

4. Select which <items> you would like to view.

5. The page will refresh displaying the Item Overview screen for the selected Item Type.

6. For more detailed information on Item Overview see: Report > Item Overview.

Reset All Workflow Under the Current Selected Item

1. Cick onManage > By Location or Manage > By Scoping Item.

2. Select item to act as a starting point for the reset

3. Click Reset Workflow

4. View item will refresh with a item type tree displaying all associated workflows

5. Select workflows to be rest

6. Click Reset Workflow

Updating the Library

1. Click onManage >By Location.

2. Choose the Item, make changes and click theUpdate Library button on the item to update the individual item.

3. Select criteria to update (8.0).

4. Changes are saved to the instance of the item being viewed inManage by Location. In addition any changes to the

attributes and descriptors (name, number, description and sub-type info) will also bemade to the corresponding

item in the framework library.

OR

1. Click onManage > By Location.

2. Check items to be updated in the tree on the left side of the screen.

3. Click theUpdate Library button.



4. Select criteria to update (8.0). In this casemultiple item types may be selected and can select criteria on a per item

type basis.

5. The attribute and descriptor values in the checked items are copied to the corresponding items in the framework

library.

Important Note: Prior to 8.0, blank values would be ignore. Now that the user can specify what criteria they can

update, blank values will override any values.

Important Note: Permissions are respected in action. If user has read only permissions and they update all crite-

ria, only the ones they have edit to will be update.

Offline Assessments

TheGRC CloudOfflinemodule enables users and non-users of the full GRC Cloud application to complete assessments

within a desktop program rather than accessing web-basedGRC Cloud.

Benefits include:

● Assessment may be completed when user is not connected to the Internet

Users of GRC CloudOffline can:

● Assess any items and criteria to which the Administrator gives them access

Exception for criteria: spreadsheet or multi user picker

● Save their work and return to it later

● Electronically submit their assessments when they next connect to the Internet.

Users of GRC CloudOffline cannot:



● View any other areas of the organization’s framework or locations, run reports etc.

● Assess spreadsheet or multi user picker.

● Transition workflows.

Exporting Items Offline

To engage the offline capabilities follow the steps below:

1. Navigate to Programs and Activities.

2. On the required activity (Example: fieldwork), scroll to the Actions.

3. Check off: OfflineEnabled on this Activity.

4. AnOffline option will be available per item in the focus picker.

5. Additional steps may need to be configured for the Activity to list items on the focus picker. See Programs and Activ-

ities.



Steps to Take Items Offline

1. Click on the offline icon in the focus picker.

2. User will be prompted by a pop up indicating:
a. File name

b. Instructions to install the client.

c. Click on the link in the pop up to install the new offline client.

Note: Previous versions are not compatible with a file exported after 8.1. Install is mandatory.

3. Click Check out x Items
a. All items the user has permissions to below the focus point will be taken offline.



4. Items will be locked within GRC Cloud until export is canceled or resubmitted.

Re-Exporting the Same Items

1. If the user exports again from the same focus, after a file is already offline, it will cancel the file already exported.

2. User cannot submit the original file exported.

Warning: You currently have this Focus exported. If exported again, the previous file is no longer valid for sub-

mission. Do you want to continue?

File Size

1. OnCheck Out / Export, any file that exceeds 500 items will not be supported. Please readjust the focus con-

figuration.

2. Message: Your offline file exceeds 500 items and cannot be exported. Please contact your administrator to discuss

reconfiguration of your focus.

Locked Item Management / Permission

When items are offline the system needs to ensure editing cannot be done internally when a user is working offline. To

avoid any issues, a locking logic has been placed on the items.

Indication of Locked Item

1. As noted above, all items below the focus picker selected for offline will be locked from editing.

2. Applies toManage by AND Editable reports: Item is read only and shows a lock.



3. All elements related to the file are locked (criteria, files, permissions, change parent).

4. Exceptions to the Locking Logic:
a. Administrative Changes via the Framework Library

● Updates, moves, deletion from the Framework Library are possible. It is to the discretion of the admin-

istrator if these actions should be executed.

● If offline files are pending, amessage is given to the user.

Warning: There are currently 'x' offline assessment(s) in a pending state. Any structural changes may

impact these assessments. View the assessments currently offline.

b. Period End

● If files are checked out when a period end is run, amessage is given to the user before they

begin.

● Items will remain locked after the period end completes. User can still submit their files.

c. Workflow Linked Actions
● Actions coming from linked workflows are still active.

d. Functions
● Functions requiring recalculation due to their inclusion of another function will be recalculated.

Locking Logic

1. No user can edit the items including administrators.

2. Administrators can cancel the lock by canceling the offline export.

3. Canceling an Exported Offline File
a. Navigate to the Tools menu

b. Click onOffline Assessments



c. Show: Pending

a. Click the X (Cancel button)

4. User can cancel their personal files.

5. Administrators can cancel all exported files.

6. All multi items will be locked will be locked. Example if a multied risk falls under two focus points and one is taken

offline, both will be locked internally.

7. Permissions Internally
a. If you do not have permissions to an item it will not lock / other users can cont to edit internally.

8. Items already offline: when exporting items to offline and an item is already locked by another user, it will be sent to

the offline regardless of permissions. Two people cannot have the same item editable offline.
a. Scenarios

● Multis: 2 users need to take their branch of the tree offline but each contains amulti item.

● High Level: a user wants to take a large section offline but a part of it is already offline.

b. On submit, these items will not be included in the update

Offline Management

Via the Tools menu, the offline assessment page is accessible for all management and review of the offline files.

Error Messages

For each submitted offline file, it records all error messages captured during the import. This includes: structure changes,

criteria deletions, item deletions.



Canceling Locked Items

1. Navigate to the Tools menu

2. Click onOffline Assessments

3. Show: Pending

4. Click the X (Cancel button)

WarningMessage: Canceling the lock will reopen the items but also render the exported file void. The user will not

be able to submit it back into GRC Cloud. Are you sure you want to continue?

5. File is now void and cannot be submit by the user.

Working Offline

Once offline the experience is very similar to working internally in GRC Cloud.

How to Work Offline

1. Install the client via the link detailed in the pop up window when exporting items via the focus picker.

2. Save the file to your local computer (Local Folder or DeskTop).

3. Open the offline client.

4. Click Open in themenu.

5. Begin work.

Criteria

1. All criteria are supported in the offline client.

Exception: Spreadsheet Criteria

Permissions

1. Permissions are fully respected andmirror the permissions in GRC Cloud online.

Exception: if a user does not have permission to an item in the tree but does have visibility to items below it, the off-

line client will represent this item by displaying the item number and nameONLY.

Item Creation

Items can be created in the offline client in a similar fashion to item creation in GRC Cloud.

1. For each item, Add new item is available.
a. Hierarchical structure applies as it does in GRC Cloud.

2. Click the desired item type to create.
a. New Item name is set by default

b. Item is inserted in the tree

3. Click on the item.



4. Assess the item. (Update name, attributes, files, etc.)

5. Notes:
a. New item creation only applies to non framework items.

● Item creation permissions are based of the parent add item permissions defined in GRC Cloud.

b. Bothmain and sub type items can be created offline: Issues, Test Results, Action Plans, Steps (+ their appli-

cable sub types).

c. Item Numbering
● On import new items need to tap into the auto numbering logic when being created and define the next

applicable number.

● If a number was defined in the offline client, it will ignore the numbering logic and import it with the new

number defined in the offline.

6. Multiple items creation
a. A user can createmultiple new items.

b. User can fill out those fields inline (after creation).

c. User can delete the item if a mistake was made (only new items).

d. On import of the offline file, the new item gets created in the hierarchy.

Submission of Offline Files

OnUpload/Submit of the file back into Cloud a user is required to input their credentials.



Submitting an Offline File

1. In theMenu options, click Submit.
a. On submit, the user will be prompted to insert their username and password.

2. Results get uploaded and the database gets update with new items, values, file attachments.

3. Warning on Submit: Offline files can only be submitted once. Please ensure you have completed all your

work before submitting the file.

4. File Size: file size cannot exceed 50m.

5. Unsuccessful submissions: User is notified with a list of errors.

a. File will remain editable and can be submitted.

b. File can be submitted again until successful.

Submitting an Offline File via Single Sign On

1. In theMenu options, click Submit



2. User will be prompted detailing additional authentication will be required. Click Submit via Browser

3. Once the user is authenticated, they will have the option to upload the file into GRC Cloud

4. Choose File

Note: the file namemust match the file name indicated above in the Location of your file.

5. File has now been uploaded. As noted above, any error messages will be displayed to the user.

6. If the file has been accidentally canceled, administrators do have an option to force submit.
a. Adminmust be authenticating with their credentials.

b. Clicking submit will route theme to the same submit page.

c. Proceed with submit.

How to Import a Canceled File

1. If a file was accidentally canceled, there is an option to Force Submit. Only administrators can force submit files.

2. User must attempt to submit

3. User must send the file to the administrator (example: via email)

4. Administrator opens offline client.



5. Insert username and password.

6. Click Submit

Additional

1. XP is not supported.

Time Tracking v8

Usedmostly by Audit and Compliance Teams, GRC Cloud’s time tracking capabilities help organizations maximize cov-

erage by capturing audit planning estimates and enabling efficient contrast and analysis with actual time spent on audit

activities. In this release, Resolver has launched a brand new Time Sheet capability that enables rapid capture and logging

of hours spent on all activities.

Time Tracking is configured via the GRC Programs page. Once the program is setup, selecting the Time Tracking check-

box will enable the ability to log time against the defined item types. Upon completion of the program, roles associated to

that program can select items they have permissions to and log time via the time sheet (example: Audits).



Time Tracking Need to Knows

1. Caching: theSelect an Item list is cached for 20minutes.

2. Saving: all elements of the page automatically save.

3. Favorites: selecting an entry as a favorite will persist it as user changes from week to week.

4. ChangingWeeks: If an entry has no time associated to and not a favorite, it will remove/delete the entry.

5. Searching: item list can be searched. 



6. Item List: Items in that list are defined by workflow states and permissions.

7. Flagging Cells:
● If time entry exceeds 24 hours it will flag and stop the entry from being saved.

● If a entry exceeds 8 hours, it gets flagged as yellow.

● If the summation of time exceeds typical working hours (8 hours / day) it will get flagged as yellow or

red (dependant on amount exceeded).



Time Tracking Reporting

a. Available via the data warehouse and 3rd party reporting or Excel.

b. All applicable dates are replicated in the warehouse to get maximum reporting value out of your data.

c. Please contact Resolver Client Care to learnmore about Time Tracking Reporting.

To learn more about configuring GRC Programs for your organization, please
contact Resolver Client Care.

Time Tracking - Legacy Time Tracking

Time Tracking has been rebuilt. This functionality only exists for clients that utilized the feature prior the 8.0 Release. Learn

how to use the new Time Tracking.

The view item inmanage by of the application contains an option for users and administrators to log and track time against

any item type in the system. Users can separately log their time against any task/item they are assigned to, which will then

cascade up the tree and be summarized at the parent levels.

Example: Internal Audit teams require users to track their time against each audit task. Tasks hours will then roll up to the

overall audit level and help you gain an understanding if the hours budgeted were adequate or if it went over budget.

Time Tracking is currently not included in any permission sets within application. All users have access to log and track

time in the view item.

mailto:clientsupport@resolvergrc.com
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Time tracking can be engaged on any item type in the system. Administrators can enable and continuously manage this set-

ting for each individual item type in the system. (6.3)

Enabling Time Tracking:

1. Design > Item Templates > 'Select an Item Type - Main Type only'

Note:Only enabled on themain type and will apply to all subtypes

2. Check the box under heading Time Tracking

Steps to Logging Time:

1. Go toManage by Location or Scoping

2. Select an item with Time Tracking enabled

3. Time Trackingwill be an additional tab on the View Item (beside the Change Log)

4. Click Log Time

5. Insert time, date and comments (if necessary)

6. Save

Timewill be logged against the item as well as rolling up any hours logged against the children - Providing a total for

all children and parent.

7. Entries can then be deleted

Rolling Up Logged Hours:

● Time Logged for this Item: reflects the hours logged for the item the user is viewing

● Time Summary for Current Item: totals the all hours logged for the item the user is viewing

● Time Summary for Current Item and Children: totals all hours logged for the item the user is viewing, plus totals all

the child hours



Note: Multi items and Single Assessment items will not be duplicate. Hours will only be accounted for once in the total roll

up.

Incident Logging Wizard

Via a separate link, all employees across your corporation, regardless of their status within Cloud, can access and log

cases or incidents they witness in their daily activities. Although this simple and user friendly 3 step form has been

designed to act as a complete separate entity to the end user, submissions made through the wizard will get created and

properly managed in GRC Cloud.

Incident LoggingWizard can be implemented on any item type in the system; however, it currently involves Resolver

administrators to provide a link to access the form. Please contact Resolver Customer Care for further inquiries. Client-

support@resolvergrc.com

Feature Overview:

● Provide a link to all employees to submit Cases, Events or Incidents (can be applied to any item type)

● Straightforward wizard guides the user through the submission process

● Specifically define the area of the tree to create new items

● Starting point and item type created via the wizard is fully customizable

● Multiple links can be defined to create any item type in the system at any point in the tree

mailto:Clientsupport@resolvergrc.com
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● Fully permission based process

● Add file attachments & print a copy of the results

Steps to Using Incident Logging Wizard

1. Contact Resolver Customer Care to discuss implementation

2. Login via the link provided

3. Select parent to attach item (only one can be selected)

4. Click Next

5. Assess available fields

6. Attach files

7. Click available workflow trigger(s)

8. Report overview is available

9. Create Another "Item Type" if applicable

10. Print a Copy if applicable
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Workflow: Overview

What is a workflow?

A workflow is a sequence of steps which can be repeated for an item of any given type, or subtype. Through workflows,

responsibility for working on an item can be passed between users based on their roles. At any point in a workflow, an item

is said to be in a specific state. That state defines which roles can work on the item and which criteria can be seen and

edited at that point in the workflow. Users enact triggers to change the state of the item. This change is called a transition.

As items transition from one state to another, e-mail notifications alert users that they now have to work on the item.



Transitions can also incorporate “smart” routing to different states depending on what fields have been filled out, what the

criteria values are and other factors. Transitions can also be configured to check that all relevant data has been entered

before allowing amove to another state and to save information to the item at the time of the transition.

Workflows are configured by administrators through the item template.

Administrators and other users can track the progress of tasks by checking the state they are in and workflow state can be

displayed in reports and home page dashboards.

Creating Workflows

A workflow is first created as a draft, where all the attributes of the workflow (its states, permissions, notifications, triggers,

transitions etc) are defined and can be edited. For items to be able to follow a workflow, the workflow must be published.

Once published, some limited edits are possible within a workflow. The changes allowed on published workflows are rel-

atively minor and do not affect the overall structure of the workflow, such as states, and the sequence of the states.

Workflow Map

New in 7.0 and Improved in 7.1

An extension of theWorkflow Overview page - that defines states, triggers and transitions - theWorkflow Map provides an

additional view of the workflow. This will help the administrators gain insight while building the workflow, as well as, con-

firm completion.

Feature Overview:

• Drag states around the page to customize the layout - Changes are saved in the database (7.1)

• Transition names are detailed, but can be toggled to not show names.

• Hoover over transition arms will highlight its next state.

• Full screen and print options.



Workflow: Glossary

The following is a list of terms used in the GRC Cloud workflow screens and in the documentation.

State

A State is a phase in a workflow which identifies the work to be performed. Two ormore states together compose a work-

flow and each state represents the status of the item as it progresses through the workflow. Users interact with items while

in a state and that state can be designed so that only specific user roles can interact with the item it in that state and so that

only selected fields can be viewed or changed while the items in the state. The item passes from one state to another as a

result of a transition.

Transition

A transition is themovement or path of an item from one state to another. Triggers cause transitions. A transitionmay have

optional characteristics used to define business rules related to the transition, namely conditional routing of the workflow

based on criteria values and other factors, validation that the items have been filled out appropriately prior to the transition

and the automated saving of information to an item immediately before a transition. Workflows can be automatically routed

based on business rules by combiningmultiple transitions to a state, each of which has a different condition.



Trigger

A Trigger is an action or event that initiates a transition from one state to another. A Trigger may be the clicking of a button,

passing a specified date, a predefined duration since the last transition or a changemade to a framework.

Condition

A Condition determines which path (transition) an item should follow once a trigger is executed. Conditions enable Triggers

to transition to one of several next States, based on a rule such as a criteria value (or range of values), whether files are

attached to an item and other factors.

Validation

A confirmation by the workflow engine that all necessary steps to achieve a transition have occurred; this includes, the

completion of mandatory criteria and the setting of specific values or attachment of files.

Action

An event that occurs as an item transitions out of a state, such as the setting of a criteria value, or the addition of a subtype

to an item.

Default Permissions

Default Permissions encompass both permissions for criteria and advanced permissions. Default permissions are estab-

lished for members of a role across all states of a workflow. These permissions are separate from any permissions set up

in the Role Builder (although those settings may be imported into a workflow). Workflow default permissions are only in

effect while an item is in a running workflow. Permissions can also be configured specifically for each state (see State Per-

missions). The term Permissive is used to describe different levels of permissions. For example, edit permissions aremore

permissive than read permissions and read permissions aremore permissive than no access.

State Permissions

Permissions can be configured for one or more roles at each state of a workflow. These will override the workflow’s default

permissions and permissions set in the Role Builder. State permissions also include Trigger permissions which are used to

determine which role(s) can see and click button-based triggers. The term Permissive is used to describe different levels of

permissions. For example, edit permissions aremore permissive than read permissions and read permissions aremore per-

missive than no access.

Responsible and Informed E-mail Notification Recipients

E-mail notifications may be automatically generated as a result of a transition occurring. E-mail notifications are highly con-

figurable. For eachmessage, there can be versions for two groups:

•Responsible recipients: Persons who are expected to perform some task based on the transition or state change. These

will often be a person in a role who will interact with an item in its new state.

• Informed recipients: Persons whomay not work directly with the item(s) in the workflow, but need to be aware of the

item`s current state.



Notifications can be configured to be sent to one of these groups, both or neither for each transition. Although the process

for creating notifications and the way the notifications work is the same for both groups, the ability to have two discrete

groups enables more appropriate customization of themessages.

Workflow: Creation Overview

Stages of Workflow Creation

1. Create a workflow

2. (Optional) Define default workflow permissions for each role. These can be Field permissions and
Advanced permissions

a. It is also possible to import existing roles and permissions for this item type or subtype. This will copy the

existing permissions for a given role to the workflow to provide a starting point for defining the field level per-

missions for each state. Note that this is purely a copy of the existing permissions. Subsequent changes to

the permissions defined in the role will not change the permissions for items that are in workflows or that

have workflows assigned to them.

Note:When importingmain and subtype permissions together, any conflicts, themost permissive will be

applied. Example: Name permission – read for subtype & Edit for main type = Edit permissions.

b. Create a default permission set. This will exist regardless of any existing permissions for the role and will

define a set of field permissions for that role for items within the workflow. These can then be varied by state.

3. Build out states.

These are the stages of a workflow. Note: All workflows commence with a Start state. Details can be edited, but this state

is always the starting point for any workflow design and cannot be deleted.

a. Name, instructions (to appear on screen) and color. Color affects how the state name appears in Manage

by screens, Matrix Assessor and reports.

b. Manage state order (for reporting, position in menus).

4. Add Triggers.

Triggers are the actions that execute an item’s transition from the current state to another state. Triggers typically appear

as buttons in theManage by screens and as a drop downmenu inMatrix Assessor, although dates and changes to a frame-

work can also be triggers.

a. Add the Trigger name for button-based triggers. This is the text that will appear on the button in theManage

by screens and in a drop down list in Matrix Assessor.

b. Add Instructions that are available as amouse over of the trigger in Manage by.

c. Add a transition name and identify the destination state of the transition.

d. (Optional) Design the Confirmation Statement. The confirmation statement appears before the user tran-

sitions the item from the current state to the next state. The Confirmation statement consists of a rich text



field and a two editable buttons for the confirm and reject options. The user needs to confirm the confirmation

statement in order to proceed to the next state.

5. Add or Edit transitions.

GRC Cloud can create sophisticated transitions that follow business rules and that update an item with specific infor-

mation at the time of the transition. Simple transitions consist of a name a next state and, optionally, a confirmation state-

ment.

However, it is possible to add alternative transitions to a trigger. While adding and editing transitions it is possible to:

a. Route workflows depending on values of fields in the items or other factors, by setting upmultiple possible

transitions, each with different business rules called conditions.

b. Ensure that specific fields have been filled or other requirements have beenmet before allowing an item to

transition from one state to another.

c. Set criteria values within an item at the time of a transition to record useful information such as the name of

the user working on the item and the date of the transition.

6. State Permissions

a. Add a Role

b. Determine if members of this role see items in this state in their homepageMy Tasks window.

c. For each criteria, choose specific Field Permissions for this state. The choices are Default, None, Read

and Edit. Choosing Default will apply the default permissions described earlier.

d. Choose specific Advanced Permissions for this state. The choices are Default, None and Execute. The

Execute option is equivalent to checking the appropriate advanced permission box in the Role profile. Note

that the Enable Permissions Management option relates to setting permissions for other Roles. The Roles

available are those that have already been attached to this workflow, not all roles in the system.

e. Choose Trigger Permissions for this state for each role. The available buttons to transition to another state

can be limited by Role.

7. Add E-mail Notifications

For each available transition, an e-mail notificationmay be authored. The text can be customized for users defined as

Responsible Recipients which is typically the primary role in the next state of the workflow and Informed Recipients, which

are other roles that need to know the status or be informed of the item`s progress. External users can also be configured to

receive updates.

a. Enter the text for the Responsible recipient. If any external users are responsible for the next state they

may be added in as additional responsible recipients, as external users are not members of roles.

b. Enter the text for the additional informed recipient. If any external users need to be informed they may be

added in as additional informed recipients, as external users are not members of roles.



Workflow: Creating and Editing of a Workflow

Create a Workflow

1. Navigate to Design > Item Templates > <Item Template> and click theWorkflows tab. Any existing work-

flows for this item type will be displayed as either Published or Draft.

Note:
When an itemmain type is selected, workflows that are attached to both themain type and all sub-types are

displayed under theWorkflows tab. However, if viewing an item subtype, only the workflows relating to that

sub type and themain type are displayed. Workflows relating to other subtypes are not available.

2. Click Add New to create a new workflow.

3. Enter a name for the workflow and a description (optional). Check which sub types the workflow will be

attached to. A workflow can operate on an itemmain time, a single sub type or multiple sub types, but can

not be attached to a combination of main type and sub type(s). For more information see Concepts: Man-

aging Subtypes.

4. Press Save. Themain workflow editing screen is displayed.

Editing Existing Workflows – Published and Draft

Many features of a workflow cannot be edited once it is published, as structural changes may corrupt the routing of items

and business rules associated with the workflow. Elements that may be edited in a published workflow are:

Workflow Overview:

• Can edit workflow name and description but not what sub-types it can be linked to.

States:

• Name & Instructions

• Color

• Administrator State Interaction

Triggers:

• Name & Instructions

• Confirmation Statement

Transitions:

• All condition, validation and action features

E-mail templates:



• Aggregate Template properties

• All recipient and recipient settings

Note:Administrators cannot add/delete states or triggers, or modify permissions.

Workflow: Building States

Building Workflow States

1. From within theWorkflow Editor, click the Overview tab. The default initial state, called Start State

appears.

2. Click Add State to create a new state.

3. Enter a name and (optionally) add Instructions. The instructions will appear in Manage by… screens, under

the heading State Instructions at the top of the right hand panel, to advise users as to what they are expected

to do in this state of the workflow. The text will also appear when the user runs their mouse over a state name

inMatrix Assessor.

4. Check, the following options as appropriate:

• Read only state for Administrators: Check to confirm that Administrators can view but not

interact with an item in this workflow state. This means that Administrators can neither:

i. change the values of criteria

ii. transition the item to another state

iii. edit permissions

iv. attach files

• Block Item Updates from Framework Library: Check to confirm that any changes made

to the framework versions of an item in this workflow state cannot be updated to this item (or

any instance of it) while it is in this workflow state.

5. Select a color for the state by launching the color picker. The color is used in the user interface (Manage

by… andMatrix Assessor screens) and in reporting and pie charts.

It is recommended that light colors such as white, light gray and yellow not be used as these

will not be easily visible to users in Manage by.

6. Press Save.

7. To add further states repeat the steps above. To edit an existing state, click the pencil icon next to the

state name.



8. The order in which states appear in reports and pie charts can bemanaged using the order drop-down on

the left hand side of the screen. Selecting a position in the order for one of the states will make appropriate

changes to the order of the other states.

Workflow: Setting Default Permissions

Set Default Workflow Permissions

A workflow´s default permissions define how users in one or more roles interact with an item that is in a running workflow.

Workflow default permissions can be configured to be different from the standard permissions for items of the same type

when they are not in a workflow (i.e. the permission set in the Role Builder). Permissions are further customized on a state

basis later in the workflow building process.

There are two approaches to creating the default permissions. Building the permissions within theWorkflow designer OR

importing the existing roles and permissions as designed in the Role Builder andmodifying them as needed.

Creating New Default Roles and Permissions

1. Click the Default Permissions tab.

2. Click Add Role. A list of all Roles in the system is displayed, including those which do not currently have

any permission for this item type. Check all Roles that are to have permissions for items in a workflow. Click

Save.

3. The Roles are listed in the left hand column. Select the Role whose permissions you wish to edit. As the

role is selected the current permissions are displayed in the right hand panel. They are separated into two

tabs for Field Permissions and Advanced Permissions. By default all permissions are set to None.

4. Under the Field Permissions tab use the radio button, for each available permission, to determine whether

the default permission for this role is None, Read or Edit. The Set All option in the top right corner can be

used to set all permissions to one of these three settings and then individual permissions can be edited

individually.

5. When complete click Save in the top left corner.

6. Under the Advanced Permissions tab use the radio button for each available permission to determine

whether the default permission for this role is None or Execute. In this context the word Execute indicates

that amember of this role has the ability to use this permission. The wording shown in Role Builder may be

more specific depending on the nature of the advanced permission. The Set All option in the top right corner

can be used to set all permissions to one of these three settings and then individual permissions can be

edited individually.

7. When complete click Save in the top left corner.

8. To edit permission for this Role or other Roles select the Role from the left column and repeat steps 4-7.

Importing Existing Roles and Default roles and Permissions

1. Click the Default Permissions tab.



2. Click Import Roles and Permissions. A warningmessage appears to advise that if the imported role infor-

mation has conflicting permissions themost permissive will prevail.

Example: When importingmain and subtype permissions together, any conflicts, themost permissive will be

applied. Name permission – read for subtype & Edit for main type = Edit permissions.

3. A list of all Roles in the system with permissions to this item type is displayed. Click Save.

4. The Role permissions can now be edited. The changes will apply only to items in this workflow and will not

affect the permissions set up in the Role Builder. Select the Role whose permissions you wish to edit. As the

role is selected, the imported permissions (from the role builder) are displayed in the right hand panel. Under

the Role Builder column, it details the permission set imported from the Role Builder, and by default, all

default permissions are set to the state to which they were imported into the workflow.

If the permissions were to change in the Role Builder, the Role Builder column in the Default Permissions will automatically

update to reflect that change; however, it will not modify the permissions set in the workflow. It is simple for reference.

They are separated into two tabs for Field Permissions andAdvanced Permissions.

5. Under the Field Permissions tab use the radio button for each available permission to determine whether

the default permission for this role should be edited via the None, Read or Edit. Or if the permissions set in

the Role Builder is correct, no additional permissions management is required. The Set All option in the top

right corner can be used to set all permissions to one of these three settings and then individual permissions

can be edited individually.

6. When complete click Save in the top left corner.

7. Under the Advanced Permissions tab use the radio button for each available permission to determine

whether the default permission for this role should be edited via the None or Execute. In this context the word

Execute indicates that amember of this role has the ability to use this permission. The wording shown in

Role Builder may bemore specific depending in the nature of the advanced permission. The Set All option in

the top right corner can be used to set all permissions to one of these three settings and then individual per-

missions can be edited individually.

8. When complete click Save in the top left corner.

9. To edit permission for other Roles select the Role from the left column and repeat steps 5-8.

Workflow Creating Triggers

Creating Triggers

Triggers are events that cause transitions to occur and can be of three types: Buttons, Conditional Dates and Framework

Updates. Buttons are pressed by users in a workflow tomanually transition an item from one state to another. Conditional

Dates and Framework Updates, to the end user, are perceived as system or admin updates.

Button Triggers

1. From theOverview tab click the add icon next to the state the trigger will be added.



OR

2. From theOverview tab in the workflow builder, select the state to which the button will be added by click-

ing the name of the state.

3. In the upper panel, the name of the current state is displayed in the You Are Here box. Add a trigger by

clicking the green plus icon in the Outgoing Triggers box.

4. Enter the name of the trigger. This will be the text that appears on the button. Ensure Button is the selected

trigger type.

5. Optionally, enter instructions which will appear as mouseover text when the user places themouse cursor

over the button in theManage By… screens.

6. Enter the name of the transition that this button will initiate. (The purpose of transitions and how they are

constructed is covered inmore detail later.)

7. Select the Next State form the drop downmenu.

8. If required, enter Confirmation Statement details as described below.

9. Click Save.

Confirmation Statements

Confirmation Statements are an optional component of a transition. A Confirmation Statement is a pop-up window that

appears before a transition, requiring a user to explicitly confirm information or to express an intention to continue with the

workflow.

Follow these steps to create a confirmation statement:

1. In the Add Trigger or Edit Trigger dialog, check the Should Show Confirmation statement box.

2. Enter the text of the confirmation statement. This text should be written as something that is either con-

firmed our rejected. The text field supports simple text formatting using the buttons at the top of the text edit-

ing window. A spell checker is also included.

3. If required, edit the default text for the confirmation button (“OK”) and the rejection button (“Cancel”)

4. Press Save.

Note:Confirmation statements can include hyperlinks. To include a hyperlink, paste the URL from a browser or another

document. Please note that the URLmust be pasted into the confirmation statement to insert the appropriate right-click-

able link to be displayed in the Confirmation Statement. Typing an http address will not create a link.



Framework Update Triggers

1. From theOverview tab click the add icon next to the state the trigger will be added.

OR

2. From theOverview tab in the workflow builder, select the state to which the button will be added by click-

ing the name of the state.

3. In the upper panel, the name of the current state is displayed in the You Are Here box. Add a trigger by

clicking the green plus icon in the Outgoing Triggers box.

4. Enter the name of the trigger. This will be the text that appears on the button. Ensure Framework Update is

the selected trigger type.

5. Enter the name of the transition that this button will initiate. (The purpose of transitions and how they are

constructed is covered inmore detail later.)

6. Select the Next State form the drop downmenu.

7. Click Save.

Conditional Date Triggers

Note: Conditional Date Triggers are executed on a daily frequency

1. From theOverview tab click the add icon next to the state the trigger will be added.

OR

2. From theOverview tab in the workflow builder, select the state to which the button will be added by click-

ing the name of the state.

3. In the upper panel, the name of the current state is displayed in the You Are Here box. Add a trigger by

clicking the green plus icon in the Outgoing Triggers box.

4. Enter the name of the trigger. This will be the text that appears on the button. Ensure Conditional Date is

the selected trigger type.

5. Enter the name of the transition that this button will initiate. (The purpose of transitions and how they are

constructed is covered inmore detail later.)

6. Select the Next State from the drop downmenu.

7. Click Save.

9. Conditions can then be added to the trigger.

Note: These conditions act as a primary check to see if the trigger should execute, if they pass then it will

continue to transition. If it fails, the trigger is not executed. In order to create these conditions on the trigger,

the trigger must first be saved and reopened.

9. Add a date condition (or any other type of condition) to the trigger.



10. Createmultiple the types of condition that will be checked against today’s the selected frequency.

a. A list of dates

b. Criteria to be checked for completeness

c. Criteria to be checked for certain values or ranges of values

d. Whether a file is attached

Note:Details of how to create conditions are discussed fully in the section Adding Conditions to a Transition.

11. Click Save.

Other details regarding date triggers

• Each state can have only one conditional date trigger attached to it to avoid contradictory

logic being placed on a state.

• Any transition and state change caused by a date trigger will be recorded in the Audit Trail and

Change Log. The user name attached to the change will be displayed as "Automated".

Editing an Existing Trigger

To edit a trigger that has already been created, click on the pencil edit icon next to its name in the top panel in theWorkflow

Builder. Then follow the steps for creating Button Triggers and Confirmation Statements. Not all fields are editable once a

trigger has been created. Once the trigger is created, all the transition information (Transition Name, Next State, Con-

firmation Statement) is moved to the transition and can be edit via the edit transition pop up. (See Editing Transitions sec-

tion)

Workflow: Working with Transitions

Understanding Transitions

Although a transition is often just the simple passing of an item from one state to another, GRC Cloud can createmore

sophisticated transitions that follow business rules and that update an item with specific information at the time of the tran-

sition.

As stated in the section on creating triggers, the transition is created when defining a trigger. The transition consists of a

name (which although not seen by users is important for the administrator building the workflow) a next state and, option-

ally, a transition statement.

It is possible to edit the transition created with the trigger and add alternative transitions to a trigger.

While adding and editing transitions it is possible to:

• Route workflows depending on values of fields in the items or other factors, by setting upmultiple possible

transitions, each with different business rules called conditions. See "Workflow: Adding Conditions" on page

151



• Ensure that specific fields have been filled or other requirements have beenmet before allowing an item to

transition from one state to another. See "Workflow: Adding Validations" on page 156

• Set values of criteria within an item at the time of a transition to record useful information such as the name

of the user working on the item and the date of the transition.See "Workflow: Adding Actions" on page 161

Editing an Existing Transition

Transitions are automatically created when triggers are created. Some pertinent information entered when creating a trigger

is populated into the transition dialog box when editing the transition.

1. On the State Editor screen, click the blue and green transition icon in the Outgoing States box adjacent to

the name of the outgoing state identified when defining the trigger.

2. On the Transition screen click the edit pencil icon in the top right corner.

3. The name of the transition and the next state, which were defined when the trigger was created, are dis-

played in the dialog box andmay be edited.

4. Click Save.

Adding Additional Transitions to a Trigger

1. On the State Editor screen, click the green plus icon adjacent to the name of the appropriate outgoing

trigger.

2. Enter a name for the transition and identify the Next State that the transition will route to.

3. Optionally add a confirmation statement if needed. (Confirmation Statements are described inmore detail

in Adding Triggers.)

4. Click Save.

Managing the order of transitions

Transitions are checked in a specific order. This priority is set as follows.

1. In the State Editor screen, transitions are not displayed, but the Outgoing States of a transition are dis-

played.



Workflow: Adding Conditions

Adding Conditions to a Transition

The workflow engine uses two different types of conditions:

Check Value

Compares the value of a criteria or of a function result with the condition. Also compares

today’s date with a list of predefined dates. If the valuemeets the condition then the transition

will be allowed (assuming validations are alsomet).

Check values can be run only on the following criteria types:

Radio Buttons & Drop Down Lists: The value in the criteria can be

- The same as a specified value

- Different from a specified value

- Greater than a specified value

- Greater than or equal to specified value

- Less than a specified value

- Less than or equal to a specified value

Date fields:Compares the date the transition is occurring (i.e. today’s date) with

a date criteria on the item.

The condition can be set so that the transition date is:

- The same as the date in the criteria

- Different from the date in the criteria

- Greater than a fixed number of days before the date in the criteria



- Greater than or equal to a fixed number of days before the date in

the criteria

- Less than a fixed number of days before the date in the criteria

- Less than or equal to a fixed number of days before the date in

the criteria

- Greater than a fixed number of days after the date in the criteria

- Greater than or equal to a fixed number of days after the date in

the criteria

- Less than a fixed number of days after the date in the criteria

- Less than or equal to a fixed number of days after the date in the

criteria

Scheduled dates:when a trigger executes, instead of comparing today’s date

with a criteria, it compares today’s date with a predefined list of dates.

If today’s datematches one of the listed dates for the transition, the transition

will proceed (assuming other conditions aremet and validations are passed).

Functions:Check values can also be run on function results. The condition can

be set so that the value of the function result can be

- The same as a specified value

- Different from a specified value

- Greater than a specified value

- Greater than or equal to specified value

- Less than a specified value

- Less than or equal to a specified value

Note: Invalid or not calculated functions fail the condition.

Child Items (Self): Check to determine whether a certain item type exists

below that item being transitioned.

- At least 1 item exists below the item being transitionedmatches



the defined item type selected.

- If it does have that item type, the condition / validation passes

and the item continues down the transition.

- If it does not have that item type, the condition is not met and con-

tinues to the next condition

- If validation fails, the transition is canceled and user is notified

the item could not be transitioned.

Child Items (Ancestor):Check the ancestor(s) of an item on transition of the

workflow to determine whether a certain item type exists below the specified

ancestor

- Cascades the tree above searching for the first item found that

matches the defined item type.

- Once it finds that item type, it will check to see if at least 1 item

exists below it that matches the defined item type selected.

- Checks there is at least 1 item of that type below.

- If it does, the condition / validation passes and the item continues

down the transition

- If it does not, the condition is not met and continues to the next

condition.

- If validation fails, the transition is canceled and user notified item

could not be transitioned.

Additional Child Item Notes:

- It will check both trees

i. If transition executed in the Scoping tree, but the

item searching for is not linked, but is in MBL, it will

recognize it as attached.

ii. If running the transition on the Scoping tree and

going to look for a risk, and that risk is not linked, but

the folder is, it will not pass successfully.

- When set onmain type (looking for a step) the transition will pass

if child it's looking for exists and is main or sub type.



- Self condition for Scoping tree items does not contain locations

as an option. Nor do applications have Scoping as an item.

Workflow States for Item Type (7.1)

- On transition of an item, it can cascade either direction of the tree

and check for an item type that is in a specific workflow state.

Example: Prior to signing-off on a process, audit or

other item verify that all descendants are in their

signed-off state.

- It applies to Siblings, Parent, Children, Descendants and Ances-

tors

- If the item defined in the condition does not exist in the tree, it will

pass the condition. To identify if an item exists in the tree, a Child

Item condition/validation can be set up to accommodate this (see

above).

Has Value

Simply checks to ensure that:

- Any value exists for one or more specified criteria (any criteria type)

- Any value exists for a one or more function results (i.e. it is neither invalid nor

not calculated)

- The item is a specific item sub type.

- A user in one or more specific roles is attached to the item

- At least one file is attached to the item

Steps to Adding/Editing Conditions

1. To edit a transition, click the transition icon in the Outgoing States box in the state editor

screen. The transition name, which was created when the related trigger was defined, appears

at the top of the screen.

2. Click the Conditions tab.



3. Click the green plus icon labeled Condition and select either a Check Value condition or Has

Value condition.

4. For a Check Value condition, enter the name of the Condition (this is not displayed to users

but is an identifier for the Administrator designing the workflow) and select the condition type

(criteria, function or scheduled date).

5. Select the specific criteria or function result to be compared to the condition: condition type

(greater than, less than, equal to etc.) and the value the criteria or function result will be com-

pared to) For date criteria there is a field to enter a number of days and a Before/After field. For

scheduled date, enter one or more dates to be compared with today’s date.

6. For a Has Value condition, enter the name of the Condition (this is not displayed to users but

is an identifier for the Administrator designing the workflow)

7. For each condition type except file (i.e. criteria, function, subtype, file or role), select the con-

dition type from the drop downmenu and click the radio buttons for the appropriate fields. For

the file condition there are no check boxes as the condition simply checks that there is a file

attached to the item. All choices are combined into the one condition.

8. Click Save.

9. More than one condition can be attached to a transition. In order for the transition to occur, all

conditions must be passed. To add further conditions repeat steps 3-8 as appropriate.

10. To edit a condition, click the pencil icon adjacent to the Condition name. There are lim-

itations as to what can be changed while editing and it may be necessary to delete a condition

and create a new one.

Setting up a Child Item Condition

1. Same 1-4 steps as above

2. Select an item type from: Define Type of Check

- Self: checks items directly below the item being transitioned

- Ancestor: cascades up and checks below the item defined

3. For Self: select the item to exist from theDefine Item Type to Confirm Existence drop down

3b. Save

4. For Ancestor: select an item type to cascade up the tree from theDefine Ancestor to Check

Below drop down

5. For Ancestor: select the item type to exist from the Define Item Type to Confirm Existence

drop down

6. Save



Setting up a Workflow States for Item Type Condition (7.1)

1. Same 1-4 steps as above

2. Select an item type from: Define Type of Check: Ancestors / Parent / Siblings / Children /

Descendants

3. Define Item Type to check: this is the item the condition will look for and determine it's state

4. Define the State Name: this must come from the list of states associated with the workflow

attached to the item type above

5. Save

Workflow: Adding Validations

Adding Validations to a Transition

The workflow engine uses two different types of validations.

Check Value

Compares the value of a criteria or of a function result with the validation. If the value passes

the validation then the transition will be allowed.

Check values can be run only on the following criteria types:

Radio Buttons & Drop Down Lists: The value in the criteria can be

- The same as a specified value

- Different from a specified value

- Greater than a specified value

- Greater than or equal to specified value

- Less than a specified value

- Less than or equal to a specified value

Date fields:Compares the date the transition is occurring (i.e. today’s date) with

a date criteria on the item.

The validation can be set so that the transition date is:

- The same as the date in the criteria



- Different from the date in the criteria

- Greater than a fixed number of days before the date in the criteria

- Greater than or equal to a fixed number of days before the date in

the criteria

- Less than a fixed number of days before the date in the criteria

- Less than or equal to a fixed number of days before the date in

the criteria

- Greater than a fixed number of days after the date in the criteria

- Greater than or equal to a fixed number of days after the date in

the criteria

- Less than a fixed number of days after the date in the criteria

- Less than or equal to a fixed number of days after the date in the

criteria

Scheduled dates:when a trigger executes, instead of comparing today’s date

with a criteria, it compares today’s date with a predefined list of dates.

If today’s datematches one of the listed dates for the transition, the transition

will proceed (assuming other conditions aremet and validations are passed).

Functions:Check values can also be run on function results. The condition can

be set so that the value of the function result can be

- The same as a specified value

- Different from a specified value

- Greater than a specified value

- Greater than or equal to specified value

- Less than a specified value

- Less than or equal to a specified value

Note: Invalid or not calculated functions fail the validation.

Child Items (Self): Check to determine whether a certain item type exists

below that item being transitioned.

- At least 1 item exists below the item being transitionedmatches



the defined item type selected.

- If it does have that item type, the condition / validation passes

and the item continues down the transition.

- If it does not have that item type, the condition is not met and con-

tinues to the next condition

- If validation fails, the transition is canceled and user is notified

the item could not be transitioned.

Child Items (Ancestor):Check the ancestor(s) of an item on transition of the

workflow to determine whether a certain item type exists below the specified

ancestor

- Cascades the tree above searching for the first item found that

matches the defined item type.

- Once it finds that item type, it will check to see if at least 1 item

exists below it that matches the defined item type selected.

- Checks there is at least 1 item of that type below.

- If it does, the condition / validation passes and the item continues

down the transition

- If it does not, the condition is not met and continues to the next

condition.

- If validation fails, the transition is canceled and user notified item

could not be transitioned.

Additional Child Item Notes:

- It will check both trees

i. If transition executed in the Scoping tree, but the

item searching for is not linked, but is in MBL, it will

recognize it as attached.

ii. If running the transition on the Scoping tree and

going to look for a risk, and that risk is not linked, but

the folder is, it will not pass successfully.

- When set onmain type (looking for a step) the transition will pass

if child it's looking for exists and is main or sub type.



- Self condition for Scoping tree items does not contain locations

as an option. Nor do applications have Scoping as an item.

Workflow States for Item Type (7.1)

- On transition of an item, it can cascade either direction of the tree

and check for an item type that is in a specific workflow state.

Example: Prior to signing-off on a process, audit or

other item verify that all descendants are in their

signed-off state.

- It applies to Siblings, Parent, Children, Descendants and Ances-

tors

- If the item defined in the validation does not exist in the tree, it

will pass the condition. To identify if an item exists in the tree, a

Child Item condition/validation can be set up to accommodate this

(see above).

Has Value

Simply checks to ensure that:

- Any value exists for one or more specified criteria (any criteria type)

- Any value exists for one or more function results (i.e. it is neither invalid nor not

calculated)

- The item is a specific item sub type.

- A user in one or more specific roles is attached to the item

- At least one file is attached to the item

Steps to Adding/Editing Validations

1. To edit a transition, click the transition icon in the Outgoing States box in the state editor

screen. The transition name, which was created when the related trigger was defined, appears

at the top of the screen.

2. Click the Validations tab.

3. Click the green plus icon labeled Validation and select either a Check Value validation or

Has Value condition.



4. For a Check Value validation, enter the name of the validation (this is not displayed to users

but is an identifier for the Administrator designing the workflow) and select the validation type

(criteria, function or scheduled date).

5. Select the specific criteria or function result to be compared to the validation, the validation

type (greater than, less than, equal to etc. and the value the criteria or function result will be

compared to.) For date criteria there is a field to enter a number of days and a Before/After field.

For scheduled date, enter one or more dates to be compared with today’s date. For a Has

Value validation, enter the name of the validation (this is not displayed to users but is an iden-

tifier for the Administrator designing the workflow)

6. For each validation type except file (i.e. criteria, function, subtype, file or role), select the val-

idation type from the drop downmenu and click the radio buttons for the appropriate fields. For

the file validation there are no check boxes as the validation simply checks that there is a file

attached to the item. All choices are combined into the one validation.

7. Click Save.

8. More than one validation can be attached to a transition. In order for the transition to occur,

all validations must be passed. To add further validations repeat steps 3-8 as appropriate.

9. To edit a validation, click the pencil icon adjacent to the validation name. There are lim-

itations as to what can be changed while editing and it may be necessary to delete a validation

and create a new one.

New in 7.0 Setting up a Child Item Condition

1. Same 1-4 steps as above

2. Select an item type from: Define Type of Check

- Self: checks items directly below the item being transitioned

- Ancestor: cascades up and checks below the item defined

3. For Self: select the item to exist from theDefine Item Type to Confirm Existence drop down

3b. Save

4. For Ancestor: select an item type to cascade up the tree from theDefine Ancestor to Check

Below drop down

5. For Ancestor: select the item type to exist from the Define Item Type to Confirm Existence

drop down

6. Save

New in 7.1 Setting up a Workflow States for Item Type Validation

1. Same 1-4 steps as above



2. Select an item type from: Define Type of Check: Ancestors / Parent / Siblings / Children /

Descendants

3. Define Item Type to check: this is the item the validation will look for and determine it's state

4. Define the State Name: this must come from the list of states associated with the workflow

attached to the item type above

5. Save

Workflow: Adding Actions

Adding Actions to a Transition

1. To edit a transition, click the transition icon in the Outgoing States box in the state editor screen. The tran-

sition name, which was created when the related trigger was defined, appears at the top of the screen.

2. Click the Actions tab.

3. Click the green plus icon labeled Action.

4. Enter the name of the action (this is not displayed to users but is an identifier for the Administrator design-

ing the workflow) and select the action type (Criteria, Subtypes, Child Item, Calculate Functions, Add Role

Membership, Clear Criteria Values (7.0)

5. For a criteria, select the specific criteria to be set.

- For drop downmenus and radio buttons, select the value to be set.

- For date fields, select either today’s date or a date before or after today’s date to be set, enter-

ing the number of days before or after.

- For the user picker, the user who effected the transition will be entered into the item. This

option is not configurable.

- For functions, select the function(s) you would like calculate after the transition.

- For Child Item, select the type of child item to be created and define the naming convention.

Note: If selecting Name and Tag, it will be truncated if it exceeds 80 characters when the item

is next saved .

Ability to create Location and Scoping Items (now applies to all non framework items in the sys-

tem)

- Add RoleMembership: adds the current user (user transitioning the item) to the permission

tab; allowing for quick, on the fly reassignment of permissions. Administrators will define the



role the user is added to when creating the action. Applies to single andmulti user pickers.

(8.0)

6.Set a subtype: select one subtype to be added to the item. Only subtypes that the workflow is attached to

are available in this feature.

7. Remove a subtype

a. When creating an action for a transition:

i. The options available are the sub types associated to the workflow.

Ex1: if running on aMain Type > showw all sub types

Ex2: if running on specific sub types > show only those applicable sub types.

b. On Transition

i. Removes the associated sub type.

ii. IMPORTANT: if this breaks the workflow (removes all applicable sub types) it

will proceed to the next state, but not remove all subtypes. Onemust remain. It

this occurs, it's amisconfiguration.

iii. If additional actions are set that apply to the removed or added subtypes >

they will be ignored.

7. For Clear Criteria Value, select as many criteria applicable to be cleared. (Change log will be updated with

"AutomatedWorkflow" as the user that cleared the criteria.) (7.0)

8. Click Save.

Workflow: Transitioning Workflow States - Combining Con-
ditions/Validations/Actions

Understanding the Processing of Conditions, Validations and Actions within Tran-
sitions

Wheremultiple transitions are attached to a trigger, they are handled in a prescribed order as discussed in

Adding Transitions.

The elements of a transition are processed in the order: Condition (including confirmation statement where

appropriate), Validation, Action. Any combination of single or multiple conditions, validations and actions can

be combined in a transition, but all must pass. Only after the completion of these is the item successfully tran-

sitioned to the next state.

Conditions

After the trigger has been executed, the workflow checks the conditions attached to the first transition. If the



conditions aremet (and any confirmation statement has been accepted), the workflow checks all the val-

idations. If the conditions are not met, the workflow will attempt the next transition. If there are nomore tran-

sitions, the user will be informed that the item could not be transitioned. However, if no transitions are

possible due to conditions this would normally indicate that the transitions and conditions have been poorly

constructed.

Validations

The workflow checks all validations. If all validations pass, then actions occur. If not, the user is advised that

the item is incomplete for transition to the next state. The user can addmissing values or change existing

values as appropriate and re-execute the trigger. The workflow will not attempt another transition due to a

missing/failed validation.

Actions

Actions occur on a transition only after all conditions and validations have been passed.

Successful Transition

The successful transition occurs immediately after the actions are completed. Any e-mail notifications are

also sent at this time (see Creating Email Notifications).

Ensuring all Necessary Information is in Place for a Transition to Take Place
using Validations.

Validations are used to ensure that the appropriate information has been entered into or attached to an item

so that it is ready to transition to the next state of the workflow. Validations are checked only after a transition

has passed any conditions that may be attached.

Validations ensure that all fields that are required to be completed in a given workflow state have been com-

pleted. It can also ensure that an appropriate value has been entered into the item before allowing a transition

to take place, that the item has a file attached, or that it is of a certain sub-type and has a user assigned to it

in a specific role. The transition to the next state can only take place if the item passes this validation.

Example 1: If there is a trigger button called “Escalate Issue” a validation could check field

values (such as the value of a radio button or a date field) to ensure the information recorded

supported the need to escalate the issue.

Example 2: It may be necessary to attach a file to transition an item to the next state. A val-

idation can be used to check that a file is attached.

Note:Validations can be attached only to transitions executed through button triggers. Validations cannot be

attached to date triggers and framework update triggers.

Capturing Information at the Time of a Transition using Actions.

The Actions feature is a powerful element of transitions enabling a change to bemade automatically to an



item at the time of the transition. (The change is made to the item the user is transitioning from, rather than

the item being transitioned to.)

An action can be used to:

-Set a criteria value for the following types:

o Drop-down

oRadio button

o Date

o User picker

o Note: It cannot update text fields, numerical fields or check boxes

-Add a new subtype to the item. Note that subtypes may be added, but not removed.

-Calculating Functions. Update function values after transition of the item.

- Creating a Child Item. Create a defined child item after the transition of an item.

Actions are useful for:

- Setting a specific value within an item that has not been set by a user, such as a priority rank-

ing or categorization of an item where that categorization is related to the transition and the

workflow path being taken.

- Recording either the date an item was transitioned or a related date for a follow-up or other pur-

pose

- Recording the name of the user who worked on an item in this state and effected the tran-

sition.

- Changing the nature of an item by changing its sub-type. (Either adding a sub type to an item

without a current sub type or adding additional sub types to items that already have one or

more sub-types.) This changemay expose different fields for completion, commence a work-

flow dedicated to that sub-type and enable the item to be categorized differently in reports fil-

tered by sub-type.

- Calculating the functions of a item to ensure the values are up to date in the system for report-

ing and users interacting with the item in the next state.

- Create a child item on successful transition of an item, the action will create a child item

based off the assessments (or routing) of the item. Administrators will create the action for a

specific transition and define which non-framework item type will be created

Managing the Workflow Using Multiple Transitions and Conditions.

Havingmultiple transitions attached to a trigger enables business rules, called conditions, to be attached to



each transition and used to route the workflow based on the definition of that condition, based on information

entered into the item.

Conditions can either check that a value exists or that the value is a specific value or a range of values.

When the trigger is executed (i.e. the button is pressed or the date trigger or framework trigger is executed)

the workflow engine will try to complete the first transition in the list. To do this, it checks the conditions in

the transition. If the itemmeets all the conditions then the transition will occur (unless it has to run through val-

idations which are discussed later). If any one of the conditions is not met, then the transition will not occur

and the workflow engine will attempt to process the second condition, and so on.

To facilitate this, transitions are attached to a trigger in a prescribed order.

Example:

In a compliance department, breaches are investigated differently based on the severity of the

breach.

There is one trigger button called “Investigate” in a workflow state. However the next state in

the workflow is determined by how a field called “Severity of Breach” is answered. The pos-

sible values of this field, which appears as a drop downmenu, are:

• Critical (4)

• Severe (3)

• Moderate (2)

• Minor (1)

Critical and Severe issues are routed to the Director of Compliance, whereas other items are

handled by junior compliance officers.

Two transitions can be attached to the “Investigate” button trigger, each with a different con-

dition and a different next state. The first transition, called “High Priority” features a condition

that states that if the “Severity of Breach” field has a value of 3 or greater, then it should be

routed to an urgent review state, which is handled by the Director of Compliance. The second

transition, called “Regular Priority” features a condition that if the value is 2 or lower it is routed

to a regular review state, handled by the compliance office. In addition, the second transition

could feature a confirmation statement where the user declares that they have reviewed all per-

tinent information and determined that the issue is not a high priority.

When the trigger button is clicked, the workflow engine runs the conditions on the first tran-

sition. If for example the value in the field was 2/Moderate, the item would fail the condition and

therefore the transition would not take place. It would however pass the second condition and

would display the Confirmation Statement for the 2nd transition. When the user clicks OK, it

would transition to the state identified in the Regular Priority transition.



Identifying Failed Validations (7.1)

When transitioning an item, validations may be in place to ensure all work is completed before the transition completes and

moves to the next state. Failed transitions are now identified to the user in Editable Reports andMange by areas of the

application (Matrix Assessor not supported).

If a transitions fails due to validations, users will see themessages below. Note: Pop upmessage in the Editable Reports

does not have to be closed. It can remain up as the user addresses the failed validations.

Editable Reports:

Manage by:



Workflow: Defining State Permissions

Steps to Defining State Permissions

Although default permissions for items within a workflow are typically set up at the start of the workflow creation process,

permissions can be further refined so that only users who aremembers of specific roles have read or edit permissions for

specific criteria and access to advanced permissions in a particular state. This ensures that only the correct users can

work with items in a specific workflow state.

1. Navigate to the state whose permissions are to be edited in theWorkflow Overview screen. The state

editor screen will appear with the name of the State in the blue horizontal bar at the top of the screen. (The

name of the state being edited also appears in the You Are Here box.)

2. Click the Field Permissions tab.

3. Click Add Role. A list of all Roles in the system is displayed, including those which do not currently have

any permission for this item type. Check all Roles that are to have permissions for items in a workflow. Click

Save.

4. The Roles are listed in the left hand column. Select the Role whose permissions you wish to edit. As the

role is selected the current permissions are displayed in the right hand panel. They are separated into three

tabs for Field Permissions, Advanced Permissions and Trigger Permissions.

5. Use the Items Appear in My Tasks drop-downmenu to determine whether items in this state should

appear in theMy Tasks table on a user’s home page. When this is set to Yes any items in this state will be

shown as requiring attention by a user with permission for this item when he or she logs into GRC Cloud.

6. Under the Field Permissions tab use the radio button for each available permission to determine whether

the state permission for this role is None, Read, Edit or Default. Unless edited, the setting for each field is

Default, whichmeans that the permission level in the default permissions will apply in this state. The Set All

option in the top right corner can be used to set all permissions to one of these four settings and then field per-

missions can be edited individually.

7. When complete click Save in the top left corner.

8. Under the Advanced Permissions tab use the radio button for each available permission to determine

whether the state permission for this role is None, Execute or Default. In this context the word Execute indi-

cates that amember of this role has the ability to use this permission. The wording shown in Role Builder

may bemore specific depending in the nature of the advanced permission. Unless edited, the setting for

each field is Default, whichmeans that the permission level in the default permissions will apply in this state.

The Set All option in the top right corner can be used to set all permissions to one of these three settings and

then permissions can be edited individually.

9. When complete click Save in the top left corner.

10. Under the Trigger Permissions tab use the radio button for each trigger button to determine whether users

in this role can see and click the trigger buttons to transition the item. All the button triggers for the current

state appear in the list. The available trigger permissions are None or Execute. In this context the word



Execute indicates that amember of this role has the ability to see and click the button. Unless edited the set-

ting for each field is None. The Set All option in the top right corner can be used to set all trigger permissions

to one of these settings and then trigger permissions can be edited individually.

11. To edit state permissions for this Role or other Roles, select the Role from the left column and repeat

steps 4-10. Roles that have been assigned to a workflow state are viewable in the workflow overview

screen.

Workflow: Creating E-mail Notifications

Steps to Creating E-Mail Notifications

Part A: Building Workflow Templates

Templates are new in the 8.0 version and allow administrators design a specific template for each transition

in the workflow. An unlimited number of templates can be created.

1. From the workflow overview screen, click the Email Templates tab.

2. By Default, 3 templates will be listed (Responsible / Informed / Immediate).

3. Click on the template tomodify the details or add a new template by clicking on the Add Tem-

plate drop down (3 types can be added).

4. Name or rename the template.

5. Determine the frequency of the emails to be sent.

6. Modify the header name. The workflow namewill be inserted by default. The header name

acts as the introduction to that template (see below).



7. Add in an Email body (if applicable): this is a brief description to why the user is receiving the

email and what tasks are associated with the items sent.

8. Define theColumns to Display (8.0): select from the 3 drop downs (Workflow Attributes /

Criteria / Functions) what information will be displayed in the email. Note: Spreadsheet criteria

is not supported.

9. Order criteria, functions, and workflow attributes. Do this by dragging and dropping the high-

lighted arrows seen in the image below.

10. Save

Note: Function and criteria values in the email are based off the value in the database at the

time the email is sent.

Part B: Associating templates to each possible transition

Now that the templates are created, they can be associated to the transition and complete the notifications

for that transition.

1. From the workflow overview screen, click the Email Notifications tab.

2. All the possible transitions within the workflow are automatically listed in the format “(Initial)

State Name > Trigger (Button Text) > Transition Name > (New) State Name”.

3. To author the e-mail transition templates for a specific transition, click the pencil Edit icon for

that transition change.

4. Select the relevant type of email (responsible / informed / immediate) from the tabs.

5. Define the Email template (the types of templates available will match type (tab) selected).



5. Select the Role(s) who will receive the Responsible Recipients message from the role drop-

downmenu. Only roles associated with the workflow are shown.

5. Add any additional external users who should receive the Responsible Recipients mes-

sages. The user picker menu will display only external users.

6. Write the text of the Responsible Recipients message. This message will appear in the tran-

sitionmessage field of the email table (see below) in the finishedmessage.

7. Select the Role(s) who will receive the Informed Recipients message from the role drop

downmenu. Only roles associated with the workflow are shown.

8. Add any additional external users who should receive the Informed Recipients messages.

The user picker menu will display only external users.

9. Write the text of the Informed Recipients message. This message will appear in the tran-

sitionmessage field of the email table (see below) in the finishedmessage.

10. Select a report to be sent to the user for the transition. (7.0)

a. Users loading the report via email must have live report access granted.

Note: if a user does not have access previously granted via the live report, it will auto-

matically grant access to it when the user clicks the report and enters the system.

b. It will remove the default link to assess items in theMatrix Assessor.



c. If an aggregate email has multiple transitions for the same item type, multiple links will

be available in the email. Each transition that has a report link defined will be available

to the user.

d. Administrators will have access to all Item Overview and Hierarchical reports they have

permission to.

e. Clicking in the link will always load the report, not the report builder

11. Press Save.

12. The number of Responsible and Informed Recipients will be updated on the Email Noti-

fication tab.

Part C: Add Aggregate Email Template message

This message will appear immediately before a table indicating the details for all recently occur-

ring transitions in a workflow.

1. From the workflow overview screen, click the Email Notifications tab.

2. To author the aggregate e-mail template, click the Edit Aggregate Email pencil icon.

3. Determine the aggregate e-mail notifications content for responsible recipients and/or

informed recipients by working on the appropriate tab. The following instructions refer to either

tab.

4. Determine the frequency of themessage, ranging from every 4 hours tomonthly.

5. Write the email body for the notification

6. Press Save.

Important Information about Aggregated Email Notifications

In any GRC Cloud site theremay be workflows running onmultiple item types and therefore a user may receive noti-

fications about multiple workflows. The e-mail message generated is aggregated across all workflows.

The frequency for notifications may be set differently for different workflows. In this case, e-mail notifications will be sent at

all times determined in each workflow’s notifications schedule, but will contain information for all workflows and the infor-

mation displayed for each workflow reflects what has occurred since themost recent e-mail notification only.

Example:

There are three workflows configured with email notification frequencies of nightly, 8 hours and 12 hours,



with e-mails scheduled as follows:

• Workflow A: Assume the nightly e-mail is generated at 12:01am

• Workflow B: Assume the 8 hour e-mails are generated at 12:01am,8:01am and 4:01pm

• Workflow C: Assume the 12 hour e-mails are generated at 12:01am and 12:01pm.

Assume these are all new workflows that have been initiated sometime betweenmidnight and 8am on the

first day.

GRC Cloud will check every 4 hours to determine whether an e-mail notification should be sent (because 4

hours I themost frequent possible schedule for generating e-mail notifications.)

For each workflow, information is only displayed if there has been activity since the last scheduled e-mail.

Details on earlier transitions are not included (i.e. there is no “reminder” that items are ready to be handled, if

the user has been informed previously). If there has been no activity in any workflow since the last e-mail, no

notification is sent.

NOTE 1: Times used are for example purposes only and do not reflect the actual times emails will

be sent.

NOTE 2: Function and criteria values in the email are based off the value in the database at the time

the email is sent.

Workflow: Immediate Emails

Upon transition of an item, an email can now be sent immediately to notify the individual(s) responsible in the next state of

the workflow in real time. Administrators have the capability, via an enhanced email setup design, to determine:

a. The specific users receiving the email

b. Define a separatemore urgent message

c. Select columns to display (including: criteria, functions and workflow attributes)

d. Define Email properties specific for the immediate email

e. Definemultiple templates for each immediate email per transition

Part A: Building Workflow Templates

Templates are new in the 8.0 version and allow administrators design a specific template for each transition in the work-

flow. An unlimited number of templates can be created.



1. From the workflow overview screen, click the Email Templates tab.

2. By Default, 3 templates will be listed (Responsible / Informed / Immediate).

3. Click on the Immediate template tomodify the details or add a new template by clicking on the Add Template drop

down.

4. Name or rename the template.

5. Name or rename the header name. The workflow namewill be inserted by default. The header name acts as the

introduction to that template (see below).

6. Add in an Email body (if applicable): this is a brief description to why the user is receiving the email and what tasks

are associated with the item being sent.

7. Define theColumns to Display (8.0): select from the 3 drop downs (Workflow Attributes / Criteria / Functions)

what information will be displayed in the email. Note: Spreadsheet criteria is not supported.



8. Order criteria, functions, and workflow attributes. Do this by dragging and dropping the highlighted arrows seen in

the image below.

9. Save

Steps to Creating an Immediate Email

1. From theWorkflow Designer > Email Notifications Tab

2. Per transition, click on the blue pencil

3. Select the Immediate Email tab

4. Define the Email template (the types of templates available will match type (tab) selected)

5. Option to customize the Email Subject

6. Select the roles for Immediate Recipients

7. Select any additional roles that would need to receive the email

8. Provide a transitions message, if applicable, that will be inserted into the email table

9. :Select a report to be sent to the user for the transition

Note: administrators will have access to all Item Overview and Hierarchical reports they have permission to.

10. Save > Immediate Columnwill be updated on the Email Notification tab with the number of roles receiving the email

Customizing Immediate Emails (7.1)

Immediate emails enable administrators to completely customize the contents that the end user receives. Administrators

can get more information out to their users and possibly reduce the amount of times the user needs to login to complete

quick trivial tasks. Input additional information into the email: Trigger Names, Criteria Values, Function Values, plus all

other information that is available in the workflow table.



Steps to Customizing an Email Body

1. From theWorkflow Designer > Email Notifications Tab

2. Click the pencil icon

3. Select the Immediate Email tab

4. Within theMessage Body Text rich text editor, input any text and formatting required

5. To reference the elements of the item and attributes of the workflow input the below tags where they lie in the text

6. The tags will reference the value of each element (example: T=>TriggerNamewill input the name of the trigger only).

7. Each tag requires two percentage symbols around the tag (Example: %%Tag Reference%% )

8. New Tag Options:
a. T=>TriggerName:Inserts the trigger name into the email. Link is active and behaves like an internal trigger.

Example: %%T=>Submit for Review%%

b. C=>ItemType=>CriteriaName: Inserts the value of the criteria reference in the tag into the email. Example:

%%C=>Risk=>Residual Impact%%

Note: All criteria are supported; however, some rich text formatting is stripped from Rich Text Editor and

Spreadsheet criteria.

c. F=>FunctionName: Inserts the function value and label into the email. Example: %%F=>Residual Risk%%

The remaining tags existed in the previous version of Cloud via the Email Table. Administrators have the option to

disable the table in the immediate email if they would prefer to add the information in via the tags below. All tags get

formatted with the%%TagReference%% as described above.

a. ActionTaken

b. ActionTakenOn

c. ByUser

d. CurrentState

e. InformedUsers

f. ItemName

g. ItemType

h. PreviousState

i. ResponsibleUsers

j. UsersNotified



k. StateMessage

l. ItemNumber

9. To disable the table, go to theWorkflow Designer > Email Notifications Tab

10. Click theEdit Email Templates

11. Deselect the option to: Include a table containing the properties below

Formore information See "Workflow: Creating E-mail Notifications" on page 168

Linking Workflows

Working together as one! The first phase of linking workflows introduces the concept of sending and receiving events from

one workflow to another. On completion of a workflow transition an action can be created to send out a 'message/event' for

all workflows to receive and trigger a transition in the workflow.

Example 1: An audit, although not complete, has been flagged as closed at the audit project level; however, tests and con-

trols remain open. Once the Audit has been closed, amessage will be sent to all the children below to go to a closed state.

Example 2: Users can close an Issue and automatically close any Action Items attached to that issue.

Example 3: Signing off on a Process will trigger all Controls to go to a signed off state.

Building Linked Workflows

Creating Linked workflows is a two step process as one workflow needs to send an event while the other receives and

engages. An action can be created on the transition of an item to throw an event to all other workflow in the system. In the

below steps wewill detail Example #2 noted above.

Creating the ACTION that Sends the Event

1. Access the workflow that will be sending themessage: this is the workflow that determines whether other work-

flows need to do something. Example: Issue.

2. Determine which transition will dictate amessage sent to others. Example: Ready for Validation > Issue is

Approved & Closed.

3. Click on that transition .

4. Go to theActions tab.

5. Add a new action.

6. Name the Action. Example: Close Children.

7. Select the type of action: Workflow Event.

8. Create or Select the Event to be Sent: this is the event that other workflows need to consume/ receive when the tran-

sition completes (explainedmore in the next section).



9. Indicate which Target Items should receive the Event: same concept as functions, the event needs to know which

direction in the tree it needs to go. In this case, descendants.

10. Save.

On save, the event is created in the system and can be consumed by all other workflows. To help search for this when

building other workflows, the Event field is searchable (explained below).

Notes:

-Workflow event cannot be created on a conditional date trigger

- A workflow event cannot be created on a transition that consumes an event. It could potential create an infinite loop.

- Created events cannot be deleted, but if renamed and not consumed by another event, if will disappear from the list.

Creating the TRIGGER that Receives the Event

Based on the above example #2, descendant workflows need to receive the event that was created. For example: Action

Plans.

1. Navigate to the desired workflow. In this scenario, Action Plans.

2. Define which states the event applies to. For example, if the issue close, the action plan should close regardless of

what state the action plan is in. To create a trigger that applies to all states see the section below: Setting upGlobal

Triggers.



3. To set up a single trigger to consume an event, click add trigger button on the workflow overview page for the

desired stated. Example: In Progress.

4. Name the trigger.

5. Select Type: Workflow Event from the drop down.

6. Name the transition.

7. Define the next state.

8. In theCreate or Select the Event to be Received: in this case, click on the box. A list of workflow events come up

that are currently in the system.

9. Select the desired Event to consume. This will initiate the transition of the item.

10. Select the Priority.Whenmultiple events are thrown to a state this setting determines which event/trigger takes

priority. If all triggers are set to Default, the trigger selection will be random. If priority is set, the trigger with the high-

est priority will be accepted.

Notes:

- If the trigger is consuming an event, an Action cannot be created to throw another event.

- Modifying an existing trigger by renaming the event, the previous event will remain in the system if the event is being used

elsewhere. If the event is not being used it will no longer be shown in the list as it's not referenced anywhere, therefore can-

not be in the list to select.

- Conditional date triggers vs event: Event always win – if an event and a conditional trigger happen simultaneous, the

event always overrides



Setting up Global Triggers

Global workflow event triggers allow to set up one trigger that applies to all the states in the receiving workflow. This will be

themost common use case when building workflows in Part 1 of LinkedWorkflows. In most scenarios, the event thrown

will be to sent to all items regardless of where it currently resides. S

1. Navigate to the desired workflow.

2. At the top of theWorkflow Overview page, a Global state is indicated.

3. Follow steps 3-10 from above: Creating the trigger that receives the Event

Anytime an event is thrown from another workflow, regardless of what state the item is in, it will transition.

Identifying State Status of Linked Workflows

Above covered the concept of sending and receivingmessages between workflows that trigger themovement from state to

state. In addition to that, a new condition has been put in place to determine whether an item in that linked workflow is in a

specific state.



Example: Prior to signing-off on a process, audit or other item verify that all descendants are in their signed-off state.

To learn how to create this condition, seeWorkflow Adding Conditions.

Workflow: Managing Subtypes

Managing Subtypes Overview

Administrators may attach workflows both to itemmain types and item subtypes. However an individual workflow may be

set only at either themain type level or the sub type level. One workflow can be linked tomultiple item sub types, but a

workflow cannot be attached to a combination of main type and some sub type(s).

Multiple published workflows within an item typemay be linked to specific but discrete subtypes. However if one published

workflow is linked to themain type (and therefore all items of that type, regardless of subtype), it is not possible to publish

workflows for the individual subtypes, and vice versa.

An individual item can be linked to only one workflow. At the time of publishing a workflow, the framework is analyzed to

ensure that no items could be linked tomultiple workflows. If any item(s) in the framework have a combination of subtypes

that would put them in that position, the workflow cannot be published. Similarly, wheremultiple published workflows are

already in place for relevant subtypes it will not be possible to add new items or edit existing items’ subtype settings if

those changes would result in linking an item tomultiple workflows.

Managing Subtypes – Detailed Information

Although draft workflows may be created from either themain type or a sub-type item template designer screen, they are

then available to be linked to that main item type or any of its sub-types.

As discussed inManaging Subtypes Overview, a workflow may be:

- Linked to the itemmain type and therefore available to all items of that type regardless of whether they are

in subtype templates or not.

OR

- Linked to one or more sub-types without being linked to themain type.

When a workflow is linked to a subtype, any item of that subtype will run that workflow. Items that are not part of that sub-

type will not be able to run the workflow.

Therefore different workflows can be attached to different but discrete subtypes. If a workflow is published for amain type,

workflows may not be published for the subtypes. Once a workflow is linked to a subtype and published, no other workflow

can be linked to and published for that subtype. Similarly if a workflow is published for a subtype, no workflow may be pub-

lished for amain type.

When a workflow is published, and where the user has the permission tomodify subtypes in the view item and subtype col-

umn inMatrix Assessor, the choice of subtype is limited to the subtypes that may be attached to that workflow. Therefore:

• Main type items will show all subtypes



• Items that are of a given subtype will only display the other subtypes to which that item`s workflow can be

attached.

In addition, a user with appropriate permissions may remove the workflow subtypes from an item, but only when it is in the

start state. This option is not available in other states, where subtypes may be added or removed but only those that apply

to the workflow.

In other states, text if a user attempts to remove a subtype, on clicking of the trigger in Manage By…orMatrix Assessor, a

message will be displayed advising the user that this cannot be done during a workflow and the transition will not be

allowed. (In Matrix Assessor this will also result in a redWorkflow Action cell).

Workflow: Resetting Workflow on Item(s)

Resetting Workflows on Item(s)

Administrators can reset a workflow on one or more items. Resetting returns the item to the initial “Start State”. However, it

doesn’t remove or change any criteria values, subtype settings, attachments etc.

The reset process may be necessary when an item has been incorrectly completed and arrived in a state it cannot move on

from, or other situations when an overridemay be necessary. For example, when workflows relate to an activity that is sea-

sonally, the reset workflow feature can be used to “re-boot” the items for the new period.

Resetting Workflows from “Manage By…” Screens

1. In theManage By screen, click the highest level item that needs to be reset, or an item higher in the hier-

archy than all the items that need to be reset.

2. Click the Reset Workflow button above the left panel.

3. In the right panel select the appropriate workflows to be reset by checking boxes for item types, item sub-

types or workflows.

4. Click the Reset Workflow button above the right panel.

Resetting Workflows during Period End

Administrators can reset workflows on one or more items during the period end process.

1. In Step 4 of the Period End process generate a filtered list of all items that are required to be reset.

2. On the Clear Results tab, check items whose workflows are to be reset.

3. Click the Reset Workflow button.

4. Continue with the remainder of the Period End process which is discussed in further detail in Period End.



Workflow Reporting

Reporting on Workflow States - Overview

All report types can display the current state of the item. The display features the name of the state and the background is

the colour assigned to the state when the workflow was designed. The order in which states appear is also defined in the

workflow.

In report design, states are like criteria and the state information can be included or excluded from a report and charts may

be filtered by specific states.

The homepage can also be configured to show the state of workflow items in the form of a pie chart. These pie charts are

available for selection with all the other charts of criteria values.

Reporting onWorkflow States

Reports can includeWorkflow State information and filter based on this information, similar to how they report and filter on

other item data. In addition, workflow states can be included in homepage pie charts and in the Executive Dashboard.

Hierarchical and Item overview Reports

1. Set up Hierarchical report, Item Overview report or Summary report as normal.

2. In the report filters locate the section called <Item Time or Subtype> Filterable Attributes and Criteria>

3. Check all state names for which items will be included in the report

4. Scroll down to the Select the columns to display section.

5. For the current period, select the State fields to be included. The options are in the format “<Item Time or

Subtype>: <Workflow Name> State”

6. For hierarchical reports, repeat this for all required item types.

7. For summary reports, locate the option relating to the appropriate sub type(s) an check the field in the for-

mat “<Item Time or Subtype>: <Workflow Name> State”

8. Run the report as normal.

Home Page Pie Charts

1. Go to Username > Edit My Profile > Homepage Preferences.

2. Check the workflow state pie chart. Its format is “<Item Time or Subtype>: <Workflow Name>”

3. Press Save.

4. Managing default pie chart choices for groups can be done similarly in Administration > Groups > Home-

page Preferences



Workflow: User Interaction (Manage By & Matrix Assessor)

Using Workflows – “Manage By…” Screens

In Manage By Location / Manage By Scoping, the current state of the item appears in the top right corner of the right hand

panel. The state name appears in square brackets. The colour of this text is defined by the Administrator who built the work-

flow and the colour is also used inMatrix Assessor and Reports. The Administrator may have included explanatory text for

this state. This will appear at the top of the right hand panel under the headingState Instructions.

As the workflow state determines which criteria can be seen by different roles at different times, it is possible that a user

can read or edit different fields when an item is in a workflow than when it is not.

The Trigger buttons that transition between states are in the blue bar below the tabs in the right hand panel. Theremay be

any number of trigger buttons, although typically just one or two, and these are on the left of the list of buttons.

When a trigger button is clicked, the item is validated to ensure that mandatory criteria have been filled out. Other actions

such as attaching a file may also be classed as mandatory.

It may be necessary to complete a transition statement. This may be a statement asking a user to confirm that they want to

proceed with a transition or amessage requiring an attestation that the information entered is complete and correct. There

will be a button to concur with the confirmation statement and another to reject the statement, which will cancel the work-

flow transition. The wording is defined in the workflow.

If it is not possible to transition to the next state for any reason, amessage is displayed.

Using Workflows – “Matrix Assessor”

In Matrix Assessor, it is possible both tomove individual items from state to state and tomove all items of a certain type or

subtype. The background colour in theWorkflow Action column indicates the current state of each item. The Administrator

may have included explanatory text (State Instructions) for this state. This can be displayed by holding themouse cursor

over the state name.

Transitioning individual items. This can be done using drop downmenus in theWorkflow Action column for each item.

When you Save and Refresh theMatrix Assessor, the required state changes will occur, assuming all mandatory fields

have been completed. When a transition is successful, theWorkflow Action cell will be colored green. If unsuccessful, a

message will appear at the top of the screen and theWorkflow action cell will be red.

Transitioning all items of a certain type or subtype: Using the Set Workflow Transitionmenu option, the user can

select all items of a certain type and subtype and determine which state they should be transitioned to next. On pressing

Save and Refresh all items that can be transitioned to the selected state will be.

It may be necessary to complete a confirmation statement. This is a statement asking a user to confirm that they want to

proceed with a transition or amessage requiring an attestation that the information entered is complete and correct. The

wording is defined in the workflow. As multiple items are being transitioned inmatrix assessor, the screen will display

appropriate confirmationmessages for all items types and sub-types and list the items being transitioned.



Whenmultiple confirmation statements are presented, the user can choose to either approve or reject each one individually

or use the Set all to affirmative check box in the top left of the window to approve all items for transitions simultaneously.

Any items that could not be processed in this transition in Matrix Assessor, because they did not pass conditions will be

identified at the bottom of the confirmation statement.

TheWorkflow action columnwill detail all items with a red (fail) or a green (pass).

Workflow User Interaction (Emails)

Workflow E-Mail Notifications

Users may receive e-mail notifications when items go through a transition. These e-mail notifications are set up by the

administrator who designed the workflows.

A user may be either a responsible recipient of an e-mail, i.e. a person who needs to interact with the item in its new work-

flow state or an informed recipient, i.e. a manager or other individual who needs to be aware of each item’s state. The recip-

ients are based on roles and the relationship between roles and workflow and their individual states.

E-mails are scheduled to run at a certain frequency and will typically summarize all activity for a given time period. Links

within the e-mails enable users to work on individual items in theManage By… screens or to work on all items listed in the

e-mail usingMatrix Assessor.

Administrators can set up emails to send a specific link to a report allowing the user to load items directly in that report.

Users receive an email, as seen in 6.3, however, administrators can substitute the "Assess all items in Assessor" with a

link the brings them to a pre-defined report. For more information, See "Workflow: Creating E-mail Notifications" on page

168

a. Users loading the report via email must have live report access granted.

b. It will remove the default link to assess items in theMatrix Assessor.

c. If an aggregate email has multiple transitions for the same item type, multiple links will be available in the email.

Each transition that has a report link defined will be available to the user.

d. Administrators will have access to all Item Overview and Hierarchical reports they have permission to.

e. Clicking in the link will always load the report, not the report builder.





Email Notification will now indicate the users Full Name, opposed to the Username. If a full name is not provided upon cre-

ation of the user profile, it will auto-insert the username into the full name field.

Workflow User Interaction (My Tasks)

Interacting with My Tasks via the Homepage

TheMy Tasks dashboard on the user home page is a valuable tool to let users know when their attention in required for

items in specific workflow states. The table displays:

• Item number

• Item name

• Workflow

• Current State

• Action Taken (the last trigger executed)

• Previous State

State names are highlighted in their assigned color as set up in the workflow State Editor. The items are grouped in the fol-

lowing order:

• By Workflow

• By Current State

• By Action Taken

There are twoways to navigate from the list into the items.

1. For individual items, click on the item name. The item will be viewed in theManage by Location or Manage

by Scoping Item screen.

2. For multiple items, click the appropriate check boxes (the check box at the top of the table selects all

items) and click the Take Check Items to Assessor button to open the items inMatrix Assessor.

Setting up the My Tasks dashboard

1. Go to Username inMenu> Edit My Profile > Homepage Preferences.

2. In the section Include Information Boxes, check My Tasks

3. Press Save.



4. Managing default pie chart choices for groups can be done similarly in Administration > Groups > Home-

page Preferences



Report

Reporting Introduction

Reporting is an ongoing process that generates useful andmeaningful data on the status of your governance, risk man-

agement, compliance or other program across the organization. Reports can be generated as frequently as required in both

tabular and chart form and some parameters can be saved to facilitate the easy update of standard reports.

The key functionality and report types are

● Executive Dashboard

● Item Overview Reports

● Summary Report

● Hierarchical Reports

● Saving, Sharing and Retrieving Reports

● Charting

● Audit Trail / Change Log

To enhance usability and efficiency large reports may be generated using a Parallel Processing Engine, whichmeans that

the user can continue working while reports are generated. See Creating Reports using Parallel Processing Engine for fur-

ther information.

Executive Dashboard

The Executive Dashboard provides a high level overview of your Governance, Risk and Compliancemanagement pro-

gram. Using pie-charts, the Executive Dashboard displays the results for graphable criteria linked to the following items:

Locations, Folders, Risks, Controls, Issues, Action Plans, Tests and Test Results. Sign off charts for Locations, Folder,

Risks and Controls are also displayed.

The information visible in all reports is restricted to items the user has read (or greater) permission to.

1. Click onReport > Executive Dashboard.

2. Use the drop downmenu to choose your starting point for the information displayed in the Executive Dashboard

graphs. This enables you to analyze a specific area in your organization.. The default Starting Point is set in the

user’s profile under homepage preferences.

3. Select the required pie charts from the check boxes.

4. Click Generate Report
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5. When you click on a particular criteria value displayed in a pie-chart (either on a piece of the pie directly or on the

legend), it automatically brings up an Item Overview page containing a list of Items that have been filtered accord-

ing to the selected criteria values.

Export the Executive Dashboard to Excel

1. Click onReport > Executive Dashboard.

2. Click theExport to Excel button found in the top right hand corner.

3. The File Download window will appear. Open or save the file as desired.

4. Each Item Type in the system will appear on a separate sheet in the file and include all evaluation criteria. No pie

charts are included in the export.

When clicking on a pie chart based on a criteria used only in an item sub-type, the resulting report will include only the crite-

ria for that item type and item sub-type. Criteria relating to other sub-types is excluded in order to make the report easier to

read andmore relevant.

Item Overview Reports

Item Overview Reports enable Users to analyze and report on each of the Item Types and Sub-Types in the system. 

Administrators will see all Items in the system in this report. All other users will only see the Items to which they have been

given at least Read permission.

The Item Overview Menu displays all 12 reportable Item Types.  Sub-Types are indented to the right of the drop down

menu.

Additional Filter: enables reports to be built by placing focus on the user generating and reviewing the report. User lists

now contain an additional checkbox to select ‘Current User’, when the report is generated it will apply the user running the

report as the filter for the defined criteria. (6.3)

Past Period data, archived in the period end process, is now reported in Item Overview reports. (5.3)

Role informationmay be included in Hierarchical Report and Item Overview Reports. This is controlled by a System Set-

ting: "Disable the ability to report on Roles in Hierachical Report" (5.2)

1. Click onReport > Item Overview > <Item Name> (Where <Item Name> is the item type you wish to report on.

e.g. Risks). The Item Overview Report Builder page appears. This displays all filterable criteria (starting point,

attributes ,evaluations, functions and roles) for the Item and Item Sub-Types.

2. Use the drop downmenu to choose the starting point for the information displayed in the Item Overview. This ena-

bles you to analyze a specific area in your organization. You can choose a starting point based on the Location

framework or Scoping item framework. The default Starting Point is set in the user’s profile under homepage pref-

erences.

3. Choose the Filter Type, eitherAnd orOr.When you select And the system will filter and display items that match

the complete list of conditions. When you select Or, the system will filter and display items that match at least one

of the conditions.



4. Determine the display attributes you wish to show in the report based on any Item Sub-Types.

5. Check off the Context column. Context helps the user understand the relationship the item when reviewing the

report. (8.0)

6. Define the Context by selecting the appropriate item types to show in the column. (8.0)

7. Use the Limit By function to determine the Item Type/Sub-Type(s) displayed in the report. If you leave all

unchecked, all types will be included in the report.

8. Select the past periods to display, if required. This is done by using the radio button to either select the number of

most recent previous periods, or by selecting individual past periods to display. The first of these is particularly use-

ful for saved reports which will be run again in the future and need to report over the same periods of time (e.g.

quarters).The selection will default to the user's Data Preferences in theUsername in Menu > Edit my Profile or

Administration > Users > Data Preferences screens.

9. Next, determine the filter conditions by selecting item attributes and evaluation criteria. A check mark beside the

criteria option will indicate you wish to filter your report based on the criteria option.

10. Filtering functions: select the applicable ranges for each item type to filter the items.

Note: filtering for functions will only be available if the function is set toReport using ranges when creating the

function.

11. Choose which columns to display in the filtered report by placing/removing a check mark next to the criteria name

in the box labeledSelect the Columns to Display.

12. Click theGenerate Report button to employ the filter and produce the report.

13. To remove the filters and return to the original list of Items, click theRemove Filters button on the Filtertab.

If the item is not required to be evaluated on a category, an N/A will appear in the column (e.g. the criteria are asked only of

a certain Item Sub-Type). If the item is required to be evaluated on a criteria but has not yet been evaluated, a – (dash) will

appear in the column.

Sort Items on the Item Overview Pages

1. Click onReport > Item Overview (where Item is the item you wish to report on. i.e. Risks or any sub-type of

Risks). 

2. The Item Overview page will appear.

3. Click on a criteria column header to sort the items in descending order from highest to lowest.  

4. Click on the same criteria column header again to sort in ascending order.

Criteria headers colored black cannot be sorted as the criteria they reference are unable to be sorted, such as check box

criteria, single andmulti line text boxes, etc.  Only blue colored criteria headers can be sorted. Clicking on the name/de-

scription of an Item will direct you to the instance of that item inManage by Location.

Export Items to Matrix Assessor

Matrix Assessor enables the rapid completion of assessments of amultiple Items in a table-like interface.



1. Click onReport > Item Overview (where Item is the item you wish to report on. i.e. Risks or any sub-type of

Risks). 

2. The Item Overview page will appear.

3. Select the Items you wish to export by placing a checkmark in the box to the left of the Item name.

4. Use theExport Select Items to: drop downmenu to select Matrix Assessor. 

5. Click theGo button to export the items toMatrix Assessor and to access theMatrix Assessor function.

Export Items to Chart Builder

GRC Cloud includes graphing and charting capabilities to help users understand trends and results. A variety of charts can

be created from both the Item Overview pages, Hierarchical Reports and the Location Tree. GRC Cloud also integrates

seamlessly with Resolver's Ballot and Survey products to enable group discussions, risk and control self-assessments

and surveys outside GRC Cloud.

Export to Heat Maps or Line Charts from the Item Overview Page

1. Click onReport > Item Overview (where Item is the item you wish to report on. e.g. risks). The Item Overview

page will appear.

2. Select the Items you wish to export by placing a checkmark in the box to the left of the Item name.

3. Use theExport Select Items to: drop downmenu to select the type of export you desire. 

4. Click theGo button when you are ready to export. The page will refresh displaying the chart.

5. Reformat the chart to display the desired characteristics. Using the drop downmenus change the X and Y axis

criteria, the chart size, the evaluation period and the items included in the graph.

Export to Resolver Survey

When Exporting to Survey, none of the current evaluations will be exported, just the item information, criteria scale and

choices.

Exports to Survey prompt the user to choose the criteria to export and enable the user to download the file. In order to open

Ballot files youmust have the Ballot application installed on your computer.

1. Click onReport > Item Overview (where Item is the item you wish to report on. e.g. risks). The Item Overview

page will appear.

2. Select the Items you wish to export by placing a checkmark in the box to the left of each Item name.

3. Click theSurvey button.

4. Select the criteria to include in the export. Place a checkmark beside the criteria to include in the export file. Only

single-choice criteria (i.e. those that appear as radio buttons or drop-downmenus) will be available for export.

5. Click theExport button. Use the File Download pop-up window that appears, save the document to your computer.

6. Once the download is complete, open Assessment Manager in Survey and use the Import from File function.



Export to Resolver Ballot

When Exporting to Ballot, none of the current evaluations will be exported, just the item information and, optionally, criteria

scale and choices.

Exports to Ballot prompt the user to choose the criteria to export and enable the user to download the file. In order to open

Ballot files youmust have the Ballot application installed on your computer.

1. Click onReport > Item Overview (where Item is the item you wish to report on. e.g. risks). The Item Overview

page will appear.

2. Select the Items you wish to export by placing a checkmark in the box to the left of each Item name.

3. Click theBallotbutton.

4. Indicate whether to use the description text within GRC Cloud to appear as the Item text in Ballot. If the option is

left unchecked the Item Name in GRC Cloud will be used as the Item Text in Ballot.

5. Select the criteria to include in the export. Place a checkmark beside the criteria to include in the export file. Only

single-choice criteria (i.e. those that appear as radio buttons or drop-downmenus) will be available for export.

6. Click theExport button. Using the File Download pop-up window that appears, save the document to your com-

puter.

7. Once the download is complete you can go into Ballot and use the File > Import > Import from Resolver func-

tion.

Export Items Listed on the Item Overview Page to Word or Excel.

1. Click onReport > Item Overview (where Item is the Item you wish to report on. e.g. Risks)

2. The Item Overview page will appear. Click on the Filter tab.

3. Sort and filter the Items as desired.

4. Use theExport drop downmenu to select the type of file to be exported to.

● PDF: Generates an Adobe Acrobat file of the HTML report.

● Excel Formatted: Creates an Excel spreadsheet. Any text entered through the rich text editor is pre-

sented with the formatting as originally entered. This may result in extra rows being created in the spread-

sheet to accommodate rows in tables.

● Excel Unformatted: Creates an Excel spreadsheet. Any fields entered through the rich text editor will not

be displayed as rich text and thereforemay be difficult to read. Other text appears normally.

● Word Formatted: Creates aWord document. Any text entered through the rich text editor is presented

with the formatting as originally entered. This may result in complex tables created in the document to

display the text entered through the rich text editor.



● Word Unformatted: Creates aWord document. Any fields entered through the rich text editor will not be

displayed as rich text and thereforemay be difficult to read.

5. The File Downloadwindow will appear. Open or save the file as desired.

6. The Excel orWord file will include all the Items listed on the Item Overview page. PDF output will feature all items

in the report.

Note: PDF export will include all items generated by the Item Overview Report, whereas theWord or Excel export will

include only the checked items.

Print Items Listed on the Item Overview

1. Click onReport > Item Overview (where Item is the Item you wish to report on. e.g. Risks).

2. The Item Overview page will appear.

3. Click thePrint button.

4. A window will pop up with a printer-friendly version of the item overview screen will appear.

5. Print using Internet Explorer general settings.

Saved Reports

There are two ways to save reports in GRC Cloud: Save Settings or Save Snapshot. Save Settings allows you to configure

and customize a report to produce exactly what you want and then save those settings to be re-run at a later date. Saved

Settings will always produce reports with the latest data. Saved Snapshots will capture the data that you have generated in

your report and save the content as of that point in time. If you view a Saved Snapshot at a later date the content is the con-

tent as of the date you originally ran the report).For detailed steps for Saved Reports, see the section in Report > Saved

Reports.

Fixed Headers

Reports can be large and difficult to interpret, fixed headers gives users a better understanding of what they are viewing in

the report by providing the ability to reference the column headers at all times. As the user scrolls the page the headers

remain fixed to the top and visible at all times. (7.1)

Note:

- Available in Item Overview, Matrix Merged / Unmerged, Spreadsheet

- Only available for IE9 and Firebox browsers. This feature is not supported in IE 8.

-Header does not remain fixed when transitioning workflow in editable reports.



Summary Report

TheSummary Report Builder enables you to create customized HTML reports on a specific Item Type and its current eval-

uations. You can also display specific items filtered by sub-type (if there are sub-types for the item).

The information visible in all reports is restricted to items the user has read permission to. Administrators members can see

all items.

Summary Report Builder

1. Click onReport > Summary Report The Summary Report Builder page will appear.

Reports can be organized by either Location/Location Process or by Organization-wide process.

Location or Loca-
tion Process:

Summary of items based on the location. The summarywill report on all items
below the Location selected.

Organization-
wide Process:

Summary of items based on the customized frameworks built in the Framework
Library. The summarywill report on all items for the chosen section of the frame-
work regardless of location. You can also choose to specify the results by loca-
tion.

Each number that appears is clickable.  It automatically brings up an ItemOverview page containing a list of Items that

have been sorted according to the columns values.

Location or Location Process Summary Report

1. Click onReport > Summary Report.

2. TheSummary Report Builder page will appear.

3. Choose the points within the locations framework for which you wish to view an Item summary for. The report will

display a summary for all items points selected.

4. Next choose which item type you would like to summarize.

5. Check off theAttributes and Criteria to Display and check off what you would like it to Limit To.

6. Click theGenerate Report button to generate the results.

7. Use the horizontal scroll bar to view all the results. Click on a number to view the detailed information (in an Item

Overview page) of those Items.

8. Click theRebuild button to create a new summary on another Item type.

Organization-Wide Process Summary Report

1. Click onReport > Summary Report.

2. TheSummary Report Builder page will appear.

3. Choose the customized framework from the second drop downmenu on which you wish to summarize Items.



4. Choose the starting point within the Locations Framework below which you wish to view an Item summary for. The

default Starting Point is set in the user’s profile under homepage preferences.

5. Then choose the points within the Framework for which you wish to view an Item summary for. The report will dis-

play a summary for all Items selected.

6. Next choose which Item Type you would like to summarize.

Only Items that have criteria that can be summarized (i.e. criteria with discrete options like drop down lists, check boxes

and radio buttons) will be listed.

7. Check off theAttributes and Criteria to Display and check off what you would like it to Limit to.

8. Click theGenerate Report button to generate the results.

9. Use the horizontal scroll bar to view all the results. Click on a number to view the detailed information (in an Item

Overview page) of those Items.

10. Click theRebuild button to create a new summary on another item type.

Export Summary Report to Excel, Word or PDF

1. Click onReport > Summary Report.

2. TheSummary Report Builder page will appear.

3. Build your report as above.

4. Click theExport button which is found at the topmiddle of the page. Select eitherWord, Excel or PDF.

5. The File Downloadwindow will appear. Open or save the file as desired.

Print Items Listed on the Summary Report

1. Click onReport > Summary Report (where Item is the Item you wish to report on. e.g. Risks).

2. TheSummary Report Builder page will appear.

3. Build your report as above.

4. Click thePrint button.

5. A window will pop up with a printer-friendly version of the Summary Report screen will appear.

6. Print using Internet Explorer general settings.

Saved Reports

There are two ways to save reports in GRC Cloud: Save Settings or Save Snapshot. Save Settings allows you to configure

and customize a report to produce exactly what you want and then save those settings to be re-run at a later date. Saved

Settings will always produce reports with the latest data. Saved Snapshots will capture the data that you have generated in

your report and save the content as of that point in time. If you view a Saved Snapshot at a later date the content is the con-



.

Hierarchical Report

Hierarchical Reports provide a view that illustrates the relationships between items in the systems. You can chose from

six report designs and include or exclude any combination of item types and criteria, plus filter results based on criteria

values. The report’s starting point (level in the hierarchy) can be selected and the information can be organized around the

location view, the scoping item view or an applications view. Information visible in reports is restricted to items for which

that user has read permissions or other permissions. Administrators and Reporting Groupmembers can see all items in the

report.

Files available in all styles of reports (7.0)

All styles of Hierarchical reports display the files attached to the items.
Matrix (Merged / Unmerged) and Spreadsheet showed file attachments in 6.3. In 7.0. files now show in List (Vertical / Hor-

izontal) and Unformatted List.

Enables reports to be built by placing focus on the user generating and reviewing the report. User lists now contain an addi-

tional checkbox to select ‘Current User’, when the report is generated it will apply the user running the report as the filter for

the defined criteria. (6.3)

File Attachment names may be included in Hierarchical Reports in the following report formats: Matrix Merged, Matrix

Unmerged, Spreadsheet.

New in 5.2

Reports that include file names can now be used to generate a ZIP file of all attachments in the system.

New in 5.2

Role informationmay be included in Hierarchical Report and Item Overview Reports. This is controlled by a System Set-

ting: "Disable the ability to report on Roles in Hierachical Report"

Hierarchical Report Formats

There are six report formats, each of which represents the information within in the framework in a different way.

● Matrix (Unmerged):Presents the data in a table form with rows for each item and columns for each criteria. Each

lowest level item in the report will appear once, with higher level items being displayed next to the lowest level item

so that the hierarchy can be interpreted. Framework items and non-framework items can both be included in this

report.
● Matrix (Merged):Presents the data in a table form, but with rows for each item and columns for each criteria. In

theMatrix (Merged) report each item appears once. To show the relationships between items at different levels,

the table cells for higher level items may be several rows deep. For example if three controls were related to one

risk, then the risk cell will be three rows deep so that the relationship to all three controls can be represented. If two

risks were related to one process and each of those risks had three controls, the process would be represented in a

cell six rows deep and so on. Due to the complex structure of this report, non-framework items (test results,

issues, action plans) are not shown as they would disrupt the layout of the hierarchical structure.



● Spreadsheet:Similar to matrix unmerged, but there is only one item per row. (Parent items are not replicated in

multiple rows). The hierarchical relationship is indicated by indenting the different items on the left of the report by

hierarchy level.
● List Horizontal: Lists all selected items and criteria as a list, displayed in the order the items appear in the hier-

archy. The hierarchical relationship is represented by indenting the items on the left side of the report. To use

screen space effectively all information relating to attributes appears in the left hand column and all information per-

taining to evaluations in the right hand column.
● List Vertical:Displays the same information as List Horizontal except that all fields fill in entire width of the screen

rather than having Attributes and Evaluations in parallel columns. The hierarchical relationship is represented by

indenting the items on the left side of the report.
● Unformatted List:Unformatted List is similar to List Vertical except items such as colored text and background,

icons are removed, although formatted text entered through the Rich Text editor is retained. The formatting is mini-

mized specifically to streamline the report for export to Microsoft Word. This report is useful for auditors who need

to extract information form GRC Cloud and incorporate it into other documents they use.

Hierarchical Report Builder Screen

The Hierarchical Report builder is accessed from Report > Hierarchical Report or by right clicking a hierarchical report

name in theMy Reports box in the home page and selectingReview/Edit Report Content/Filters.

The top of the Hierarchical Report Builder screen consists of a number of blue tabs: a General tab, a Saved Reports tab

and a tab for each Item Type included in the framework. The page opens with the General Tab open. TheGeneral tab fea-

tures two panels.

The top panel organizes and sets the scope of the report, in terms of the report presentation style, how it is organized, the

starting points and limits related to framework items and locations.

The bottom panel is used to select the criteria types and sub type to be included in the report.

Build a Hierarchical Report

1. Click onReport > Hierarchical Report to view theGeneral Tab of the Hierarchical Report Builder.

2. Select the Report Presentation style as defined above.

3. Select whether all instances of multi-parent items should be shown or just the first incidence. Selecting the first

optionmeans that amulti parent item can be seen in each location it appears in the hierarchy, whereas the second

option limits this to being just displayed one time.

4. Select theOrder, by choosing either the Location Framework (the structure as seen inManage by Location), or the
Scoping Item Framework (the structure as seen inManage by Scoping Item Framework)

5. Select theStarting Point. This is the item in the hierarchy that will be displayed as the highest level in the report.

Any item in the hierarchy can be set as the starting point. The default Starting Point is set in the user’s profile under

homepage preferences.

6. Choose whether to limit the display of items by a certain framework. This is used where GRC Cloud has been set

up with multiple frameworks. For example, there could be Sarbanes-Oxley compliance framework, an Enterprise

Risk Management Framework and a health & Safety Framework. Checking this option and using the two drop-



downmenus to select one framework and potentially a specific folder within that framework, can be used to

restrict the scope of the report.

7. Choose whether to limit the scope of the report by a specific location. This can be used in conjunction with the

Order option (see Step 4 above) to limit the scope of the report to a specific location or sub-location attached to a

scoping item, such as an account line, while still enabling the locations above the one selected in the “Limit by”

option to be viewed within the report.

8. In the lower panel select all Item types that are to be included in the report. If a main item type is selected (for exam-

ple All Locations or All Controls), all associated subtypes are immediately selected also. Alternatively, one or more

item sub-types may be selected. For example, if there weremultiple types of risks, but only health and safety risks

were required in this report, and health & safety risks had been set up as a sub-type, then these can be selected,

by leaving the “All Risks” box unchecked, while checking the “Health & Safety Risks” box.

9. Filter the report by certain criteria values or responses, by clicking the blue tab for an item type and checking the

responses that will be included in the report. For example, if a Risk Likelihood Criteria had five possible responses,

but this report was only concerned with selecting Very High and High Likelihood responses, check these two

boxes. Selections can also bemade for text fields, numeric fields and date fields. Selections can bemade for sev-

eral criteria, however, the filtering will only select items that meet all the filters selected. This process can be

repeated for all other item types, by clicking on the related tab andmaking selections there.

10. Filtering functions: select the applicable ranges to filter the items.

Note: filtering for functions will only be available if the function is set toReport using ranges when creating the

function.

11. Choose which criteria to include/exclude from the report, by clicking the blue tab relating to the item type and scroll-

ing to the bottom of the page. There is a list of all criteria for this type and associated sub-types and criteria may be

checked or unchecked.

12. To see the report created by these parameters, click Generate Report. Note that large reports may be submitted to

a report queue for processing. This maximizes the efficiency of the applications resources. If the report needs to

be queued, you are advised of this. The status of queued reports can be viewed under Tools > Queued Reports.

13. To see a chart based on the selected items and criteria, click Generate Chart.

14. To take the selected items and criteria and view them inMatrix Assessor, so that assessment criteria may be com-

pleted, click Assessor.

Hierarchical Report Viewer Screen

After following step 11 above, you will view the report in the Hierarchical Report Viewer Screen. The entire report is shown

in one screen. This can take time to generate within the browser if the report is large. There are several options on this

screen.

To edit or save the parameters of the report, or to share the report with other users, click Rebuild.

● To save a Snapshot of the report, click Snapshot. Note that a Snapshot saves the data of the report, not the param-

eters (starting point, limit options, items types, criteria filters etc.) that would enable you to re-run a report regularly with

current data. To save report parameters, click Rebuild.



● To view the content of the report in Matrix assessor, so that assessment and evaluations may be completed, click

Assessor.

● To print the report click Print. A Printer-Friendly version of the page will be shown. Use the browser controls to send

this document to the printer.

● To export the report to Adobe Acrobat PDF, Excel spreadsheet orWord document, click theExport button and select

the appropriate option. See next section for details.

● Page View Mode: To view a report in a document mode (example: MSWord) an option in the report header is available

to toggle the report from draft mode to document mode. Available in Hierarchical reports: List Horizontal / Vertical,

Unformatted List

Page View Enabled (indicated by blue button and orange text) - Now document size and great for printing / exporting

Export Hierarchical Report to PDF, Excel or Word

1. Click onReport > Hierarchical Report. The Hierarchical Report Builder page appears.

2. Build a report as described in the previous section.

3. Click theExport button and choose the appropriate option:



● PDF:Generates an Adobe Acrobat file of the HTML report

● Excel Formatted:Creates an Excel spreadsheet. Any text entered through the rich text editor is presented with

the formatting as originally entered. This may result in extra rows being created in the spreadsheet to accom-

modate rows in tables.

● Excel Unformatted:Creates an Excel spreadsheet. Any fields entered through the rich text editor will not be dis-

played as rich text and thereforemay be difficult to read. Other text appears normally.

● Word Formatted:Creates aWord document. Any text entered through the rich text editor is presented with the for-

matting as originally entered. This may result in complex tables created in the document to display the text entered

through the rich text editor.

● Word Unformatted:Creates aWord document. Any fields entered through the rich text editor will not be dis-

played as rich text and thereforemay be difficult to read.

Note: The Spreadsheet Report cannot be exported toWord.

Note: Color coding in original reports will be displayed in all PDF, Word and Excel output if the Print Reports With Color

option is set to True in System Settings.

Using Hierarchical Report Data in Chart Builder

The Hierarchical Report and its capability of saving settings provides themost flexible and useful way of using Chart

Builder. Use the general tab to decide which items you wish to include in your chart. (More filtering is available in the Chart

Builder itself.) Use the following steps to select data for charting:

Use the following steps to select data for charting:

1. Navigate toReport > Hierarchical Report. Youwill be at theGeneral tab.

2. In the upper panel make the appropriate selection in theOrder By andStarting drop downmenus. The other options

have no effect on the information to be included in the chart.

3. In the lower panel select all the items that may be required in the chart.

4. Open the tabs for each item type to be incorporated into the chart and scroll to select the columns to display .

5. Check all the criteria whose values are needed for display in the chart. Repeat this for each item type to be

included in the chart.

6. Click Generate Chart.

For further information on Chart Builder, see Chart Builder.

Exporting File Attachments

Administrators can generate a ZIP file of attached files and download them to the desktop.

For any Hierarchical Report where Files have been included (using the check boxes in the Select Columns to Display sec-

tion) an Administrator can now create an export package consisting of:



● Copies of files

● Html and Excel versions of the report, which contain links to the files in the package. (The difference between the

links in this exported file and the links normally seen in a hierarchical report is that these links will point to a folder of

files on the user's desktop, whereas the links contained in a report link to files within the GRC Cloud application.

1. Run a Hierarchical Report, ensuring that the option to display files has been checked for the required item types.

This is done through a check box in theSelect Columns to Display section of the report builder.

2. The file export package is created by clicking the “Generate Zip File” button in the hierarchical report builder and the

report will automatically go to the queue regardless of the report size.

3. The Administrator has several options when building the ZIP file:

● Select a name for the queued request

● Provide a description

● Set a name for the ZIP file which will contain the report and files

● Create a password so the downloaded ZIP file can be opened only by an individual who knows the password. This

password requires aminimum of eight characters, a mix of upper and lower case and at least one number and two

letters.

● Choose to download only the current version of each file, or multiple versions as defined by a date range. The

extract will include any earlier versions of files currently attached to items that were attached at the time of the

“From” date up until the “To” date. This means that the oldest file includedmay have been attached before the “From”

date.



4. Click Add to Queue. All File Extract requests go through the queue regardless of size. The status of a queued

request is visible in the Tools > Queued Requests screen. Completed queued export requests are shown in
theMy Reports box on the homepage and in the Saved Reports tab in hierarchical reports. The file export request is

indicated by a briefcase icon.

5. The request can then be loaded into the application, like any other report, by clicking the icon and then clicking Load.

6. Clicking Download Zip File to retrieve the file and download it to the desktop.

7. The ZIP file can then be extracted on the user’s desktop, using capabilities built-in toWindows XP and other oper-

ating systems or using a ZIP file application. The links within the HTML and Excel versions of the file are used to

open the downloaded files. Where there aremultiple versions of a file attached to an item this is indicated with a ver-

sion number.

Saved Reports

There are two ways to save reports in GRC Cloud: Save Settings or Save Snapshot. Save Settings allows you to configure

and customize a report to produce exactly what you want and then save those settings to be re-run at a later date. Saved

Settings will always produce reports with the latest data. Saved Snapshots will capture the data that you have generated in

your report and save the content as of that point in time. If you view a Saved Snapshot at a later date the content is the con-

tent as of the date you originally ran the report). For detailed steps for Saved Reports, see the section in Report > Saved

Reports.

Fixed Headers

Reports can be large and difficult to interpret, fixed headers gives users a better understanding of what they are viewing in

the report by providing the ability to reference the column headers at all times. As the user scrolls the page the headers

remain fixed to the top and visible at all times. (7.1)

Notes:

- Available in Item Overview, Matrix Merged / Unmerged, Spreadsheet

- Only available for IE9 and Firebox browsers. This feature is not supported in IE 8.

-Header does not remain fixed when transitioning workflow in editable reports.



Unformatted List Report

The Unformatted List Report is a simple rendering of information within items onto the screen. The primary purpose of the

Unformatted List Report is to provide an easy way to generate Audit Reports, where items can be listed in sequential order.

The style of the report has minimal formatting so that it can easily be converted intoMicrosoft Word format. Use of tables

has beenminimized as html tables can be difficult to manage when exported intoMicrosoft Word. In addition icons, colored

text and other formatting have been eliminated.

Once the report has been generated on screen and exported toMicrosoft Word (See full instructions in Hierarchical Reports

) the text can easily be copied and pasted into any existing templates the user has for Audit Reports.

Audit Trail / Change Log

Change Log provides Administrators with a complete list of all user activity that has occurred on the application to date. It

outlines the date and time of the activity, the Item that it concerns, the User’s name that performed the activity, and a brief

description of the activity. This functionality is used for audit purposes and cannot bemodified.

Note:Audit Trail does not capture administrative configuration actions. (Example: workflow building of states / triggers /

transitions / emails, item templatemanagement)

Only Administrator groupmembers can access this functionality.

1. Click onReport > Audit Trail.

2. There are two tabs on this page: Report and Filters.

The Report Tab
All user activities made in the system are listed here. They are sorted chronologically and show the Item name, date, user

and a description of the change.

3. Click on an item name to see where the item exists in the organization. TheBrowseMyOrganizationwindow will

appear.

4. Use the column headings to sort changes displayed on the page (as done in the Item Overview pages).

The Filters Tab
5. Enter the criteria you wish to filter by: Item name, datemodified, user/group or whether items are deleted.

6. Click the Filter button to display the results.

Actions Captured in Audit Trail

1. Creating and deleting items

2. Moving andMulti-ing items



3. All criteria, function calculation and attachments add to the system

4. Exporting items offline

5. Workflow state changes

6. Updating to/from the library

7. Permission changes to workflow and role builder (8.0)

8. Password Changes (8.0)

9. Creating, deleting andmodifying attributes of roles, groups and users (8.0)

Change Log Tab

A complete record of every user action associated with the Item is displayed in the Change Log tab. This functionality is

used for audit purposes and cannot bemodified. The Date, User Name and Description of the action are displayed in chron-

ological order with themost recent action first. Change log doesn't not record administrative actions (Role Permission build-

ing, framework building, etc)

By default, the Change Log tab is deactivated for non-Admin users.

Redlining and Highlighting Changes
Specific to the Rich Text Editor, all changes will be tracked highlighting any additions in green text and redlining any

deleted text. This changemakes it easier to quickly understand what changes have beenmade to rich text criteria. (6.2)

Note: when initially assessing the rich text editor and spreadsheet criteria, text will not be highlighted.

Note: Audit Trail and Change Log do not capture redlining and highlighting of changes for the Spreadsheet criteria. Only rec-

ords the latest value. (7.0)



Using the Parallel Processing Engine for Generating Large
Reports

When running a large reports, GRC Cloud will automatically determine themost effective way to generate the report so that

the user can continue working while it is being generated. This typically occurs when a report may contain greater than

10,000 items. In such cases instead of requiring the user to wait for the report to be generated (which would prevent the

user from doing any work in the system), GRC Cloud will inform that the report is being queued for.

The number of hours reports remain available in the Parallel Processing Engine queue is set in System Settings. This

avoids unnecessary storage of reports which would occupy server disk space unnecessarily. Previously this time period

was set to 72 hours. The System Settings value will automatically account for weekends, but not public holidays.

Note: GRC Cloudmakes its own determination whether to use the Parallel Processing Engine for each report. The user

cannot select whether to use this feature or not.

1. Run a report in the normal way (See Reports section for more information).

2. If required, amessage will appear stating “Report requested is over a certain size. The report will be sent to the Par-

allel Processing Engine”.

3. Select a name for the report. There is also an option to add a description.

4. Click Add to Queue. A confirmation appears stating: “Your report request has been sent for processing. You can

check the status of this request in System-Queued Requests”.

5. Click theSystem-Queued Requests link to view the status of the report. If the status is completed, click on the

report name to view the report.

6. Reports generated via the Parallel Processing Engine are listed under Tools > Queued Reports. They are also

visible through the Saved Reports option under Report > Item Overview, Report > Summary Report or Report >

Hierarchical Report, or through theMyReports feature on the user home page when this option is activated. In
each case the generated reports are located underQueued Reports.

Saving Reports generated by the Parallel Processing Engine

1. Open the report, which will be located underQueued Reports under theSaved Reports tab on the Item Over-

view Report, Summary Report or Hierarchical Reports screens.

2. To save a snapshot, click Save Snapshot, then enter a name, optional description and click Save.

3. To save the report settings click Rebuild, then theSaved Reports tab. Click AddNew Report and then enter a
name, optional description and click Save as normal.

Saving and Sharing Reports

There are two ways to save reports in GRC Cloud: Save Settings or Save Snapshot. Save Settings allows you to configure

or customize a report to produce exactly what you want and then save those settings to be re-run at a later date. Saved set-

tings will always produce reports with the latest data. Saved Snapshots will capture the data that you have generated in



your report and save the content. If you view a saved snapshot at a later date the content is the old content (the way the

system was when you ran the report).

Saved reports are available for Summary Reports, Item Overview Reports and Hierarchical Reports.

The information visible in all reports is restricted to items for which the user has at least read permission. Administrators

can view all items.

Live Reports: allow users to create, share and update reports across the system in real time. Changes made to the report

will automatically update across all the users it was originally shared with. (6.3)

Create a New Report, Save the Settings and Share

1. Click onReport > Item Overview, Report >Summary Report orReport > Hierarchical Report.

2. The Report Builder page will appear. (For Item Overview Reports, the first page of the report will appear).

3. Click on theSaved Reports Tab.

4. Click theNew Report button.

5. The Report Properties pane will appear.

6. Input the name and description for the report.

7. Click Save. You now have a blank report loaded.

8. Customize your report as you normally would. For more information see Item Overview Reports, Hierarchical

Reports or Summary Reports.

9. Before you click Generate Report return to the Saved Reports tab and click Save to save the exact settings.

Sharing Reports

Note: if a user does not have access previously granted via the live report, it will automatically grant access to it when the

user clicks the report and enters the system.

10. To Share Reports with other users, scroll to the bottom of the Report Properties panel.

11. Changes to Sharing a Copy: Identify users or groups from theShare a Copy list provided by checking the appro-

priate boxes in the pop up.

Note: the selected users will not be kept after Save. If the report needs to be shared again, re-pick the

users and Save. If modifying and re-sharing, the Live reports are a more practical feature to utilize.

Report ownership was designed to work with users only. Only a single person can own a report. There is currently

no support for groups.When sharing with a group, users get extracted and shared with eachmember.

12. Changes to Sharing a Copy: Click theSave (Share a Copy has been removed) button at the top of the screen. The

report will appear in each selected user's Saved Reports section under the headingShared Reports.

13. Sharing a Live Report: Identify users or groups from theShare a Live Report list provided by checking the appro-

priate boxes in the pop up.





14. Sharing a Live Report: Click theSave button at the top of the screen. The report will appear in each selected user's

Saved Reports section under the headingShared Reports.

15. Sharing a Live Report: Any changes made to the Live Shared report will automatically update all users listed in the

Share a Live Report section of the report properties. Only the user that created and shared this report will be able to

view the list of users.

Note: Sharing Live Reports does NOT apply to Saved Charts.

Live Reports can be shared with Groups, however, if a user is removed from that group they will main-

tain access to the live report. They need to be removed specifically from the Live report (via the report

properties)

Create a New Report, Save a Snapshot and Share

1. Click on Report >Item Overview, Report > Summary Report orReport > Hierarchical Report.

2. The Report Builder page will appear. (For Item Overview Reports, the first page of the report will appear).

3. Customize your report as you normally would. For more information see Item Overview Reports, Hierarchical

Reports or Summary Reports.

4. After you click Generate Report, click Save Snapshot.

5. The Save Report Snapshot page will appear.

6. Input the name and description for the report. A datemarker is automatically supplied in the name. It is rec-

ommended that you leave this as it shows what time and date the content of this report refers to.

7. You have now saved a snapshot of the report.

8. To Share Reports with other users, after saving the report, click Rebuild thenSaved Reports to return to the
report list.

9. Click on the name of the saved snapshot in the list in the left side of the screen.

10. Click Load to re-open the snapshot report and scroll to the bottom of theReport Properties panel.

11. Changes to Sharing a Copy: Identify users or groups from theShare a Copy list provided by checking the appro-

priate boxes in the pop up.

Note: the selected users will not be kept. If the report needs to be shared again, re-pick the users. If mod-

ifying and re-sharing, the Live reports most likely a better feature to utilize.

12. Changes to Sharing a Copy: Click theSave (Share a Copy has been removed) button at the top of the screen. The

report will appear in each selected user's Saved Reports section under the headingShared Reports.

Edit a Saved Report

1. Click onReport >Item Overview, Report >Summary Report orReport > Hierarchical Report.

2. Click on theSaved Reports tab.

3. Click on the report you wish to load.



4. Click the Load button.

You can only load a report of the same type as the page you are on. (Saved Summary Reports can only be loaded on the

Summary Report page. Saved Hierarchical Reports can only be loaded on the Hierarchical Report page.) If you click on a

Summary Report while on the Hierarchical Report page it will display the report information but you cannot load or run the

report.

5. The Report Builder page will appear.

6. If you wish tomodify the name or description of the report click on theSaved Reports tab.

7. Customize your report as you normally would. For more information see Item Overview Reports, Hierarchical

Reports or Summary Reports.

8. Before you click Generate Report return to theSaved Reports tab and click Save.

You can also load a report by clicking on it from the homepage. To add reports modify your homepage preferences. For

more information see System > My Profile.

Run a Saved Report

1. Click onReport >Item Overview, Report >Summary Report orReport > Hierarchical Report.

2. Click on theSaved Reports tab.

3. Click on the report you wish to run.

4. Click the Loadbutton.

You can only load a report of the same type as the page you are on. (Saved Summary Reports can only be loaded on the

Summary Report page. Saved Hierarchical Reports can only be loaded on the Hierarchical Report page.) If you click on a

Summary Report while on the Hierarchical Report page it will display the report information but you cannot load or run the

report.

5. Click Generate Report.

You can also load a report by clicking on it from the homepage. To add reports modify your homepage preferences. For

more information see System > My Profile.

Delete a Saved Report

1. Click onReport > Item Overview, Report >Summary Report orReport > Hierarchical Report.

2. Click on theSaved Reports tab.

3. Click on the report you wish to delete.

4. Click theDelete Selected button.

5. The page will refresh and a confirmation screen will display

6. Click Delete Permanently.



Move a Saved Report

1. Click onReport >Item Overview, Report >Summary Report orReport > Hierarchical Report.

2. Click on theSaved Reports tab.

3. Click on the report you wish tomove.

Drag it into the target folder. If you are unable tomove the report to or from a specific folder (for example, to or from queued

reports) an error message will appear to advise you themove is not possible.

Create a Folder to Store Your Reports In

1. Click onReport >Item Overview, Report >Summary Report orReport > Hierarchical Report.

2. Click on theSaved Reports tab.

3. Click on the folder to which you would like to add a sub-folder.

4. Click Create Sub-Folder.

5. Enter a name and description for the new folder.

6. Click Save so save your folder.

Delete a Folder with Stored Reports

1. Click onReport > Item Overview, Report > Summary Report orReport > Hierarchical Report.

2. Click on theSaved Reports tab.

3. Click on the Folder you would like to delete.

4. Click Delete Selected.

5. The page will refresh and a confirmation screen will display.

6. Click Delete Permanently.

Deleting a Folder will cause all Child Reports and Folders to be deleted as well.

Accessing Saved Reports from the Homepage

If theMy ReportsHomepage Preference is selected, your Homepage will display a list of all Saved Reports, Shared

Reports, Queued Reports and Report Folders that have been created (SeeSystem > MyProfile for detailed information
about Homepage Preferences).

See Saved Reports from the Homepage

1. After logging in or by clicking theResolver Icons at the top left or top right of the screen.

2. Your Homepage will appear.



3. Click on a Saved Snapshot or Saved Settings Report.  (If Folders are listed, click the + sign to expand and display

the Reports located inside.)

4. The corresponding Report or Report Builder will display.

Drag and Drop Reports and Report Folders

1. After logging in or by clicking theResolver Icons at the top left or top right of the screen.

2. Your Homepage will appear.

3. Click on and drag a Report or Report Folder and drop it onto another Parent Report Folder.

4. The Report or Report Folder will now have a different Parent Report Folder.

Chart Builder

Chart Builder is a comprehensive and flexible tool for building graphs that display information from your framework item

assessments and function results in a variety of formats.

Chart Builder can be accessed from several GRC Cloud screens. For more details see these sections:

● Hierarchical Report

● Item Overview Reports

● Manage by Location (Right-Click Menu)

● Manage by Scoping Items (Right-Click Menu)

After entering the Chart Builder, you will be in the first of three screens used to build a chart.

FromSelect a Chart Type click on the image that most closely resembles the chart you are attempting to generate. The
available options are:

● Bar charts (vertical)

● Bar charts (horizontal)

● Line charts

● Line/Bar Combination

● Pie charts

● Doughnut Charts

● Scatter Charts

● Cross Table Charts



Scatter & Cross Table Charts

Scatter and Heat MapCharts enable the simultaneous graphing of two or more series of data with a number of points on a

chart. For example, a common scatter chart involves graphing several risks’ likelihood assessment on one axis and their

impact assessment on the other.

Scatter Charts

Scatter Charts represent the values related to individual items graphed by 2 or more criteria.

Function results can now be included in Scatter Charts/Heat Maps. In GRC Cloud Scatter Charts and Cross Table Charts

represent your information in slightly different ways.

For example, for a series of risks where there are three assessments and one function, the graph could be set up to display

the following:

Data Series Displayed As

Risk Likelihood (assessment) X-axis

Risk Impact (assessment) Y-axis

Ability to Mitigate Risk (assessment) Size of data point

Overall risk score (function of likelihood + impact – ability to mit-
igate

Color of data point

Generating a Scatter Chart

1. Select an Item.

The box illustrates the relational structure of the data you selected to chart. The diagram represents the rela-

tionships between items and criteria in a similar hierarchical format to Manage by Location screens. If you selected

more than one type of item (for instance control objectives, risks and controls) the relationship between these is

shown in a tree format. Clicking on the + sign adjacent any Item will display Item sub-types.

Select the Item to be graphed. It may be any Item or Item subtype in the hierarchy. Click Select Item.

2. Four boxes appear allowing you to select data to be graphed on 4 axis:X-axis, Y-axis, data point size & data point

color. Beside each item for which there are available numerical criteria a + sign will appear for Attributes and Eval-

uations and Function results. Use these to navigate to the required criteria for each axis and click the name of the

criterion. It will be highlighted in blue. Note that the Size and Color axes are optional.

3. Click Generate Chart. A standard Scatter Chart is displayed.

4. The following Series Customization Options are available for Scatter Charts.

● Label Display Format: Select any combination of five items to appear as a label on the pie segments.



● Legend Index: The value assigned to each scale choice in Criteria Builder.

● Item Number: The Item’s assigned reference number in the organizational framework.

● Item Name: The Item’s assigned name in the organizational framework.

● Coordinates: The assessment values related to each item based on 2, 3 or 4 criteria.

● Custom Label: Alternative Labels may be defined, along with a color, whichmay be selected from the color picker.

● Data Point Size: This can be changed to help legibility.

5. The following Axis Customization Options are available for scatter charts:

● Customize Axis: Changes the appearance of the X and Y axes. TheMinimum will default to 0, unless there are

negative values. TheMaximum will default to the highest value. The interval sets the distance between the data

points on the X and Y axes. The larger the number, the greater the interval between the data points.

6. The following Axis Customization Options are available for scatter charts:

● Chart Size: Charts can be displayed in three standard sizes. The default size is Medium. The sizes are as follows.

Graph Size Width Height

Small 300 200

Medium 600 400

Large 1024 768

Use the drop downmenu to select one of the three sizes above or to set a custom size defined in pixels.

● Chart Background Image: An image can be displayed in the background of a chart, such as a heat map back-

ground or company logo. To add an image, check the box and then browse your hard drive or network drive for an

image. Note that any image will be resized to fit the background of the graph and therefore images may become dis-

torted.

● Color Template: Various alternative color schemes can be selected from the drop down list.

Cross Table Charts

Cross Table Charts display the frequencies for assessment scores on 2 axes enabling an alternative view of the frequency

of assessment scores. In a Cross Table Chart, each data point represents the incidence of an item receiving a ranking on

two scales. For example in the illustration below 6 risks are shown, assessed on likelihood and impact, each on 3-point

scales.



The chart illustrates the following assessments.

Combination of impact and like-
lihood

Frequency

Impact =1, Likelihood =1 Did not occur

Impact =1, Likelihood =2 Occurred once

Impact =1, Likelihood =3 Did not occur

Impact =2, Likelihood =1 Occurred 3 times

Impact =2, Likelihood =2 Did not occur

Impact =2, Likelihood =3 Occurred once

Impact =3, Likelihood =1 Occurred once

Impact =3, Likelihood =2 Did not occur

Impact =3, Likelihood =3 Did not occur

This chart therefore indicated that there was a concentration of risks that were of low impact andmedium likelihood. In fact

a total of 4 risks out of the 6 had low likelihood and 4 out of the 6 hadmedium impact.

Generating a Cross Table Chart

 Use the following steps to generate a Cross Table Chart.

1. Select an Item

The box illustrates the relational structure of the data you selected to chart. The diagram represents the rela-

tionships between items and criteria in a similar hierarchical format to Manage by Location screens. If you selected

more than one type of item (for instance control objectives, risks and controls) the relationship between these is

shown in a tree format. Clicking on the + sign adjacent any Item will display Item sub-types.



Select the Item to be graphed. It may be any Item or Item subtype in the hierarchy. Click Select Item.

2. Four boxes will appear allowing you to select data to be graphed on the X-axis and Y-axis. Beside each item for

which there are available numerical criteria a + sign will appear for Attributes and Evaluations. Use these to navi-

gate to the required criteria for each axis and click the name of the criterion. It will be highlighted in blue. ClickGen-
erate Chart. A cross table chart is displayed.

3. The following Series Customization Options are available for scatter charts.

● Label Display Format: Select any combination of five items to appear as a label on the pie segments.

● Legend Index: The value assigned to each scale choice in Criteria Builder.

● Item Number: The Item’s assigned reference number in the organizational framework.

● Item Name: The Item’s assigned name in the organizational framework.

● Coordinates: The assessment values related to each item based on 2, 3 or 4 criteria.

● Custom Label: Alternative Labels may be defined, along with a color, whichmay be selected from the color picker.

● Data Point Size: This can be changed to help legibility.

4. The following Axis Customization Options are available for scatter charts:

● Customize Axis: Changes the appearance of the X and Y axes. TheMinimum will default to 0, unless there are neg-

ative values. TheMaximum will default to the highest value. The interval sets the distance between the data points on

the X and Y axes. The larger the number, the greater the interval between the data points.

5. The following Axis Customization Options are available for scatter charts:

● Chart Size: Charts can be displayed in three standard sizes. The default size is Medium. The sizes are as follows.

Graph Size Width Height

Small 300 200

Medium 600 400

Large 1024 768

Use the drop downmenu to select one of the three sizes above or to set a custom size defined in pixels.

● Chart Background Image: An image can be displayed in the background of a chart, such as a heat map back-

ground or company logo. To add an image, check the box and then browse your hard drive or network drive for an

image. Note that any image will be resized to fit the background of the graph. Therefore images may become dis-

torted.

● Color Template

Various alternative color schemes can be selected from the drop down list.



Pie Charts & Doughnut Charts

Pie charts and doughnut charts are identical in how the operate and what they illustrate. The only difference between them

is their appearance. This section will refer to pie charts, but the instructions for both pie charts ad doughnut charts are iden-

tical.

Pie charts graph one series of data. They are useful for seeing the relative occurrence of given values within a set. For

example: the relative frequency of high, medium and low ratings for control effectiveness from a list of controls.

Generating a Pie Chart

 Use the following steps to generate a pie chart.

1. Select the information to be included in the Chart.

The box illustrates the relational structure of the data you selected to chart. The diagram represents the rela-

tionships between items and criteria in a similar hierarchical format to Manage by Location screens. If, before enter-

ing the Chart Builder, you selectedmore than one type of item from the Hierarchical Report or Right-Click Menu in

theManage by Location section (for instance control objectives, risks and controls) the relationship between these

is shown in a tree format. Below each item type is a branch representing any Attributes, Evaluations and Function

Results associated with the item.

Clicking on the + sign adjacent to the Attributes and Evaluations provides a list of all criteria for which a numerical

value has been captured. This could be an entered numerical value, a numerical value that relates to a selection

from a check box, radio button or drop down list item, or the results from a function. (Function results must be

expressed as ranges in order to be graphed.)

Select the single criteria or function to be included in the graph, by clicking on it. Clicking highlights the choice in

blue. The selectionmust be a criteria or function, not an item.

2. Select an Evaluation Period to Display.



If there aremultiple periods of data recorded (i.e. when a Period End process has been run) then it is necessary to

select one of the periods. If no Period End has been run the only choice available will be Current.

3. Click Generate Chart. A standard pie chart is displayed.

4. The following Series Customization Options are available for pie charts.

● Label Display Format: Select any combination of five items to appear as a label on the pie segments.

● Index: The value assigned to each scale choice in Criteria Builder.

● Label Name: The text name assigned to each scale choice in Criteria Builder.

● Count: The number of times the value occurs in the range selected. For instance, the number of controls listed as

being Ineffective out of all the controls graphed.

● Percentage: The count expressed as a percentage of the total.

● Custom Label: Alternative Labels may be defined, along with a selected color and whether the pie segment should

be exploded (shown as separate from the rest of the pie chart.)

5. The following Appearance Customization Options are available for pie charts:

● Chart Size

Charts can be displayed in three standard sizes. The default size is Medium. The sizes are as follows.

Graph Size Width Height

Small 300 200

Medium 600 400

Large 1024 768

Use the drop downmenu to select one of the three sizes above or to set a custom size defined in pixels.

● Color Template

Various alternative color schemes can be selected from the drop down list.

Column Charts & Bar Charts

ColumnCharts and Bar Charts are identical in function, except that the axes are inverted for Bar Charts. Column and Bar

Charts are themost sophisticated chart type in GRC Cloud with a variety of tools for sorting and grouping data and cus-

tomizing the display.

The following instructions refer to Column charts but the same instructions will apply to Bar charts except where ref-

erences aremade to the X and Y axes.

Themajor areas discussed in this document are:

● Creating a ColumnChart, and differences between "Count of Item" Charts and "Criteria Value/Function" Charts

● "Count of Item" Chart Examples



● "Count of Item" Chart Information Grouping

● "Criteria Value/Function" Chart Examples

● "Criteria Value/Function" Information Grouping

● Customization Options

Criteria Function Chart Examples

Criteria/Function Charts display data on the assessment results or function results of individual assessed items (as

opposed to Count Charts which aggregate data to count the frequency of certain assessment scores).

Example A:
Graph the Impact and Likelihood for a series of risks.

1. What do you want to chart? From the drop downmenu select Criteria/Function Value.

2. What information do you want in the Chart?Within the box, navigate to the risks and check the boxes adjacent to

the appropriate criteria item types. 

3. Leave the “Group information for Level 1 at its default setting of N/A.

4. Click Generate Chart.
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Criteria/Function Charts display data on the assessment results or function results of individual assessed items (as

opposed to Count Charts which aggregate data to count the frequency of certain assessment scores).
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1. What do you want to chart? From the drop downmenu select Criteria/Function Value.



2. What information do you want in the Chart?Within the box, navigate to the risks and check the boxes adjacent to

the appropriate criteria item types. 

3. Leave the “Group information for Level 1 at its default setting of N/A.

4. Click Generate Chart.

Saving and Sharing Charts

There are two ways to save charts in GRC Cloud: Save Settings or Save Snapshot. Save Settings allows you to configure

or customize a report to produce exactly what you want and then save those settings to be re-run at a later date. Saved set-

tings will always produce reports with the latest data. Saved Snapshots will capture the data that you have generated in

your report and save the content. If you view a saved snapshot at a later date the content is the old content (the way the

system was when you ran the report).

Saved reports are available only for Summary Reports, Item Overview Reports and Hierarchical Reports.

The information visible in all reports is restricted to items for which the user has at least read permission. Administrators

and Reporting GroupMembers can view all items.

Save Chart Settings and Share

1. From within the Chart Builder area, click on theSaved Charts Tab.

2. Click theNew Chart button.

3. The Report Properties pane will appear.

4. Input the name and description for the report.

5. Click Save. You now have a blank chart loaded.

6. Customize chart as you normally would.

7. Before you click Generate return to the Saved Reports tab and click Save

8. To Share Charts with other users, scroll to the bottom of the Report Properties panel.

9. Identify users or groups from the list provided by checking the appropriate boxes.

10. Click theShare a Copy button at the top of the screen. The chart will appear in each selected user's My Reports

section in theShared Reports area.

Save Chart Snapshot and Share

1. Within the Chart Builder area, customize your report as you normally would.

2. After you click Generate, click Save Snapshot.

3. The Save Chart Snapshot page will appear.



4. Input the name and description for the chart. A datemarker is automatically supplied in the name. It is rec-

ommended that you leave this as it shows what time and date the content of this report refers to.

5. You have now saved a snapshot of the charts. Click OK.

6. To Share Charts with other users, after saving the report, access theSaved Charts tab to return to the chart list.

7. Click on the name of the saved snapshot in the list in the left side of the screen.

8. Click Load to re-open the snapshot chart and scroll to the bottom of theReport Properties panel.

9. Identify users or groups from the list provided by checking the appropriate boxes.

10. Click theShare a Copy button at the top of the screen. The chart will appear in each selected user's My Reports

section under the headingShared Reports.

Edit a Saved Chart

1. In the Chart Builder area, click on the chart you wish to load.

2. Click the Load button.

3. The Report Properties page will appear.

4. If you wish tomodify the name or description of the report click on theSaved Charts tab.

5. Customize your report as you normally would.

6. Before you click Generate return to theSaved Charts tab and click Save.

You can also load a report by clicking on it from the homepage. To add reports modify your homepage preferences. For

more information see System > My Profile.

Recreate a Saved Chart

1. From within the Chart Builder area, click on the report you wish to run.

2. Click the Load button.

3. Open theChart tab and change options as required.

4. Click Generate.

Create a Folder to Store your Charts In

1. Within Chart Builder, click on theSaved Charts tab.

2. Click on the folder to which you would like to add a sub-folder.

3. Click Create Sub-Folder.

4. Enter a name and description for the new folder.

5. Click Save so save your folder.



Move a Saved Chart

1. In theMy Reports area of the home page click on any chart to open up theChart Builder > Saved Charts tab.

2. Click on the chart you wish tomove.

3. Drag it into the target folder.

Delete a Folder with Stored Charts

1. Within the Chart Builder, click on theSaved Charts tab.

2. Click on the Folder you would like to delete.

3. Click Delete Selected.

4. The page will refresh and a confirmation screen will display

5. Click Delete Permanently.

Deleting a Folder will cause all Child Charts and Folders to be deleted as well.

Accessing Saved Reports from the Homepage

If theMy Reports Homepage Preference is selected, your Homepage will display a list of all Saved Reports, Shared

Reports, Saved Charts, Queued Reports and Report Folders that have been created (SeeSystem > MyProfile for
detailed information about Homepage Preferences).

See Saved Charts from the Homepage

1. After logging in or by clicking the Resolver Icons at the top left or top right of the screen.

2. Your Homepage will appear.

3. Click on a Saved Snapshot Chart or Saved Settings Chart.  (If Folders are listed, click the + sign to expand and dis-

play the Reports located inside).

4. The corresponding Chart will display.

Drag and Drop Charts and Chart Folders

1. After logging in or by clicking the Resolver Icons at the top left or top right of the screen, your Homepage will

appear.

2. Click on and drag a Report or Report Folder and drop it onto another Parent Report Folder.

3. The Report or Report Folder will now have a different Parent Report Folder.



Editable Reports

Editable Reports will allow administrators to build a very specific process out for their users. Users can log into the system,

load reports, and review and edit all in one step. With the click of amouse, all criteria types are available for edit and saved

directly to the database. Upon completion of the edit and review, workflow is also available to transition the items to the

next state to finalize the task. All this can be done without having to access any other part of the application.

No set up is required. All reports built prior to 6.3 will automatically inherit this functionality.

Feature Overview:

Quick edit of all criteria types

Includes the edit of all criteria types available in the system.

Cannot edit Name, Number, Description, Sub Types

Assessing Criteria Items (Assessments automatically saved to the database)

1. Editable cells are indicated by a pencil icon

2. Permissions determined on click and will indicate no entry icon

3. Each time a criteria pop up is closed (3 ways) it saves directly to the database:

a. Selecting a value (single user list, radio button, drop down, dates)

b. Clicking off the criteria pop up

c. Clicking the green check mark

4. Spinner will indicate the value is being saved (see image below)

5. All saved criteria fields will be indicated with green check mark (see image below)

6. Values failing validation (alpha numeric value in a numeric field), will be indicated by anX.
a. Icon will remain until it is corrected.



b. Invalid value will remain in the criteria when accessed again

7. Each Criteria type has an option to insert a tool tip to help guide the user in assessing the criteria.

(Available during criteria creation and edit)

Available in all styles of report

Item Overview and the 6 styles of Hierarchical Reports (Matrix Merger, Matrix Unmerged, Spreadsheet, List

Horizontal, List Vertical, Unformatted List)

Option to transition workflow

Users maintain the ability to transition items from one state of the workflow to another via Editable Reports.

1. Transition a single item: clicking on the workflow state name for an individual item will bring up the

associate triggers for that state of the workflow. Clicking the trigger here behaves no differently than

inManage by or Matrix Assessor.

2. Transition multiple items in the same state: following the same steps above (clicking the work-

flow state name for an item) produces the same pop up; however, if user selects the additional option

to transition "All items in this State", it will attempt to transition all items in the report that are of same

state.

3. Identifying Triggers in reports: trigger options are identified in report in 2 ways (Workflow Icon and

Thicker Blue Boarder)



Example: mass transition all items from Draft Issue to In Progress

Note: only the items on the page the user resides on in Item Overview will bemass transitioned. Not

all items across multiple pages.

Additional Workflow Options:

1. State Instructions:mouse over of the ? in the workflow transition pop up will detail the state instruc-

tions. Additionally, if instructions longer than 200 characters were provided, a click of themouse will

provide a pop up detailing the instructions in its entirety.

2. Trigger Instructions: mouse over any trigger will detail the trigger instructions for each trigger shown

to the user.

Access to the view item (attach files / manage permissions / create new items)

Previously in 6.3, users could use the item name link in the report to navigate to the item inManage By. We



havemodified this link in 7.0. Clicking the link will now pop up the view item (seen inManage By) allowing

the user to alter addition attributes of the item.

Additional Options:

1. Edit of Name, Number, Description, Sub Types

2. File Attachments

3. PermissionManagement

4. Creation of new items

Note: with each action performed above, the report will not automatically update. Please use

the Refresh button in the button bar to update the reports with the changes in the view item

pop up. Refresh will remove all indicators of actions taken (save / invalid results).

Functionality removed from the standard view item and not possible while in reporting:

1. Workflow transitions

2. Deleting of items

3. Unlinking of items (Manage by Scoping context)

Revert changes

After editing each value, if a mistake was made, there is an option to revert the edited value back to the previous value. Val-

uable after multiple edits within the report, the user can review all changes (indicated by the check mark) and if felt a

change was made in error, they can revert without having to remember the previous assessments.

1. Only reverts back one assessed value

2. Available to the user that assessed the value last

3. If another user edited the value, option to revert is lost

4. Available to the user until the value is update (as indicated in #3)

5. Automatically saved to the database after clicking Revert



Calculate Functions

Functions can now be recalculated by manually clicking the function in the report. Each cell function that is available for

recalculation will be indicate by a refresh icon. Permissions remain in place and will block the user from calculating if only

read permissions were granted. (7.1)

Additionally, hovering over the function cell, an option will appear as a tool tip to calculate all the functions that apply to the

item (see image). Any functions in the report that draws from other functions will recalculate to send themost updated

value; however, the function will not visually update. A report refresh would be required in this scenario.

Rich text report description available in report header

The report description - found in the report properties tab - has been upgraded to support rich text elements, as well as,

show when the report is displayed. This will allow users to gain additional direction to what actions need to be taken to com-

plete their task(s).

Clicking on the text field for the description will engage rich text options.

Description Changes:

1. Supports rich text

2. Option to embed links

3. Description of the report is now visible in all Hierarchical Report types

4. Default open when the report is generated



Additional Information

1. Past Period data and signed off items will always appear in read only.

2. Queued Reports are not supported in Editable format.

3. Most recent values always persist.

If multiple users are working on the same report, when user A accesses a criteria that user B has changed, the value

shownwill display user B's changes. Therefore, the value seen in the report may not be the same as the

value in the pop up.

4. Having permissions in one area of the tree to edit vs read in another for the samemulti > you will always be able to

edit both instances in report (opposed to edit /read in Manage by Location).

5. Typing a value with a comma in the numeric field will remain in the field (example: 5,00) even after it is saved. Vis-

ually it appears as 5,00 in editable reports until refreshed.

6. Rich Text Editor and Spreadsheet Criteria do not pop up if the user does not have permissions OR is past period

data.

Overriding Editable Reports

Editable reports can be restricted to ReadOnly. All inline edit-ability of the report gets removed for all users, including

administrators. If themain intention of the report is for review of the data, it is recommend this setting be enabled. (7.1)

1. Load the saved report

2. Go to theSaved Reports tab

3. Scroll theReport Properties



4. Check the InlineEditing: Prevent users from editing report data

5. Save

Note: Item links triggering the view item pop up and the View Item in Tree pop up remain available for navigation; however,

any updates made to in the view item pop require a report refresh to reflect the changes.

Advanced Reporting and Analytics

Analytics Page

Is utilized to view the advanced reports and analytics defined via theManage Analytics page.

Component of the Analytics Page

1. Menu: Available via the Reports menu.

2. Analytic Reportswill appear on this page if configured via theManage Analytics page.

3. Visibility of reports is determined by the administrator when configuring the report.

4. Visibility Flags:

a. None: no user see it on the Analytics page

b. Users: all users see it on the Analytics page

c. Administrator: only administrator see it on the Analytics page

5. Clicking on the report:

a. Generates a report embedded in GRC Cloud.

b. Passes in that item id and generate the report from that focus (if defined in the report).

c. Sets the users focus.

6. Filter by Focus is enabled it will pass in the starting point and generate the report parameters off that starting point.



7. Tableau and Crystal reports are part of the GRC Cloud Enterprise Edition. Please contact Resolver Client Care or

visit our website to learnmore.

http://www.resolvergrc.com/grccloudenterpriseedition/


System Administration
The Administration area is where Administrators manage key elements of the system.

The key areas include:

● Criteria

● Item Templates

● Frameworks

● GRC Programs

● Users / Groups

● Roles

● System Settings

● Period End

My Profile

In this section users canmodify their own profile settings.

1. Modify Your Profile
2. Change Full Name
3. Change Email Address
4. Change Password
5. Change ChallengeQuestion (Functionality Removed in 8.1.1)
6. Change Homepage Preferences
7. Change Data Preferences (view past period data)
8. Two Factor Authentication
9. File Permissions
10. ChangeGroupMembership

Modify Your Profile

1. Click onUsername in Menu > My Profile.

2. TheManage User Profilewindow will appear.

There are four tabs available in theManage User ProfileWindow, General, Homepage Preferences, GroupMembership

and Permissions. While on any tab, the content window toolbar offers the ability to change password, change challenge

question, save or cancel.



Change Full Name 

1. Click onUsername in Menu > My Profile.

2. TheUser Profilewindow will appear.

3. Under theGeneral tab, modify the name in the Full Name text box.

4. Click Save to apply your change(s).

Change Email Address

1. Click onUsername in Menu > My Profile.

2. TheUser Profilewindow will appear.

3. Under theGeneral Tab, modify the name in theEmail Address text box.

4. Click Save to apply your change.

Change Culture

GRC Cloud’s interference can appear in different languages, date formats and number formats for different users. The user

Culture option determines which of the available cultures are viewed by the user, either based on their browser settings or

by setting a culture preference to the user profile. If the browser culture setting is selected, but is for a culture not currently

available within GRC Cloud, the default culture from System Settings will apply.

1. Click onUsername in Menu > My Profile.

2. TheUser Profilewindow will appear.

3. Under theGeneral tab, enter the Culture Options. These define the language of the interface and formats for

numbers and dates. Select whether the Culture is based on the user’s Browser Settings of their User Profile in

GRC Cloud. Then select the required culture. (Example, French Canada) If the desired culture is not available,

please contact Resolver to have a culture option added to your site. (Translation fees may apply)

4. Click Save to apply your changes

Change Password

1. Click onUsername in Menu > My Profile.

2. TheUser Profilewindow will appear.

3. Under any tab, click theChange Password button on theContent Window Toolbar.

4. Type in the user’s current password.

5. Type in the user’s new password and retype the password to help avoidmistakes.

6. Click theSave button to apply change.



Change Challenge Question - Functionality Removed in 8.1.1

1. Click onUsername in Menu > My Profile.

2. TheUser Profilewindow will appear.

3. Under any tab, click theChange ChallengeQuestion button on theContent Window Toolbar.

4. Choose the preferred challenge question from the drop downmenu.

5. Type in the answer to the selected challenge question.

6. Click theSave button to apply the change.

Change Homepage Preferences

1. Click onUsername in Menu > My Profile.

2. TheUser Profilewindow will appear.

3. Click on theHomepage Preferences tab.

4. Check the box beside any information to display on your homepage.

● Pie Charts and starting point. There is typically one pie chart for each criteria that can be charted in addition

to a starting point for reporting purposes

● Include Information Boxes: Determines whether to display theMy Messages box and theMy Reports box.

The Reports box, which shows saved and shared reports, can be configured to have a specific action for a

mouse left click. It can be set to either open the report itself, open the report builder, or go straight to Matrix

Assessor. and aMy Messages box which displays recent automatedmessages generated by GRC Cloud.

● Determine whether the homepage displays is based on the user's personal profile or one or the profiles of

one or more groups of which the user is amember.

5. Click Save to apply your change(s).

My Reports box displays with the width of two pie charts and always appear at the top of the home page. It can be con-

figured for a specific action to take place when the report is left-clicked: either open the report, open the report builder, or

open the data in Matrix Assessor.

Change Data Preferences

In Data Preferences, there are twomethods for selecting the past periods to be viewed by default. In addition to selecting

the required periods from a drop downmenu, the user can also choose to select a number of periods. This number rep-

resents the number of periods prior to the current period to be included. The previous periods selected in Data Preferences

will also appear by default in Item Overview reports.



1. Click onUsername in Menu > My Profile.

2. TheUser Profilewindow will appear.

3. Click on theData Preferences tab.

4. To enable the ability to view past period data, check the box marked "Display Past Period Data".

5. To select the periods to be viewed inManage by Location, Matrix Assessor, Chart Builder and Item Overview

reports, either:
● select the required periods from the list, by checking the appropriate boxes.

or

● select the number of previous periods to be included. This will show the last "N" periods, where N is the

number selected . This option is useful for saved reports which will be re-run in the future, as it is not nec-

essary to reselect items each time the report is run.

6. To select the evaluation criteria and functions to be viewed inManage by Location, Matrix Assessor and Chart

Builder, select the required items from the list, by checking the appropriate boxes.

7. Click Save to apply your change(s).

File Permissions

Only Administrator GroupMembers can edit these permissions. All other users can only view their permissions.

1. Click onUsername in Menu > My Profile.

2. TheUser Profilewindow will appear.

3. Click on the File Permissions tab. All Items that the user has access to are displayed here. If this page is blank, it

means you do not have any permission to any files.

4. File permissions can bemodified by selecting/deselecting the appropriate boxes.

5. To remove all permissions from a File click theX at the end of the row, or deselect all boxes and click Save.

6. To add permissions to a new File not listed here click theAdd Files button.

7. A list of all file available in the system will appear. Select the box beside the File you wish to assign permissions

to.

8. Click Add Selected Files.

9. The new File is now at the bottom of the list, and has been automatically assigned a Read only permission. This

can be changed to Edit rights by checking the appropriate box.

10. Click Save to apply your change(s).



Change Group Membership

Only Administrator GroupMembers can edit these permissions. All other users will see aGroupMembership page that is

grayed out.

GroupMembership allows administrators to assign the same permissions tomany users. Include the user in a group, and

set the permissions for the group as a whole inSystem > Administration > Groups.

1. Click onUsername in Menu > My Profile.

2. TheUser Profilewindow will appear.

3. Click on theGroupMembership tab.

4. TheGroupMembership tab allows you to change what groups the user is a part of.

5. The left box lists available groups, groups that are in the system, but that the user does not belong to.

6. The right box lists the groups that the user is already part of.

7. To add the user to a group highlight the group in the left box and click the arrow pointing to the right to move the

selected group to the other side.

8. To remove the user from a group highlight the group in the right box and click the arrow pointing to the left to move

the selected group to the other side.

The system has four default groups: Administrators, Reporting, External and Everyone.  These groups cannot be deleted.

My Inbox - Functionality Retired in v8.0Only available to Survey users.

My Inbox is an area that can be set up on a user's homepage and contains automatic applicationmessages addressed to a

user’s email. This includes mail from theGRC Cloud application concerning all matters pertaining to that specific user. Mail

will remain in the inbox indefinitely unless a user decides to delete them.

Your inbox displays a list of messages on the framework panel andmessage contents on the detail panel. Your most

recent messages are displayed first however you can sort messages according to their date or subject.

A closed envelope designates an unopenedmessage, whereas an open envelope indicates that amessage has been read.

Information contained in amessage’s content includes themessage sender and receiver, the subject, date and time. When

you click on a link displayed, you are automatically taken to it.

1. Read aMessage

2. Delete aMessage

3. ApplicationMessages



Read a Message

1. Click onSystem > My Inbox.

2. Click on the Subject of the email you wish to view.

3. The email information will open in the detail panel.

4. Links to the Items will be provided within the email based on the type of notification. Click on the link to go straight

to the Item the email referred to.

Delete a Message

1. Click onSystem > My Inbox.

2. Check off the box next to the correspondingmessage, then click the delete symbol X.

3. To empty your mailbox entirely, check off the box beside the delete symbol, then click the delete symbol X itself.

Application Messages

GRC Cloud includes 21 preset automatic applicationmessages, concerning a variety of subjects.

When any of the following situations occur, a message is automatically sent to the user’s email address and duplicated in

the system inbox.

User Management

In this section Administrators can create new users, edit existing user details including passwords, homepage preferences

and data preferences (past periods) and also delete users.

Additional User List columns:

1. Email Address: details the email address associated with the account.

2. Last Successful Login: details the last time a user successful logged into the system (details date and time).

3. Last Failed Login: details the last failed attempt the user had logging into the system. Usernamewas correct,

password was not. Any failed attempt when clicking the Login button is captured.

Users have the ability to login with username or email address. If the user has multiple accounts with the same

email associated, they will not be permitted to login via an email address. (7.0)

Full Name is now a required field in the user profile. If the administrator does not input a full name, it will auto-insert the user-

name. Once saved the full name can be changed, but not removed.

Notes:



1. In Homepage Preferences it is possible to determine the action when clicking amouse on a report name to either dis-

play a report or go to the report builder screen.

2. In Data Preferences, there are now twomethods for selecting the past periods to be viewed by default. In addition

to selecting the required periods from a drop downmenu, the user can also choose to select a number of periods.

This number represents the number of periods prior to the current period to be included.

3. The previous periods selected in Data Preferences will also appear by default in Item Overview reports.

Create a New User

1. Click onAdministration > Users.

2. Click the Create aNew User button. This brings up theCreate a Userwindow.

3. Enter the user’s details, their user name, full name, password and complete email address.

4. Select the User Type: Full or Light or External. Internal (Full & Light) users have access to the GRC Cloud web-

based application. External users can receive email notification and be a part of user list, but have no access to the

system.  Note: Once a user is set up either Internal or External, this setting cannot be changed. User can be

changed from Light to Full and Full to Light.

5. NOTE: At this time, Light and Full user behave exactly the samewithin the application. There are no permission dif-

ferences.

5. Enter the Culture Options. These define the language of the interface and formats for numbers and dates, Select

whether the Culture is based on the user's Browser Settings or their User Profile in GRC Cloud. Then select the

required culture. (Example: French Canada). If the desired culture is not available, please contact Resolver to

have a Culture option added to your site. (Translation fees may apply.)

6. Enable 2 Factor Authentication if applicable (See "2 Factor Authentication")) (6.3)

7. Click Create set up the user with the selected settings.

Note: GRC Cloud's interface can appear in different languages, date formats and number formats for different users. The

user Culture option determines which language the user sees after logging in.

The username and email must be unique in the application; the email address must be complete and the passwordmust

meet security standards (at least 8 characters long and contain at least 1 number, 1 letter, and 1 change in case).

The email address entered here will be used by the system to send administrative emails to the user, including new pass-

words and 'Added as an Item Owner' notifications.

It is recommended that you require users to change their password on first login; this option is selected by default.

Edit an Existing User

1. Click onSystem > Administration > Users.

2. Click on a username in the left hand column.

3. TheUser Profilewindow will appear.

#
#
#
#
#


There are four tabs available in theManage User Profile window, General, Homepage Preferences, Data Preferences,

GroupMembership, Permissions and File Permissions. While on any tab, the content window toolbar offers the ability to

save, change password, delete or go back.

Edit an Existing User – User Profile

1. Click onAdministration > Users.

2. Click on a username in the left hand column.

3. TheUser Profilewindow will appear.

4. Edit the User Name, Full Name or Email Address as required.

5. Enter the Culture Options. These define the language of the interface and formats for numbers and dates, Select

whether the Culture is based on the user's Browser Settings or their User Profile in GRC Cloud., then select the

required culture. (Example: French Canada) If the browser culture settings are for a culture not available within

GRC Cloud, the default culture set in System Settings will be used.

If the desired culture is not available, please contact Resolver to have a Culture option added to your site. (Trans-

lation fees may apply.)

6. Click Save to apply your change(s).

Note: Once created, Internal (Full and Light) users setting cannot be changed to External users. Option will appear grayed

out on this screen.

Change Challenge Question - Functionality Removed in 8.1.1

1. Click onAdministration > Users.

2. Click on a username in the left hand column.

3. From theUser Profile Page, under theGeneral tab, click theChange ChallengeQuestion button on theContent

Window Toolbar.

4. Choose the preferred challenge question from the drop downmenu.

5. Type in the answer to the selected challenge question.

6. Click theSave button to apply the change(s).

Change Data Preferences

Past data, generated through the period end process, can be viewed inManage by Location and theMatrix Assessor. The

Data Preferences feature in the User Profile enables/disables past period data and selects the periods and Criteria to dis-

play.

1. Click onAdministration > Users.

2. Click on a username in the left hand column.

3. From theUser Profile Page, click on theData Preferences tab.



4. To enable the ability to view past period data, check the box marked "Display Past Period Data".

5. To select the periods to be viewed inManage by Location, Matrix Assessor, Chart Builder and Item Overview

reports, either:
● select the required periods from the list, by checking the appropriate boxes.

or

● select the number of previous periods to be included. This will show the last "N" periods, where N is the

number selected . This option is useful for saved reports which will be re-run in the future, as it is not nec-

essary to reselect items each time the report is run.

6. To select the evaluation criteria and functions to be viewed inManage by Location, Matrix Assessor and Chart

Builder, select the required items from the list, by checking the appropriate boxes.

7. Click Save to apply your change(s).

Change Homepage Preferences

1. Click onAdministration > Users.

2. Click on a username in the left hand column.

From theUser Profile Page, click on theHomepage Preferences tab.

3. Select the starting point from which the information will be displayed. Use the drop downmenu to choose your

starting point for the information displayed in the Homepage. This enables you to analyze a specific area in your

organization. You can choose a starting point based on any of the Frameworks the Administrators have created,

including by Location Framework and Coping Item Framework. . The default is By Location

For example, if you work in the Chicago HR department and only want your homepage to display information

related to HR in Chicago, then choose that item as the starting point. Items that are not child items in the frame-

work tree will not be included in the information displayed on your homepage.

4. Select the Group Preferences to be displayed. The Administrator may set certain information to appear on the

home page of eachmember of any group. The check boxes here enable the user to select to view these pre-set

items for one or more groups of which they are amember, or alternatively choose their own preferences for what is

displayed. Be checkingmultiple boxes, personal preferences may be combined with the content set for one or

more groups of which they are amember.

5. Check the box beside any information to display on the user's homepage.

● Pie Charts and starting point. There is typically one pie chart for each criteria that can be charted in addition

to a starting point for reporting purposes

● Include Information Boxes: Determines whether to display theMy Messages box and theMy Reports box.

The Reports box, which shows saved and shared reports, can be configured to have a specific action for a

mouse left click. It can be set to either open the report itself, open the report builder, or go straight to Matrix

Assessor. and aMy Messages box which displays recent automatedmessages generated by GRC Cloud.

● Determine whether the homepage display is based on the user's personal profile or one or the profiles of one

or more groups of which the user is amember.

6. Click Save to apply your change(s).



File Permissions

1. Click onAdministration > Users.

2. Click on a username in the left hand column.

3. From theUser Profile Page, click on the Permissions tab. All items that the user has access to are displayed here.

If this page is blank, it means the user selected does not have any permission to any files.

4. File permissions can bemodified by selecting/deselecting the appropriate boxes.

5. To remove all permissions from a File click theX at the end of the row, or deselect all boxes and click Save.

6. To add permissions to a new File not listed here click theAdd Files button.

7. A list of all file available in the system will appear. Select the box beside the File you wish to assign permissions

to.

8. Click Add Selected Files.

9. The new File is now at the bottom of the list, and has been automatically assigned a Read only permission. This

can be changed to Edit permission by checking the appropriate box.

10. Click Save to apply your change(s).

Change Group Membership

1. Click onAdministration > Users.

2. Click on a username in the left hand column.

3. From theUser Profile Page, click on theGroupMembership tab.

4. TheGroupMembership tab allows you to change what groups the user is a part of.

5. The left box lists available groups; these groups are in the system, but that the user is not currently amember of. 

The right box lists the groups that the user is currently part of.

6. To add the user to a group highlight the group in the left box and click the arrow pointing to the right to move the

selected group to the other side.

7. To remove the user from a group, highlight the group in the right box and click the arrow pointing to the left to move

the selected group to the other side.

GroupMembership allows you to: Assign the same permissions tomultiple users, include the user in a group and set the

permissions for the group as a whole inSystem > Administration > Groups.

The system has three default groups: Administrators, Reporting and Everyone.  These groups cannot be deleted.



Delete an Existing User

1. Click onAdministration > Users.

2. Click on theX in the right hand column on the same row as the user you wish to delete.

3. A pop-up will appear asking you to confirm that you wish to delete this user. Click OK.

Impersonating a User

Impersonation enables administrators to assume the role of any users, including administrators, in the system. Each User

Profile has an option to impersonate that user and by doing so, allows the administrator to walk through the system rep-

resenting that user.

1. As an administrator, navigate to the User List page

2. Click the impersonate icon parallel with the user.

OR

3. Select a user from the list

4. To impersonate by clicking on Impersonate button

5. From that point, all interaction with the system will be from the perspective of the selected user.

6. To stop impersonating, click the Stop Impersonating link next to the user name (top right corner).

Notes:

1. Limited Administrators cannot impersonate Administrators

2. All changes made while impersonating will be tracked in impersonationmode (Example: George (impersonate by

John)

3. Filtering by an impersonator in the Audit Trail is not supported.

Updating LDap User Profiles

The user list provides an option to synchronize the user in your active directory with the users in GRC Cloud.

1. Click Sync Users it will check if the users credentials have changed, if so it will synchronize the two systems.

2. It will match the Active Directory GuID and update: emails, user name, full name.

3. It will not update passwords.



Group Management

Groups enable a number of users to all be given the same permissions or characteristics. For example, if a group has three

members and this group is made the owner of an Item, then all its members will become owners. Consequently, if a user is

added to the group the new user will have all the permissions of the other groupmembers and this would become owner of

the same item. If a user is removed from the group, the permissions would be removed from them.

In the GroupManagement section, Administrators can add and remove users to/from groups. You can also introduce an

entirely new group to the application. Groups allow Administrators to give specific permissions tomultiple users as well as

simplify user management.  The system has four default groups: Administrators, Reporting and Everyone, External. These

groups cannot be deleted. The purposes of these groups are as follows.

Everyone:All users are permanently part of this group. This group enables permissions to be set global across the system.

Administrators:A user can bemade Administrator by adding to the group.

Reporting:No specific permission set applied.

External:External users can receive email notification and be a part of user list, but have no access to the system. 

1. Create a New Group

2. Edit a Group

3. Change Description of a Group

4. Add/Remove Users to/from aGroup

5. Change the Permissions of a Group

6. File Permissions

7. Delete and Existing Group

Create a New Group

1. Click onAdministration > Groups. This takes you to theManageGroups Page.

2. Click theCreate a New Group button. This will bring up the Create Group Page.

3. Enter a Group Name.

4. Enter a description of the group if required.

5. Click Create to create the group.

6. This will take you to theEdit a GroupWindow where you can set permissions and groupmembership.

Edit a Group

1. Click onAdministration > Groups. This takes you to theManageGroups Page.



2. Click on a group name in the left hand column. TheEdit a Groupwindow will appear.

There are three tabs available in the Edit a Group window: General, GroupMembership, Permissions and File Permissions.

Change Description of a Group

Default content can be set for the homepages of all members of a specific group. This enables administrators to set certain

minimum information that is available to users as soon as they log in. The content of the pie charts and other elements is

limited by the permissions that member or group has. Note that the individual users can change their options not to include

information from their groups. If the user is amember of several groups they can choose to view the homepage elements of

none of the groups, one of the groups, or any combination of the groups they are amember of.

1. Click onAdministration > Groups. This takes you to theManageGroups Page.

2. Click on a group name in the left hand column. From theEdit a GroupPage, under theGeneral tab.

3. From the Edit a Group Page, click on the Homepage Preferences tab.

4. Select all appropriate items to appear on the homepages of all groupmembers. 

5. Click Save to apply your change(s).

For information on how users can customize the content of their homepages, including group homepage preference set-

tings see User Management – Change Homepage Preferences

Change Group Homepage Preferences

1. Click onAdministration > Groups. This takes you to theManageGroups Page.

2. Click on a group name in the left hand column. From theEdit a Group Page, under theGeneral tab.

3. Modify the description in theDescription text box.

4. Click Save to apply your change(s).

Add/Remove Users to/from a Group

1. Click onSystem > Administration > Groups. This takes you to theManageGroups Page.

2. Click on a group name in the left hand column.

3. From theEdit a GroupPage, click on theGroupMembership tab.

4. TheGroupMembership tab allows you to change which users belong to what group. The left box lists available

users, users that are in the system, but that are not assigned to this group.  The right box lists the users that are

part of this group.

5. To add a user to a group, highlight the user in the left box and click the arrow pointing to the right to move the

selected group to the other side.

You can add/removemultiple users simultaneously by dragging the cursor over multiple users, or by holding downCtrl

while clicking. Then click the arrow tomove the selected users to the other box.



6. To remove the user from a group, highlight the user in the right box and click the arrow pointing to the left to move

the selected user to the other side.

7. Click Save to apply your change(s).

File Permissions

1. Click onAdministration > Groups. This takes you to theManageGroups Page

2. Click on a group name in the left hand column.

3. From theEdit a GroupPage, click on the File Permissions tab. All items that the user has access to are displayed

here.

If this page is blank, it means you do not have any permission to any files.

4. File permissions can bemodified by selecting/deselecting the appropriate boxes.

5. To remove all permissions from a File click the X at the end of the row, or deselect all boxes and click Save.

6. To add permissions to a new File not listed here click theAdd Files button.

7. A list of all file available in the system will appear. Select the box beside the File you wish to assign permissions

to.

8. Click Add Selected Files.

9. The new File is now at the bottom of the list, and has been automatically assigned a Read only permission. This

can be changed to Edit permission by clicking the appropriate box.

10. Click Save to apply your change(s).

Delete an Existing Group

1. Click onAdministration > Groups. This takes you to theManageGroups Page

2. Click on theX in the rightmost column beside the group you would like to delete.

3. You will be prompted to confirm that you wish to delete the group. Click OK.

OR

4. Click onAdministration > Groups. This takes you to theManageGroups Page.

5. Click on a group name in the left hand column.

6. From theEdit a GroupPage.

7. Click theDelete button.

8. You will be prompted to confirm that you wish to delete the group. Click OK.

You cannot delete any of the four default groups: Administrators, Everyone, External and Reporting.



Understanding Roles and Permissions

GRC Cloud’s granular permission set and Role-based approach to permissions has a variety of benefits, including:

● Enables more efficient creation of sets of permissions that can be applied tomultiple users and then

edited for multiple users later if required.

● Enables any criteria within an item to be editable, readable or hidden for members of a specific role

● Different users can see and edit different criteria within the same item

● Enables users to occupy different roles within different parts of the framework. For instance if an individual

has responsibility for testing controls and overseeing the work of other control testers, he/she can be

member of one role (Control Tester) for some items and another role (Control Test Supervisor) for others,

which would have different permissions.

For information on steps to building out Roles and Permissions, see Setting up Roles and Permissions in Role Builder.

Roles

In GRC Cloud, a Role is not a collection of users with similar responsibilities. Instead, a Role is a set of common per-

missions for one or more item types or sub-types. A Role is then applied to a specific item in the location framework or

scoping item framework, and then a specific user (or users) is chosen to occupy the Role for that item.

Therefore there are three elements to setting up permissions for a user and an item.

1. A Role is created and its permissions for various item types are defined

2. The Role is applied to items

3. Users are applied as role members for the items

Step 1 is performed in a Role Editor where new Roles can be created and assigned to different item types and then in turn

to different fields for the various item types.

Example:  At Company X, a Control Test Supervisor may require the following permissions



● Location: Read name of location ONLY

● Folders: (e.g. Processes, Sub-processes and Cycles). Read the name and description of these items.

● Risk: Read all risk criteria, including name, description, impact, likelihood etc.

● Test: Read name and description of test, edit comments and notes and description of test procedure. Also able to

add Test Results, Issues and add attached files.

● Test Results: Read and Edit all fields.

● Issues: Read and Edit all fields. Manipulate permissions for Issue so it can assigned to a co-worker.

All the capabilities listed above could be saved in one Role called Control Test Supervisor.

Steps 2 and 3 are typically combined into one action called PermissionMembership. In these steps, items in the Location

Framework or Scoping Framework are selected and the role and user applied to that item. This can be done in one of two

ways:

● In Role Editor, a Role can be selected and then applied to specific items and users, or

● In Manage by Location andManage by Scoping Item, an item can be selected and a role and individual

user can be applied to that item.

● Synchronizing permissions with multi user picker. See "SyncingMulti User Picker with Permissions" on

page 45



Cascading of Role Permissions

As a Role typically represents permissions for multiple item types, a cascading concept enables role membership to be

automatically applied to items above and below the item where role membership is being edited. (6.1)

It is now possible to havemultiple anchor nodes on the branch of the tree. In this scenario the permissions will cascade as

expected, but will not override each other, they will grant the user a combination of the 2 sets of permissions.

Example:

Using the Company X example, if Pat Campbell is being given the role membership for the Control Test Supervisor role at

Risk #261, the system also identifies the items above and below that risk in the hierarchy for which the role has per-

missions. Pat therefore receives role membership for these items also.

Therefore, Pat Campbell would get Control Test Supervisor permissions for the Locations and Folders above that Risk and

also for any Controls, Tests, Test Results and Issues below the Risk. However, Pat does not receive permissions for

Action Plans or Steps, as these are not defined in the Control Tester role.

Advanced Permissions and replacement of Local Administrator and Owners

In addition to setting read or edit permissions for each criteria, other permissions may also be defined for a role.

● Ability to add child items to items in the location framework or scoping item framework. The permission

can limit the item type/sub-type to which child items may be added and the item types/sub-types which



may be used as child items.

● Ability to add, delete or edit file attachments to an item type or sub-type

● Establish the role membership for other users in specified roles for a specific item type or sub type. (This

ability replaces Local Admin.)

● Ability to receive specific e-mail alerts: Functionality retired in v8.0

o On creation of a new item (this message was previously sent only to Owners)

o Completion Reminder alerts

o Deadline Reminder alerts

o Sign-off Ready notifications.

For information on steps to building out Roles and Permissions, see Setting up Roles and Permissions in Role Builder.

Setting up Roles and Permissions in Role Builder

Individual Users’ access to individual items—and criteria within those items—is defined by Roles. Themanagement of per-

missions has been completely redesigned in GRC Cloud 5. Rather than assign individual users and groups to specific

items in a location framework and then applying specific read and edit capabilities for descriptors, attributes and evaluation

criteria, management of permissions is now designed exclusively on the basis of Roles.

Roles are collections of permissions for one of more Item Types and Subtypes (rather than specific items in the location

framework). These permissions may be as granular is read or write access to individual criteria, descriptors and functions

within a specific item type or sub type.

As Roles are set across Item Types rather than individual Items, the allocation of one or more users to a role for specific

areas of the location framework is achieved by setting RoleMembership at various points of the framework.

For amore detailed overview of how Roles work, see Understanding Roles and Permissions.

Important Permission Change: in the focus picker and context paths the permissions will automatically assume the user

has item name permissions cascading up the tree. For example, if the user has permissions to a risk and the context has

folder showing, it will ignore permissions and show the item name only. (8.0)

Creating a Role

1. As an Administrator navigate toAdministration > Roles

2. Click Create a New Role

3. Enter a name for the Role, a Description (optional) and click Save.

4. Click GoBack



Delete a Role

1. As an Administrator navigate to Administration > Roles

2. Click theX next to the name of the Role to be deleted

3. When asked to confirm the deletion, click OK.

4. Click GoBack

Editing Role Permissions

1. As an Administrator navigate toAdministration > Roles

2. Click one of the listed Roles

3. Click thePermissions tab. All current permissions are displayed for one or more item types and sub-types.

4. Click Edit Permissions

5. Using the drop-downmenu, pick an item type or item sub-type. The available permissions option will load onto the

screen. These are divided into Field Permissions, Advanced Permissions and E-mail Notifications. The following

sections explain the choices.

Selecting Field Permissions

When setting up a Role’s permissions an item type or sub-type can be set for every criteria as eitherRead/Write (editable),

ReadOnly orNone. (When None is selected, the criteria will not be visible to users in that Role.)

1. For each Descriptor (main, mandatory criteria) and Criteria select whether this role has Read/Write permissions,

ReadOnly permissions, or None by using the radio buttons in the Access column

2. Tomanage this more efficiently use the “Set all Access fields to:” drop downmenu to choose None, ReadOnly or

Read/Write. Then change the settings for individual field Permissions, by using the radio buttons in the Access col-

umn

3. Either continue to Advanced Permissions or press Save.

Selecting Advanced Permissions

Advanced Permissions enable a Role to have specific capabilities for a particular Item Type or Sub-type.

1. Add/Delete Child Items:Select which of the available item types can be attached to the Item Type or Sub-type.

For example, when editing permission for a risk, it is possible to add a Control, Issue or Steps, but not Test, Test

Result or Action Plan as these item types cannot be attached to a Risk. Select the required item types and sub

types by checking the appropriate check boxes.

Where there are one or more sub-types set up in the system, themain item and any sub-types will be displayed.

This can be used to further restrict the child items that can be opened under this item type.

Note:add and delete have been separated into two permissions and behave independently (7.1).



2. Files: This option enables members of the Role tomanage file attachments within this item type or sub-type. To ena-

ble check the check box.

Note:add and delete have been separated into two permissions and behave independently.

3. Enable Sign-Off: This enables this role to sign off items for this item type or sub-type. To enable check the check

box.

4. Change Permissions: This enables the user to set Permissionmembership for other users for this role in this item

type or sub-type. This is useful when adding new items that may need to be allocated to a specific user to work on

whomay not have acquired permissions through the cascading feature. To enable check the check box.

5. Update Library from Manage by Location:Enables the user to edit an existing item inManage by Location, and

copy those changes to the corresponding item in the Framework Library.

6. Move Items between Locations:Enables a user to move items from one location to another by using the Change

Parent button in Manage by Location, while retaining all the values for descriptors, attributes and evaluations. To

use this, it is also necessary to have the Add/Delete Child Items permission for the item type that will become the

parent of the item beingmoved.

7. Create Multi Items in Manage by Location: Enables a user to createmulti parent items (multis) in theManage by

Location screen, by using the Change Parent button. To use this, it is also necessary to have the Add/Delete Child

Items permission for the item type that will become the parent of the item beingmultied.

Selecting E-Mail Notifications

E-mail notifications are generated by GRC Cloud in response to certain actions or certain date-driven schedules. This sec-

tion enables the type of e-mail and schedule to be defined for the Role.

1. For each option check the check box to select the e-mail type and schedule.

2. Press Save to retain all settings.

3. Click GoBack to return to the previous screen.

Managing Role Membership

As a Role typically represents permissions for different item types, a cascadingmethodology enables permissions to be

automatically applied to other item either above or below the item where the role permissions have been applied.

Example: The Control Test Supervisor Role is applied to user called Pat Campbell for Risk #261. GRC Cloud
automatically identifies the items above that risk and below that risk in the hierarchy for which the role has per-
missions applies those permissions to Pat. Therefore, Pat Campbell would get permissions for the Locations
and Folders above that Risk and also for anyControls, Tests, Test Results and Issues below the Risk. However,
Pat would not receive any permission for Action Plans or Steps, as this was not defined in the Control Tester
role.

1. As an Administrator navigate toAdministration > Roles

2. Click one of the listed Roles

3. Click theRole Permissions tab. Any existing Items with users assigned to this role are displayed.



4. Click AddUsers/Groups.

5. On the left side of the screen select one or more items. Organize the framework either By Location or By Scoping

Item by clicking the appropriate radio button.

6. On the right side of the screen select one or more users. This can be done by scrolling up and down the list of users,

or by typing in the name of the user and then checking the box adjacent to the user name. Users can be deselected

by unchecking the box.

7. Click Save.

8. Click GoBack

System Settings

System settings allow Administrators to set “global” settings for users across GRC Cloud. The table below illustrates what

each field enables Administrators to customize.

1. Click onAdministration > System > System Settings. The Edit Settings page will appear.

2. Modify the following settings as required.

3. Click Save to apply your change(s).

System Setting Definition

Bcc Email Address Inserts the defined email address as Blind Carbon Copy for all task oriented emails generated from GRC Cloud.

Custom Error Page Text Determines the text users see when an error occurs.

Default Language and Settings Defines the default culture settings for the site, which determine interface language plus date formats and number formats. The default culture will be overwritten for individual users by setting the culture set-

tings in their user profiles. However, if the user sets their culture by their default browser setting, but this language/culture is not supported by GRC Cloud, the default culture set by this option will prevail. Exam-

ple: If GRC Cloud was set up to support English US, French-Canada and Spanish, but the user's browser setting was for Hungarian, the user would seeGRC Cloud in the default culture, as a Hungarian version

is not available.

Disable Ability to Add New items to all scoped parent items Prevents a new child item that is added to a scoped item from being reproduced in all instances of the scoped items.

Disable Item Description for all Item Types Removes the system driven item description from view item and reports.

Disable Single Instance Assessment Flag Removes the flag from the view item panel.

Disable Ability to Report on Roles in Hierarchical Report Prevents users from including Role information in hierarchical reports to reduce performance issues on large sites.

Disable uploading file extensions Enables administrators to restrict all users (including administrators) from uploading potential harmful files into the Cloud system.

Display Change Log in Item View Enables the change log to be seen by non-Admin users in Item information panel. Setting to False increases system performance as less information need to be loaded each time an item is viewed.

Display Update Library button above tree for non-Admin

users

Enables the ability to updatemultiple item assessments back to the Framework Library.

E-mail from address forWorkflow-based e-mails For customers using the option workflow module, this is the e-mail address from which automated e-mails will appear to come.

Enable automatic e-mail notifications Sets whether automatic notifications/emails are sent out to users.

Enable Crystal Reports Set to false users will not see any configured reports on Focus / programs or analytics page.Administrators will still see these reports but will not render any data when clicked on.

Enable Excel Preview Enables the ability to preview an attached Excel file. Only available in Hierarchical Reports.

Enable Focus Enables/disables theWork Queuemenu slider.

Enablemanual editing of numbers of new items Enables/disables the automatic numbering system for framework items.

Enable notificationmessages Switches on or off messages that appears on each user’s homepage in theMy Messages box.



System Setting Definition

Enable Signoff of items Enables or disables the application’s sign-off capabilities.

Enable Single Instance Items Enables functionality for Single Instance Items which is necessary when using centralized application controls and entity level controls.

EnableWebDav Enables/disables theWedDav capabilities required to instantly update files. Disabling will revert back to downloading files.

Function result - decimal places displayed Sets the number of decimal points for results to all functions. Will not override the setting defined in each individual function.

Function results - maximum number of ranges Sets themaximum displayed number of ranges for results for amathematical function.

Header Right Image  Inserts an image into the top right corner of themenu. (.gif, .jpg, or .png; recommended size is 200px x 36px)

Login Page Image Inserts an image on the login page below the user and password input boxes.

Password Expiry period Determines the number of days before a user’s password expires and it must be reset.

Password Reuse Frequency Determines the number of different passwords required before a user can duplicate a password.

Print Reports With Color Enables or disables colored criteria in printed reports.

Queued Report and File Export request life span (Hours) Sets the number of hours a queued report will remain available for retrieval before being automatically removed. Theminimum period is 24 hours andmaximum is 120 hours (5 days). The system automatically

allows for weekends, but not for public holidays.

Show Activity Name in Header Details the activity related to the item that is currently focused on. Visible in the top left menu.

Show Context In Header Determines whether the defined context (set in Item Templates) is shown in the top left focus picker tab.

Show the site name in the Header Inserts a customized site name into the top right corner of themenu. Typically used for training sites or when an organization has multiple sites.

Text to display on the Login Page Determines the customized text seen on the login page (bottom element on the page).

The Site Name Determined the customized site name seen in the top right corner of themenu.

The Sub-type Column inMatrix Assessor minimized by

default

Reduced the Sub-Type column inMatrix Assessor to theminimum width as a default setting.

WebDav File Timeout Defines the number of minutes files remain active for a user to edit. Once time elapses, the file can no longer be accessed via the Recent Documents

Website URL Web site host name. Setting used by automated e-mails to ensure links work correctly.

Workflow Email Image Inserts an image in the top left of all workflow emails. (.gif, .jpg, or .png; maximum size is 200px x 36px)

Email Templates

GRC Cloud contains a variety of preset email messages. All automatic applicationmessages can bemodified. The Email

Templates section contains a list of the preset applicationmessages. Administrative groupmembers can edit the email

messages and specify that certain messages not be forwarded to users.

1. Click onAdministration > Email Templates. The Edit Email Templates page will appear.

2. Select the Action Name from the drop downmenu for the applicationmessage to bemodified. The page will

refresh with the email template for the selected applicationmessage.

3. Edit the “From” email address, the Subject Line and theMessage Body as appropriate.

4. Click Save to apply change(s)

Warning:Ensure that you do not remove any of the variables (a variable is text contained within percentagemarks e.g.

%NAME%) as changing variables contained in amessage will corrupt themessage content. The sender's email address

must be an active address.



Application Messages

When any of the following situations occur, a message is automatically sent to the user’s email address and duplicated in

the system inbox.

Sign off Availability Notifies user that they an Item is ready for sign off.
Functionality retired in v8.0

ItemRequired -
Deadline Overdue

Notifies user that they are responsible for an Itemwith a deadline that has past
(where deadline was set up within the criteria).
Functionality retired in v8.0

ItemRequired -
Deadline 1 Day

Notifies user that they are responsible for an Itemwith a deadline 1 day from
today (where deadline was set up within the criteria).
Functionality retired in v8.0

ItemRequired -
Deadline 2Weeks

Notifies user that they are responsible for an Itemwith a deadline 14 days from
today (where deadline was set up within the criteria).
Functionality retired in v8.0

ItemRequired -
Deadline 1Month

Notifies user that they are responsible for an Itemwith a deadline 30 days from
today (where deadline was set up within the criteria).
Functionality retired in v8.0

New User Wel-
come

Notifies user that they have been created as a new user in GRC Cloud and pro-
vides a user name. For security reasons, the password follows in a separate
email.

New User Pass-
word

Notifies user of password for their initial login to GRC Cloud.

Reset Password Notifies user when Administrator has reset the user’s password. It contains a
link, to the GRC Cloud login screen.

Eval Required -
Deadline Overdue

Notifies user that they are responsible for an evaluation with an annual,
quarterly or monthly deadline that has past.
Functionality retired in v8.0

Eval Required -
Deadline 1 Day

Notifies user that they are responsible for an evaluation with an annual,
quarterly or monthly deadline 1 day from today.
Functionality retired in v8.0

Eval Required -
Deadline 2Weeks

Notifies user that they are responsible for an evaluation with an annual,
quarterly or monthly deadline 14 days from today.
Functionality retired in v8.0

Eval Required -
Deadline 1Month

Notifies user that they are responsible for an evaluation with an annual,
quarterly or monthly deadline 30 days from today.
Functionality retired in v8.0

Sub-ItemEval-
uation Changed

Notifies the user that they you can no longer sign off an Item because eval-
uations have changed for a sub-item. Themessage provides a link to view the
re-opened item.
Functionality retired in v8.0

Period End Close is
about to Begin

Notifies users that Period End Close process is approaching. It advises users
to save their work and log out. Users are unable to log in for the duration of the



process.

Period End Close
has Begun

Notifies users that Period End Close has initiated. It advises users that they are
unable to log in for the duration of the process and that another email will be
sent when login has been re-enabled.

Period End Close is
Complete

Notifies users that Period End Close has completed and that users are now
able to login again.

Import Criteria Values

The criteria importer provides the capability to import values from 3rd Party content management systems into the GRC

Cloud system. Administrators can export values into a predefined Excel format that can than be imported into specific crite-

ria within GRC Cloud.

Specifications:

1. Imported criteria values will update the items inManage By Location/Scoping only and the Framework

Library (7.1).

2. The criteria importer supports all criteria types

Exceptions: Spreadsheet Criteria / User Lists

3. All imported values will be truncated to the definedmax character count of the criteria.

Example: Text field criteria's max character count = 80

4. If the target value is blank (no values in excel), or if the unique criteria column is blank, the importer

will stop and prompt the user.

5. Blank Values in the Excel Spreadsheet will not override values in Cloud.

6. Support for multiple value imports (Check box criteria)

Formatting:
a. Separated by commas and no spaces.

b. No comma is required after the last value (example: A,B,C)

c. If a label for a criteria is invalid (example: label 1-3 is correct, label 4 is not) AND the importer is

bringing in 4 values for that criteria. It will ignore the import for that criteria. All values coming in

for a specific criteria need tomatch. Result: detailed in the Import Overview report: X criteria

were not updated due to an invalid label.

7. If the same criteria is attached to bothmain and sub type, it will not update the value. It cannot dis-

tinguish between the two in order to update.

8. Value imports are case sensitive.

9. Rich Text Editor Import:
a. Character count will be respected (truncates the text accordingly)

b. Rich text formatting not imported



c. Ability to import hyperlinks (detects http / https / www and will convert it into a link within cloud

rich text editor).

10. All changes will be tracked in the Audit Trail.

Excel Formatting:

1. Importing supports 6 date formats

Examples: Oct-14, 10/14/04, Oct 4 2013, October 4 2013, 04-Oct-13

2. Values MUST lie on sheet 1 of the excel file.

3. Headers must be detailed in the top row of the Sheet 1.

● Header will detail the name of the value being import from outside the system.

4. Importing Item numbers must be formatted/stored as a text field in Excel.

5.  All values will be automatically rounded after 7 decimal places.

6. Numeric fields need to be formatted in text if using as a Unique Identifier, and want numbers ending in

0 tomatch properly. Example: 12.40 needs to be formatted in text. Excel stores this values as 12.4

and will import that stored value.

7. File must be an Excel 2007 file (.xlsx) or greater.

Importing the Criteria

1. System > Administration > Import Criteria Values

OR

Manage by Location / Scoping OR Framework Library > Select a Starting Point for Import from the

tree (Only one starting point can be defined in the tree) > Click Import Criteria Values button

2. Select the Item Type to import values.

3. Identify the file containing the import values.

4. Click Next

Note: ClickingNext references the Cloud Item Type and the Excel file headers and will display them

in the next screen.

5. Select Unique Identifier

All available criteria (including Item Name and Number) can be used tomatch the items in Excel to the

items in Cloud. The Excel options are based off the column headers in the first row of the first Excel

sheet.

Note: Unique identifier cannot also be used as a field to import if selected as an identifier. It will be dis-

abled in theMatch Criteria drop down.



6. MatchCriteria andExcel ColumnHeaders > Add

Thesematches will define which criteria in Cloud will get updated with the values in Excel. Multiple

matches can be identified.

7. Import

8. Report of criteria updated in Cloud is presented to the user. Values will get updated and referenced in

the Audit Trail.

 File Management

All users are able to add files, including new versions of existing files to the application. Themaximum allowed size for

uploaded files is 50MB. Attachments are searchable by the attachment title, description or contents.

1. Upload a File
2. Delete a File or Hyperlink from the System
3. Modify File Permissions
4. Search for a File
5. Edit or Upload New Versions of Files in the System

Upload a File

You can upload a file to the application without associating it with a specific instance of an item using the File Manager fea-

ture. Later on, you can easily attach a file in the system to an item. SeeManage Attachments for more information on

attaching existing files to Items.

All users now have the ability to uploadmultiple files and attach tomultiple items in the system. (6.3)



● Add amaximum of 5 files

● Can be added to an undefined set of items (no limitation)

● Available in all areas of the applicable files can be attached

Uploading

1. Click on Tools > File Manager.

2. A list of all the files currently on the system will appear.

3. Click AddNew File.

4. On the Upload New File page, click the Browse button Select File > file gets listed

When a user uploads a new file into the system, it will take into account the file name from where it’s being

browsed from and insert that name into the Name field. This functionality has been added to all areas to which files

can be attached.

● Only inserts the name if the name field is empty

● It will not overwrite the name if one was already entered

5. Add Description and Keyword (if applicable)

6. Repeat steps to add additional files (6.3)

7. Click the Save File button. The upload new file page will refresh and the file will be checked-in.

Note: You cannot modify the content of a file within GRC Cloud. Instead, you need to download the current copy to your

computer, make changes and upload a new version of the file to the application. The application will retain all copies of the

file for reference purposes and allocate individual version numbers so they can be easily identified.

Delete a File or Hyperlink from the System

This will permanently delete all versions of the file from the system.

1. Click on Tools > File Manager.

2. Optional: Enter the name, description or keywords of the File you are looking for.

3. Click theSearch button.

4. A file list also appears below the search box.

5. Place a checkmark beside the File(s) you wish to delete, and click theX button.

6. A window will appear to confirm that you wish to delete the file. Click OK.

Modify File Permissions

1. Click on Tools > File Manager.

2. A list of all the files currently on the system will appear.



3. Click the on the File Name of the desired File.

4. TheEdit File or Attachment Informationwindow will appear.

5. In the detail panel under the Permissions tab, you will see existing permissions for that item.

6. If the file is checked-in then click theEdit button at the top of the panel.

7. Click theAddUsers/Groups button to view a list of all users within the system that can be given various per-

missions to this Item.

8. Check the User Group(s) you want to assign permissions to or open a group by clicking on the plus sign to select

individual members listed within that group.

9. Click theAdd Selected User/Groups button. The users or groups selected will now appear in the list ready to be

assigned specific permissions.

10. By default, each user or group added will be given Read permissions. Use the check boxes to determine any addi-

tional permission for each user and group listed.

11. To edit existing permissions, check/uncheck the applicable boxes, or click theX to remove all permissions for a

user or group.

12. Click Save to apply your change(s).

Search for a File

You can locate files using a keyword(s) found in the file’s name and/or description, file type, Item Type the file is attached

to. In the case of text files andMicrosoft Office documents, by text contained within the document.

1. Click on Tools > File Manager.

2. A list of all the files currently on the system will appear.

3. Click Search Files.

4. Enter the desired search criteria.

5. Filter by one or more selections: Name, Description, Keywords and Content.

6. Click Search.

7. All matching files will be listed.

Edit or Upload New Versions of Files in the System

You can locate files using a keyword(s) found in the file’s name and/or description, file type, Item Type the file is attached

to.  In the case of text files andMicrosoft Office documents, by text contained within the document.

Administrators can restrict all users (including administrators) from uploading potential harmful files into the Cloud system.

This is achieved by adding the file extension into the system setting field. File extensionmust be separated by commas.

(Example: exe, com, vbs, dll) See "System Settings" on page 250

Interchangeable file type versions. Ability to upload any type of file as a version, even if it differs from the original version



type. Example:Upload a file as .docx, user can then upload a new version as .doc or even xls. All restrictions surrounding

version uploading have been removed.

1. Click on Tools > File Manager.

2. A list of all the files currently on the system will appear.

3. Navigate to the desired file.

4. Click on the File Name of the desired File.

5. TheEdit File or Attachment Informationwindow will appear. Click the Edit button at the top of the page, unless the

Item has already been checked out by you.

If theEdit button does not appear, it is because the file has been checked out. The status of the file will say "Checked out

to:...", and the file cannot be edited until it has been checked back in.

6. Modify the information as desired.

7. Attach File to Multiple Items: select additional items to attach the file to in Manage by (6.3)

8. Click Save to apply your change(s).

Period End

Overview

The purpose of period end is to create an archive and reference point for an organization’s data and to create saved data

that can be retrieved for comparison purposes. This is particularly important for companies complying with Sarbanes Oxley

Section 404, Canada’s Bill 198 or other compliance activities whomay have to give evidence of their compliance at a given

point in time. Archived data can be used to provide time-based comparisons displayed inManage by Location andManage

by Scoping Items, Matrix Assessor and in graphical form using the Chart Builder. Period End is available to Administrator

users only.

The Period End process enables the Administrator to “clean up” data, including:

● Change status of all “signed off” items to “open”

● Remove issues, action plans, steps, tests, and test results (any non-framework items)

● Clear evaluation data

● Either unattach files from items or purge them from the system

● Reset Workflows

Note: completion of the Period End process deletes all Audit Trail and Change Log entries

Administrators are no longer forced to clear the Audit Trail and Change Log. A new option on Step 2 to indicates whether

the logs are cleared. (7.0)



Note: continuing tomaintain the Audit Trail and Change Logmay impact view item performance. If performance deg-

radation arises, disable the Change Log tab via the System Settings (Display Change Log in Item View).

The Administrator selects which of these items are reset or removed. The framework itself is left intact from period to

period.

Period End Process

Lockout All Other Users

New in 5.4

File attachments can be either removed from items, or purged enmasse, in Step 4 of the Period End process.

The Administrator is led through a five-step process with step by step instructions on the screen. The five steps are:

1. Lockout Other Users and Name this Period

2. Archive andMaintenance

3. Delete Non-framework Items EnMasse

4. Clear Criteria and Function Values and Remove or Purge Attached files or Reset Workflows

5. Reopen Items and Remove User Lockout

Access the Period End feature as follows: Administration > System > Period End. All users will be “locked out” of the

system while the Period End process is running.

Note: If you start a period-end process accidentally or decide that you do not have sufficient information to complete it, just

run through the steps without deleting any items or clearing any criteria. This will not affect any information in the system.

Afterwards, contact Resolver Client Support and request that they delete that period-end archive for you. Note that a

small fee will apply for deleting the period-end.

Step 1 of 5: Lockout Other Users and Name this Period

1. Choose whether to send an e-mail notification to all system users. This enables the Administrator to warn users

that the Period End process will be taking place. As all users will be immediately locked out of the system, it is

advised that the Administrator should send this e-mail. The wording of the e-mail is customizable and instructions

for amending the e-mail appear on the screen. All users will receive the e-mail whether they are logged into GRC

mailto:clientsupport@resolvergrc.com?subject=Period End Question
mailto:clientsupport@resolvergrc.com?subject=Period End Question
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Cloud or not. To avoid e-mailingmany users the Administrator may choose to run the Period End outside normal

business hours. The Administrator may edit the text of the e-mail by following the instructions on the screen.

2. The Administrator must choose a “name” for this period as this namewill be used to identify various periods for

time-based reporting. Therefore names should be simple and descriptive.

For instance:

● Q2, 2008

● 2008-Jan

● 2008-01-31

3. When these steps are completed click Begin Period End Process. The next screen confirms the completion of

these steps. (At this point an email will be sent to all users informing them a period end is in progress, regardless of

whether the Administrator sent the first email described in step 1 or not, and that they will be notified when they

can return to work in the system upon completion of the period end.)

4. Click Go ToNext Step.

Step 2 of 5: Archive and Maintenance

In this step, a copy of the current data will be archived. There are no options to select.

1. Uncheck Clear Change Log and Audit Trail if it's necessary tomaintain the Change Logs and Audit Trail. (7.0)

2. Click Go to Next Step to continue. The next screen simply confirms the completion of the Archive andMain-

tenance step.

2. Click Go ToNext Step.

Step 3 of 5: Delete Non-Framework Items "En Masse":

In this step all “Non-Framework items” such as Issues, Action Plans, Steps, Test Results that are not part of a framework,

and Test Results may be deleted. The selection of which Non-Framework Items are to be deleted is made by creating a

hierarchical report of items and then selecting which ones are to be deleted.

Note: Resolver advises that clients should typically not delete large numbers of items. An example of the problem with dele-

tions, is the case of Test Results. From this perspective, testers will need to use test result items in the next period and

would not want to recreate them all from "scratch". Therefore, instead of deleting Test Results, simply clear the criteria

which will be reassessed in the new period. Similarly, from the perspective of Deficiencies, decide whether you want to

retain old Deficiencies or delete them each period.

1. Create a hierarchical report using relevant sections of the framework and by selecting the item types to be viewed.

Although the Period End function will only delete non-framework items, framework items (such as folders, loca-

tions, risks, controls) may also be viewed in order to ease navigating around the framework.

2. After generating a hierarchical report, select all items or check the box(es) adjacent to any item(s) to be deleted

and then click the Delete button at the top if the screen.

3. Click Rebuild to create additional hierarchical reports to list other framework items and repeat steps 2 and 3.



4. When all items to be deleted have been selected, click Go to Next Step. The next screen confirms the completion

of these steps.

5. Click Go ToNext Step.

Step 4 of 5: Clear Criteria and Function Values / Remove or Purge Attached Files
/ Reset Workflows

In this step, attributes or evaluations of any items may be cleared, along with the results of any functions and attached

files. The selection of criteria and function results to be cleared is made by creating a hierarchical report of items and then

selecting the desired criteria.

1. Create a hierarchical report using the relevant sections of the framework and indicating the item types to be

viewed. One ormore hierarchical reports may be created and these reports may be amended by using the Rebuild

button to return to the report design screens to refine which items are to be viewed.

2. Click theClear Results tab to select which criteria or function results are to be cleared or files removed. Where

there are sub types for an item, the criteria selection needs to bemade for each sub-type.

3. For files there are two choices; the files can either be removed from the items in this report, OR, the files can be

removed from the item AND purged from File Manager. Check the appropriate box.

4. When all the items and criteria to be cleared are in the report, click Clear. This will clear the selected criteria for all

items in the report. (Note that it will not clear criteria for areas of the organization that do not appear in the report.) If

you do not wish to clear all items in the system, youmay need to run a number of smaller reports, clearing criteria

values order to ensure all the required items are cleared without clearing ones that you wish to retain.

5. You are asked to confirm that these items are to be cleared. (The Clear process cannot be undone.) Click OK.

6. Click Reset Workflow (will reset all items workflow states listed in the report to the start state).

7. Confirm confirmationmessage.

8. When all the Clearing has been completed, click Go to Next Step. The next screen confirms the completion of

these steps.

9. Click Go ToNext Step.

Step 5 of 5: Reopen Items and Remove User Lockout

Now that the database has been archived and selected item criteria have been cleared and non-framework items removed,

all SignedOff items will be opened and the system will bemade available to all users. There are no options to select in this

section.

1. Click Go to Next Step. GRC Cloud confirms the completion of this step.

2. Click Go ToNext Step. A screen will confirm the completion of the Period End Process.

3. Press Finish to return to the GRC Cloud home page. GRC Cloud users will be informed by e-mail that the system

is now available again. This step will re-open all signed off items in the system and remove the user lockout allow-

ing users to login again.



2 Factor Authentication

2 Factor Authentication provides additional security when logging into GRC Cloud. Available on a per user basis, via the

user profile, both light users and administrators can enable the setting. Upon logging into the system, the user will be

prompted to enter the authentication code sent to their Inbox.

Enabling 2 Factor Authentication

1. Via themainmenu: Username > Edit My Profile

2. Scroll to the bottom of the profile page

3. Under Optional Settings: Check Enable two factor authentication

4. Save

5. Option can also be enabled when Administrators are creating a new user (See "User Management" on page 235

OR

6. Administrator Access: USername > Administration > Users

7. Select a User Profile

8. Under Optional Settings: Check Enable two factor authentication

9. Save

Logging In

1. Enter user credentials.

2. Email is sent to users inbox.

3. Select 'This is a Trusted PC' (Optional).

Note: If selected, the user will not be prompted to enter the code if logging in from the same PC they defined as

trusted. This will persist until the user login lapses 14 days. After 14 days without a login, they will be prompted

again for the key. (8.0)

4. Submit

Note: If 2 Factor Authentication is enabled for a user, the Forgot Password option will not be available. The user will be

required to contact their administrator in order to change their password.



Administrator Permissions

Two types of administrative options:

1. Administrator: User has full administrative privileges across the entire site.

2. Limited Administrator (6.1): User has the potential to have full administrative privileges. However, they can be lim-

ited from accessing any administrative area of the site.



Limited Administration

Enables the 'site' Administrator(s) to restrict Limited Administrators to all the areas defined below:

● Design Menu :Criteria / Item Templates / Frameworks

● Administration Menu: Users / Groups / Roles / ChallengeQuestions / System Settings / Email Templates /

Import Criteria Values / Period End

Restrictions: The following restrictions have been placed on the new user type:

1. Cannot add users to Administrator group.

2. Cannot alter other Administrators or Limited Administrators.

3. Cannot make normal users into any type of Administrator.

Note: The Limited Administrator cannot modify or create other users in the system with higher permission sets even if

granted Group and User access.

Creating a Limited Administrator

1. Administration > Create a User

2. Go toGroups Membership tab > Check off Administrators group

3. Go Back toGeneral tab and scroll down

Options are now available to limit the administrator from all menu options.

4. Uncheck/check the areas to remove/grant access for that administrator .

5. Save

Login Page

Built on a responsive design approach - as the screen gets small, the page adopts to the size and only provides the key ele-
ments for login - the login page will allow administrators to brand the page with the logo of their choice; as well as, deliver a

specific message to their users before entering the system. Administrators have full control over build elements via the sys-

tem settings.

Customization of the Client Logo

1. As an administrator, go the System Settings: Administration > System > System Settings.

2. Scroll down to Login Page Image setting.

3. Click Browse.



4. Select an image (.gif, .jpg, or .png; recommended size is 160px x 80px).

5. Click Save at the top of the page.

6. Clear your cache: Ctrl + F5

7. Log out to verify image is correct.

Customization of the Welcome Message

1. As an administrator, go the System Settings: Administration > System > System Settings.

2. Scroll down to Text to display on the Login Page setting.

3. Add in the text that will welcome your user base.

4. Rich Text and hyperlinks are available.



Resolver Contact Info

If you are in need of assistance please contact us through one of themethods below:



Technical Support, End-User Support and Remote Training Resolver Support Center

US and Canada 1-877-755-3716

Outside US and Canada +001-646-367-2086

Development Ideas/ Suggestions Resolver Support Center

www.resolvergrc.com

Twitter: @resolvergrc
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